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1. Introduction
This is the home of the TouchDraw 2 for Windows documentation. The layout of the pages and information

displayed in this documentation is based on the User Interface (UI) structure. It is broken down into seven main

sections with pages describing each portion of the interface and available functionality:

Section Name Description

Preface The Preface section contains necessary legal and acknowledgment information

regarding TouchDraw 2 for Windows.

Getting Started The Getting Started section contains information for launching TouchDraw 2 and

helpful web page links.

User Interface The User Interface section can be used to learn more about the application interface.

File Management The File Management section can be used to learn more about managing files and

drawings within TouchDraw 2.

Editing Drawings The Editing Drawings section can be used to learn more about available features

when working with a drawing in TouchDraw 2.

Tips and

Techniques

The Tips and Techniques section can be used to learn about using the Function Key

Feature to perform specific actions within TouchDraw 2.

Miscellaneous The Miscellaneous section contains additional information outside of the main UI

structure of the application, such as file importing and exporting formats.

The information shown in the User Interface, File Management, and Editing Drawings sections, in particular, is

organized based on the layout of the application interface.

For example, to find information about changing the text properties of a figure in the editor, go to the Editing

Drawings section, expand these pages, and then select Text.
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To find information about importing or exporting a drawing, go to the File Management section and select one

of these pages.

Each documentation section begins with pages describing the basic features of their user interface, and

subsequent pages provide further details about a particular feature. Use the links on a page to navigate to
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additional information about a specific subject or expand the pages to find a specific section.

The search feature can be also be used to find an item. Type in a keyword, and a list of pages will appear for

selection.
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2. Preface
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2.1. Legal Notice
This software product is copyrighted and all rights reserved by Elevenworks LLC. The distribution and sale of

this product are intended for the use of the original purchaser only and for the use on their authorized systems.

Copying, duplicating, selling, or otherwise distributing this product with the express written permission of

Elevenworks are violations of U.S. Copyright Law and are hereby expressly forbidden.

Every effort has been made to ensure that the information in this manual is accurate; however Elevenworks is

not responsible for errors.

Apple, the Apple logo, iPhone, iPod touch, and iTunes are trademarks of Apple Inc., registered in the U.S. and

other countries. iPad is a trademark of Apple Inc. App Store is a service mark of Apple Inc. Content purchased

from the iTunes Store is for personal lawful use only. Don’t steal music.

Microsoft, Microsoft Windows and Visio are trademarks of the Microsoft group of companies.

TouchDraw 2 and the TouchDraw 2 logo are trademarks of Elevenworks LLC.

Other company and product names mentioned herein are trademarks of their respective companies. Mention of

third-party products is for informational purposes only and constitutes neither an endorsement nor a

recommendation. Elevenworks assumes no responsibility with regard to the performance or use of these

products.
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2.2. Open Source
Portions of this software may utilize the following copyrighted material, the use of which is hereby

acknowledged.

Name License

Json.NET The MIT License (MIT)

Markdig BSD 2-Clause "Simplified" License

Sprache The MIT License (MIT)

ExCSS The MIT License (MIT)

FontAwesome CC BY 4.0 License

Portions licensed under the Apache License, Version 2.0. You may obtain a copy of the License at:

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed

on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or

implied. See the License for the specific language governing permissions and limitations under the License.

https://www.newtonsoft.com/json
https://github.com/JamesNK/Newtonsoft.Json/blob/master/LICENSE
https://github.com/lunet-io/markdig
https://github.com/lunet-io/markdig
https://github.com/sprache/Sprache
https://github.com/sprache/Sprache/blob/develop/licence.txt
https://github.com/TylerBrinks/ExCSS
https://github.com/TylerBrinks/ExCSS/blob/master/license.txt
https://fontawesome.com/search?o=r&m=free
https://fontawesome.com/license/free
http://www.apache.org/licenses/LICENSE-2.0
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3. Getting Started
TouchDraw 2 supplies everything you need to create structured 2D vector graphics on the go with your device.

Create charts, graphs, floor plans, architecture drawings, illustrations, or most anything else you can image.

Not only does TouchDraw 2 make it easy to create your drawings quickly, it also delivers a simple to use

environment where you will enjoy changing and manipulating each drawing.
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3.1. Launching TouchDraw 2
To launch the TouchDraw 2 application on your Windows computer, complete the following steps:

Step 1: Click on the Start button.

Step 2: Select the TouchDraw application to open it.

Note: A shortcut can also be placed on the desktop for easy access to TouchDraw.
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3.2. Closing TouchDraw 2
Select the File Menu and then select Exit to close the application.
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3.3. Useful Links
Elevenworks Website

Useful links on the Elevenworks.com website.

Description Link

Elevenworks Main Website https://www.elevenworks.com/

TouchDraw Main Web Page https://www.elevenworks.com/touchdraw

TouchDraw 2 for Windows Documentation https://www.elevenworks.com/documentation

To get support or to provide feedback on TouchDraw 2, you can contact Elevenworks via our Contact Form or

at the following email address: support@elevenworks.com.

https://www.elevenworks.com/
https://www.elevenworks.com/touchdraw
https://www.elevenworks.com/documentation
https://www.elevenworks.com/contact
mailto:support@elevenworks.com
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4. User Interface
The following screen will open when the TouchDraw 2 application is first launched. This screen functions as

the user interface for creating and managing drawings in TouchDraw 2 for Windows.

This screen functions as the user interface for creating and managing drawings in TouchDraw 2 for Windows.

As shown above, the screen has three main features.

Feature Description

Drawing Toolbar The Drawing Toolbar can be found on the left side of the portion of the application

window and provides access to the drawing tools offered by TouchDraw 2.

Drawing Canvas The Drawing Canvas can be found in the center of the application window and is

where the drawing resides.

Sidebar A Sidebar is positioned on the right-hand side and can be used to make additional
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Feature Description

modifications to objects within a drawing.

Additionally, Menus, a toolbar, Format Bar, and a Bottom Bar can be found at the top of the application

window for making quick changes to objects within a drawing.

Note: The Drawing Toolbar is designed to adjust based on the screen size of the device or computer it is

running on. When your computer has a smaller screen, some options will collapse into selectable menus within

the Drawing Toolbar.
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4.1. Menus
The Menu Bar contains 8 menus to access actions, options and settings related to the application, file

management and drawing manipulation.

Click on a menu and choose the desired option.

Menu Name Description

File The File menu contains all file management options and application preferences.

Edit The Edit menu contains common editing, duplication, and text manipulation choices.

Arrange The Arrange menu contains options for grouping, locking, moving, aligning, and

distributing objects within a drawing.

Modify The Modify menu contains options for modifying shapes, lines, and paths within a

drawing.

View The View menu contains options for changing what is viewed in the main application

window.

Help The Help menu contains search and help file options.
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4.1.1. File Menu

The File Menu can be used to access actions related to file management such as opening, saving, importing,

and printing drawings. When this menu is selected, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

New The New menu item can be used to create a new drawing.

Open... The Open... menu item can be used to open an existing TouchDraw 2 document, or it

can be used to import a drawing or image in one of the 3rd party file formats that

TouchDraw 2 supports.

Open Recent The Open Recent menu item can be used to select from a list of most recently opened

drawings.

Close The Close menu item closes the current drawing.

Save The Save menu item saves the current drawing.

Save As... The Save As... menu item saves the current drawing as a new drawing.

Insert Image... The Insert Image... menu item can be used to import a bitmap image stored on the

local file system into the current drawing.



Page 24

TouchDraw 2 for Windows

Menu Item Description

Export... The Export... menu item can be used to export a drawing into one of the 3rd party file

formats supported for exporting.

Print... The Print... menu item can be used to print single or multiple pages of a drawing.

Preferences The Preferences... menu item can be used to change general, handle, and

performance options for the application.

Exit The Exit menu item can be used to exit the TouchDraw application.
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4.1.2. Edit Menu

The Edit Menu can be used to access actions related to the clipboard, undo, and miscellaneous text editing.

When this menu is selected, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Undo The Undo menu item removes drawing changes in the order they were applied,

starting with the most recent.

Redo The Redo menu item reapplies drawing changes in the order they were removed,

starting with the most recent.

Cut The Cut menu item removes the currently selected item from the active drawing and

places it in the clipboard.

Copy The Copy menu item places a copy of the currently selected item into the clipboard.

Paste The Paste menu item adds the most current item residing in the clipboard to the active

drawing.

Paste Special The Paste Special Submenu contains special options related to pasting the contents

of the clipboard into the active drawing.

Delete The Delete menu item permanently removes an item from the active drawing.
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Menu Item Description

Duplicate The Duplicate menu item creates a copy of a selected item in the active drawing.

Duplicate in Place The Duplicate in Place menu item creates a copy of a selected item and places it in

the same location as the original.

Select All The Select All menu item selects all items residing in the currently active drawing.

Deselect All The Deselect All menu item deselects all items residing in the currently active

drawing.

Invert Selection The Invert Selection option deselects currently selected figures within the active

drawing and selects all figures that were previously not chosen.
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4.1.2.1. Paste Special Submenu

Use the Paste Special Submenu to access special actions related to the pasting the contents of the clipboard

into the active drawing.

When this submenu is selected within the Edit Menu, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Paste in Place The Paste in Place menu item copies the current clipboard item into the exact

location of the original.

Paste Multiple The Paste Multiple menu item can be used to paste multiple copies of a clipboard

item at specific offsets.

Paste Style The Paste Style menu item applies the formatting properties of one object to the

currently selected object.
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4.1.3. Arrange Menu

Use the Arrange Menu to access actions for arranging or aligning selected figures within a drawing. When

this menu is selected, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Group The Group menu item allows currently selected shapes on the drawing canvas to be

manipulated and treated as a single figure. This menu item is enabled when two or

more groupable figures are selected in the drawing canvas. Shapes residing on the

drawing canvas can be manipulated.

Ungroup The Ungroup menu item removes the grouping attribute for selected shapes to allow

for individual manipulation. This menu item is enabled when one or more grouped

figures are selected in the drawing canvas.

Lock The Lock menu item prevents a selected figure(s) or group of figures from being

moved or resized. This menu item is enabled when one or more unlocked (and

lockable) figures are selected in the drawing canvas.

Unlock The Unlock menu item removes a previously instated lock on a figure(s) or group of

figures to allow for moving and resizing. This menu item is enabled when one or more
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locked figures are selected in the drawing canvas.

Bring to Front The Bring to Front menu item moves a currently selected figure(s) to the front of all

figures residing in the same layer. This menu item is enabled when one or more

figures are selected in the drawing canvas.

Bring Forward The Bring Forward menu item moves a currently selected figure(s) one step closer to

the top of the stack within the layer they reside in. This menu item is enabled when

one or more figures are selected in the drawing canvas.

Send Backward The Send Backward menu item moves a currently selected figure(s) one step closer

to the bottom of a stack within their residing layer. This menu item is enabled when

one or more figures are selected in the drawing canvas.

Send to Back The Send to Back menu item moves a currently selected figure(s) behind all other

figures residing within the same layer. This menu item is enabled when one or more

figures are selected in the drawing canvas.

Align Submenu The Align submenu contains options to align figures in relation to each other.

Distribute

Submenu

The Distribute submenu contains options to distribute figures evenly in relation to

each other.
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4.1.3.1. Align Submenu

Use the Align Submenu to access actions for aligning selected figures within a drawing.

When this submenu is selected within the Arrange menu, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Align to Grid The Align to Grid menu item aligns figures with the grid. This menu item is enabled

when two or more unlocked figures are selected in the drawing canvas.

Align Top The Align Top menu item moves all currently selected figures to match the top (Y

position) of the first selected figure. This menu item is enabled when two or more

unlocked figures are selected in the drawing canvas.

Align Vertical

Center

The Align Vertical Center menu item moves all currently selected figures to match

the vertical center (Y position + 1/2 of the height of all figures) of the first selected

figure. This menu item is enabled when two or more unlocked figures are selected in

the drawing canvas.

Align Bottom The Align Bottom menu item moves all currently selected figures to match the

bottom (Y position + Height) of the first selected figure. This menu item is enabled
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when two or more unlocked figures are selected in the drawing canvas.

Align Left The Align Left menu item moves all currently selected figures to match the left (X

position) of the first selected figure. This menu item is enabled when two or more

unlocked figures are selected in the drawing canvas.

Align Horizontal

Center

The Align Horizontal Center menu item moves all currently selected figures to

match the horizontal center (X position + 1/2 of the width) of the first selected figure.

This menu item is enabled when two or more unlocked figures are selected in the

drawing canvas.

Align Right The Align Right menu item moves all currently selected figures to match the right (X

position + Width) of the first selected figure. This menu item is enabled when two or

more unlocked figures are selected in the drawing canvas.
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4.1.3.2. Distribute Submenu

Use the Distribute Submenu to access actions for distributing the selected figures within a drawing.

When this submenu is selected within the Arrange menu, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Distribute

Horizontally

The Distribute Horizontally menu item adjusts the positioning of selected figures to

create an even amount of horizontal space between each figure. This menu item is

enabled when three or more unlocked figures are selected in the drawing canvas.

Distribute

Vertically

The Distribute Vertically menu item adjusts the positioning of selected figures to

create an even amount of vertical space between each figure. This menu item is

enabled when three or more unlocked figures are selected in the drawing canvas.

Pack Horizontally The Pack Horizontally menu item takes a set of selected shapes and “packs” them

into the smallest space possible horizontally.

Pack Vertically The Pack Vertically menu item takes a set of selected shapes and “packs” them into

the smallest space possible vertically.

Pack The Pack menu item takes a set of selected shapes and "packs" them into as small of a
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rectangular space as possible. Be aware that the arrangement of selected figures might

be altered in order to pack them into the smallest space.
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4.1.4. Modify Menu

Use the Modify Menu to transform or move the selected figures within a drawing. When this menu is selected,

the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Rotate The Rotate submenu contains options to rotate the selected figures within a drawing.

Flip The Flip submenu contains options to flip the selected figures within a drawing.

Transform The Transform submenu contains options to transform (move, scale, etc...) the

selected figures within a drawing.

Open Path The Open Path menu item is enabled when one or more closed paths are selected.

This option removes a line segment or simply separates the last end/start points into

two separate handles to transform a closed path into an open path.
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Menu Item Description

Close Path The Close Path menu item is enabled when one or more open paths are selected. This

option adds a line segment between the last end point and the start point of a selected

path or connects the start and end points of a curve segment to create a closed path.

Split All Segments The Split All Segments menu item is enabled when one or more paths are selected.

This option splits a selected path into segments at each end point handle to create

multiple individual path figures.

Join Lines/Paths The Join Lines/Paths menu item is enabled when two or more lines or open paths are

selected. This option joins the end point handles of segments to create a single path

figure.

Trim Lines/Paths The Trim Lines/Paths menu item is enabled when two or more shapes are selected

and at least one of those shapes is a line or open path. This option trims the ends of

intersecting lines, paths, or connections when the intersection is near the end of the

line/path.

Reverse

Lines/Paths

The Reverse Lines/Paths menu item flips or reverses the direction of the decorations

(arrowhead, diamond, square, etc.) within selected lines or paths.

Switch Arc

Direction

The Switch Arc Direction menu item reverses one or more selected arcs within a

drawing.

Make Compound

Path

The Make Compound Path menu item is enabled when two or more paths are

selected. This option combines two or more selected paths into one compound path to

provide attribute-sharing capabilities.

Split Compound

Path

The Split Compound Path menu item is enabled when one or more compound paths

are selected. This option splits a compound path into individual paths.

Add Shapes The Add Shapes menu item is enabled when two shapes or closed paths are selected.

This option combines two selected shapes into one figure.

Subract Shapes The Subtract Shapes menu item is enabled when two shapes or closed paths are

selected. This option removes the intersecting portions of the second selected shape

from the first figure selected in the drawing canvas.

Intersect Shapes The Intersect Shapes menu item is enabled when two shapes or closed paths are

selected. This option removes all non-intersecting portions of selected figures from
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Menu Item Description

the drawing canvas.

Exclude Shapes The Exclude Shapes menu item is enabled when two shapes or closed paths are

selected. This option removes the intersecting portions of selected figures from the

drawing canvas.

Convert Shape to

Path

The Convert Shape to Path is enabled when one or more shapes or lines are selected.

This option converts the bordering lines of a selected shape into a closed path by

adding the necessary handles.

Convert Text to

Path

The Convert Text to Path is enabled when one or more text figures are selected. This

option converts a text figure created with the Text tool into a path.
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4.1.4.1. Flip Submenu

Use the Flip Submenu to access actions for flipping the selected figures within a drawing.

When this submenu is selected within the Modify Menu, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Flip Horizontally The Flip Horizontally menu item interchanges the position of a figure horizontally.

Flip Vertically The Flip Vertically menu item interchanges the position of a figure vertically.
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4.1.4.2. Resize Submenu

The Resize Submenu can be used to resize selected figures based on the largest or smallest size, width, or

height. At least two figures must be selected within the drawing for these options to appear within the Modify

Menu.

TouchDraw 2 will resize all figures to match either the size, width, or height of the smallest or largest figure

among the selections in the drawing.

Click or Tap on a Resize option to learn more about what it does.

Option Name Description

Resize to Largest

Size

The Resize to Largest Size option can be used to resize all selected figures within the

drawing to match the largest sized figure.

Resize to Smallest

Size

The Resize to Smallest Size option can be used to resize all selected figures within

the drawing to match the smallest sized figure.

Resize to Largest

Width

The Resize to Largest Width option can be used to resize all selected figures within

the drawing to match the largest width within the selections.

Resize to Smallest

Width

The Resize to Smallest Width option can be used to resize all selected figures within

the drawing to match the smallest width within the selections.

Resize to Largest

Height

The Resize to Largest Height option can be used to resize all selected figures within

the drawing to match the largest height within the selections.

Resize to Smallest

Height

The Resize to Smallest Height option can be used to resize all selected figures within

the drawing to match the smallest height within the selections.
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4.1.4.3. Rotate Submenu

Use the Rotate Submenu to access actions for rotating the selected figures within a drawing.

When this submenu is selected within the Modify Menu, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Rotate 90° Right The Rotate 90° Right menu item rotates a selected figure to the right by 90°.

Rotate 90° Left The Rotate 90° Left menu item rotates a selected figure to the left by 90°.

Rotate 180° The Rotate 180° menu item rotates a selected figure by 180°. The figure is flipped

upside down or back to its original position depending on the number of times this

selection is made.

Reset Center

Rotation

The Reset Center Rotation menu item is enabled when the "Center of Rotation"

option in the Handles Settings popup menu is selected and has been altered on a

shape. This option changes the "Center of Rotation" for a shape back to its original

centered location.
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4.1.4.4. Transform Submenu

Use the Transform Submenu to access actions for transforming (moving, scaling, etc.) the selected figures

within a drawing.

When this submenu is selected within the Modify Menu, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Move By... The Move By... menu item changes the location of a figure based on input coordinates.

Scale By... The Scale By... menu item alters figure size based on input coordinates to create a

smaller or larger figure spanning over a specific area.
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4.1.5. View Menu

Use the View Menu to access actions for changing settings of the currently visible drawing canvas. When this

menu is selected, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Zoom In The Zoom In menu item increases the magnification level of the drawing canvas to

allow for working on the drawing in more detail.

Zoom Out The Zoom Out menu item decreases the magnification level of the drawing canvas to

make a larger portion of the drawing viewable in the window at once.

Zoom To Submenu The Zoom To Submenu can be used to access additional zooming options for a

drawing.

Selection As Group The Selection As Group option is the default setting for TouchDraw 2. When

enabled, multiple shapes selected at once will be treated as a group and can be resized,

rotated, etc., as a group.
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Menu Item Description

Select Individually

(Classic)

The Select Individually (Classic) option enables the same behavior experienced

when selecting shapes in TouchDraw 1. All of the handles for all of the selected

shapes will be displayed in the Drawing Canvas.

Show Rulers The Show Rulers menu item displays the left and top rulers from the main application

window. Select this menu option again for the rulers to reappear.

Show Grid The Show Grid menu item displays the background grid from the main application

window to show a blank canvas. Select this menu option again for the grid to reappear.

Show Page Bounds The Show Page Bounds menu item places page boundary lines on the drawing

canvas when enabled. This option is disabled by default within TouchDraw 2 and

must be selected from the menu to be enabled. Select this menu option again to

disable it and remove the boundary lines.

Show Regions The Show Regions menu item can be used to show (or hide) regions within a drawing.

Snapping Submenu The Snapping submenu contains options related to the snapping behavior of the

active drawing canvas.

Grid Level

Submenu

The Grid Level Submenu can be used to choose if the grid is rendered in the

background (underneath the drawing) or the foreground (above the drawing).

Easy Drag Mode The Easy Drag Mode option hides all handles to prevent a selected figure from being

altered as it is moved. The option can be applied to a single figure by selecting the

object prior to choosing this setting or set when no figures are selected to apply the

setting to every item on the drawing canvas.

Handles Submenu The Handles Submenu contains options for enabling and disabling the visibility of

certain handles within a drawing.

Layers Submenu The Layers Submenu contains options for application setup and operational

characteristics of TouchDraw 2 for layers.

Show Format Bar The Show Format Bar menu item displays the formatting bar from the TouchDraw 2

application window. Select this menu option again for the formatting bar to reappear.

Show Sidebar The Show Sidebar menu item displays the sidebar from the TouchDraw 2 application

window. Select the menu option again for the sidebar to reappear.

Show Toolbar The Show Toolbar menu item displays the main toolbar from the TouchDraw 2
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application window. Select the menu option again for the Toolbar to reappear.
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4.1.5.1. Zoom To Submenu

The Zoom To Submenu options can be used to dynamically resize the magnification level and the location of

the drawing within the drawing canvas to make the complete drawing visible in the window based on the

drawing contents, page, or current selection. You can also return the drawing back to fit its normal

magnification level in this submenu.

Option Name Description

Zoom To Fit

Contents

The Zoom To Fit Contents menu option can be used to zoom in and fit th drawing

figures so that they are shown within the window.

Zoom To Fit Page The Zoom To Fit Page menu option can be used to fit the entire page within the

window.

Zoom To Fit

Selection

The Zoom To Fit Selection menu option can be used to zoom in on the drawing so

that the selected figures are shown within the window.

Zoom to Actual

Size

The Zoom To Actual Size menu option can be used to 100% drawing size based on

the page size (8 1/2 by 11, etc.).

Zoom To Origin The Zoom to Origin menu option returns a drawing back to it's normal magnification

level (100%) and resets the visible portion of the drawing canvas so that the

coordinates 0,0 are in the upper left hand corner.
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4.1.5.2. Snapping Submenu

Use the Snapping Submenu to access the settings related to the snapping for the active Drawing Canvas.

When this submenu is selected within the View Menu, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Snap to Grid The Snap to Grid menu item aligns objects to the grid for more precise drawing

modifications.

Snap to Lines The Snap to Lines menu item aligns objects with the nearest lines.

Snap to

Pixels/Points

The Snap to Pixels/Points menu item aligns objects to whole pixel numbers for

simplified object modification and increased accuracy.

Snap to Shapes The Snap to Shapes option snaps a figure to a selected shape vertex or center point.

To see this option in action, disable the Snap to Grid option, make certain Snap to

Shapes is enabled, and then draw a star or rectangle. Once the shape is completed,

select the Line Tool and try to draw a line from one of the vertexes of the shape or its

center point. The drawn line will snap to one of these locations.
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Grid Level Submenu

The Grid Level Submenu can be used to choose if the grid is rendered in the background (underneath) the

drawing or in the foreground (above) the drawing.

Option Name Description

Background The Background option can be used to render the grid within the background

(underneath) the drawing. This option is selected by default.

Foreground The Foreground option can be used to render the grid within the foreground (above)

the drawing.

 

Background Example

The drawing will appear similar to what is shown below when the Background grid level option is selected.
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Foreground Example

The drawing will appear similar to what is shown below when the Foreground grid level option is selected.
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4.1.5.3. Handles Submenu

The Handles Submenu contains options for configuring which handles are visible for figures residing on the

Drawing Canvas.

Click or Tap on the corresponding Handles Option name to learn more about what the option does.

Option Name Description

Rotation The Rotation option toggles the visibility of the rotation handle on the drawing

canvas.

Gradient Locations The Gradient Locations option toggles the visibility of the gradient location handle

within a figure(s) on the Drawing Canvas.

Center of Rotation Enabling the the Center of Rotation option allows the point at which a figure or

shape is rotated around to be edited.

Bounds Submenu The Bounds Submenu can be used to toggle the visibility of the boundaries of path

handles. Boundaries can be shown on handles for all figures, strokes, and paths or for

everything but paths.
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Option Name Description

Path Segments

Submenu

The Path Segments Submenu can be used to toggle the visibility of segment handles

for paths.

Path Control

Points Submenu

The Path Control Points Submenu can be used to toggle the visibility of path

control points between always showing, only showing active points, or showing none

at all.
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4.1.5.4. Layers Submenu

The Layers Submenu contains options for application setup and operational characteristics of TouchDraw 2

for layers.

Note: Enabled options will have a checkmark to the left of their name within the menu.

Preference Name Description

Layer Isolation The Layer Isolation preference isolates modifications to the currently selected layer

and prevents other existing layers from being selected for editing. **This preference

is enabled by default.

Add Layer When

Locked

The Add Layer When Locked preference automatically creates another layer if a

figure is added to the drawing canvas when the current layer is locked.

Auto Select Layer The Auto Select Layer preference alters the currently active layer to the residing

layer of a selected figure unless the layer has been locked. Note: This option does not

work when Layer Isolation is on, since that setting only allows you to select figures

within the currently selected layer.

Ask For New The Ask For New Layer Name preference opens a prompt window for naming a
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Layer Name layer any time a new layer is created.
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Rendering Options Submenu

The Rendering Options Submenu contains options for

Note: Enabled options will have a checkmark to the left of their name within the menu.



Page 54

TouchDraw 2 for Windows

Preference Name Description

Show Gradients The Show Gradients option toggles whether or not gradient fills (both linear and

radial) are rendered in the Drawing Editor. If gradients are hidden, that does not mean

they have been removed from your drawing. It simply means that they won't be drawn

in the editor to increase rendering speed.

Show Images The Show Images The option toggles whether or not images are rendered in the

Drawing Editor. If images are hidden, that does not mean they have been removed

from your drawing. It simply means that they won't be drawn in the editor to increase

rendering speed.

Show Shadows The Show Shadows option toggles whether or not shadows are rendered in the

Drawing Editor. If shadows are hidden, that does not mean they have been removed

from your drawing. It simply means that they won't be drawn in the editor to increase

rendering speed.

Show Handle

Shadows

The Show Handle Shadows option shows handle shadows while images are being

rendered within the Drawing Editor. This does not mean that shadows have been

removed from the drawing. Instead, shadows are not drawn in the editor to provide

increased rendering speed.

Show Outlines The Show Outlines option only shows the outlines of shapes within the Drawing

Editor. All fills and shadows are disabled when this option is enabled.

During Move and

Resize Submenu

The During Move and Resize Submenu may be used to enable or disable options for

showing gradients, images, shadows, and text when moving or resizing within the

Drawing Editor.

During Pan and

Zoom Submenu

The During Pan and Zoom Submenu may be used to enable or disable options for

showing gradients, images, shadows, and text when panning and zooming within the

Drawing Editor.
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4.1.6. Help Menu

Use the Help Menu to access help and feedback options for TouchDraw 2. When you select this menu, the

options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Documentation The Documentation menu item will take you to this documentation.

Send Feedback The Send Feedback menu item will create a new feedback email message in your

preferred email client addressed to the TouchDraw 2 team.

Send Feedback The Send Feedback menu item opens an About window showing the current version

of TouchDraw 2.
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4.2. Toolbar
The Main Toolbar appears at the top of the main screen as shown below and can be used to perform various

functions on selected objects or on an entire drawing.

Note: Please see Toolbar Actions to learn more about available Toolbar Actions.
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4.2.1. Toolbar Actions

The following list describes all of the actions that are available to be configured as part of the toolbar:

Icon Name Description

Lock This option will be enabled if one or more unlocked figures are

selected in the current drawing window. The Lock toolbar

option prevents moving and resizing actions on the selected

figure(s).

Unlock This option will be enabled if one or more locked figures are

selected in the current drawing window. The Unlock toolbar

option removes a lock on single or multiple figures for moving

and resizing.

Group This option will be enabled if two or more figures are selected

in the current drawing window. The Group toolbar option

combines selected figures into a single object for performing

manipulation actions.

Ungroup This option will be enabled if one or more grouped figures are

selected in the current drawing window. The Ungroup toolbar

option separates a previously grouped set of figures for

individual manipulation.

Front This option will be enabled if one or more figures are selected

in the current drawing window. The Front toolbar option will

move the currently selected figure(s) to the front of all other

figures within the layer they reside in.

Forward This option will be enabled if one or more figures are selected

in the current drawing window. The Forward toolbar option

will move the currently selected figure(s) one step closer to the

top of the stack within their residing layer.
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Backward This option will be enabled if one or more figures are selected

in the current drawing window. The Backward toolbar option

will move the currently selected figure(s) one step closer to the

bottom of the stack within their residing layer.

Back This option will be enabled if one or more figures are selected

in the current drawing window. The Back toolbar option will

move the currently selected figure(s) behind all other figures

within their residing layer.

Left This option will be enabled if two or more figures are selected

in the current drawing window. The Align Left toolbar option

moves all currently selected figures to match the left (X

position) of the first selected figure.

Horizontal Center This option will be enabled if two or more figures are selected

in the current drawing window. The Align Horizontal Center

toolbar option moves all currently selected figures to match the

horizontal center (X position + 1/2 of the width) of the first

selected figure.

Right This option will be enabled if two or more figures are selected

in the current drawing window. The Align Right toolbar option

moves all currently selected figures to match the right (X

position + Width) of the first selected figure.

Top This option will be enabled if two or more figures are selected

in the current drawing window. The Align Top toolbar option

moves all currently selected figures to match the top (Y

position) of the first selected figure.

Vertical Center This option will be enabled if two or more figures are selected

in the current drawing window. The Align Vertical Center

toolbar option moves all currently selected figures to match the

vertical center (Y position + 1/2 of the height of all figures) of

the first selected figure.

Bottom This option will be enabled if two or more figures are selected
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in the current drawing window. The Align Bottom  toolbar

option moves all currently selected figures to match the the

bottom (Y position + Height) of the first  selected figure.

Align to Grid The Align to Grid toolbar option aligns a selected figure(s)

with the grid.

Flip Horizontally The Flip Horizontally toolbar option interchanges the position

of selected figures horizontally.

Flip Vertically The Flip Vertically toolbar option interchanges the position of

selected figures vertically

Distribute

Vertically

This option will be enabled when three or more unlocked

figures are selected in the drawing canvas. The Distribute

Vertically option adjusts the positioning of selected figures to

create an even amount of vertical space between each figure.

Distribute

Horizontally

This option will be enabled when three or more unlocked

figures are selected in the drawing canvas. The Distribute

Horizontally option adjusts the positioning of selected figures

to create an even amount of horizontal space between each

figure.

Rotate 90° Left The Rotate 90° Left toolbar option rotates selected figures in

the current drawing to the left by 90°.

Rotate 90° Right The Rotate 90° Right toolbar option rotates selected figures in

the current drawing to the right by 90°.

Rotate 180° The Rotate 180° toolbar option rotates selected figures in the

current drawing by 180°. The figure is flipped upside down or

back to its original position depending on the number of times

this selection is made.

Add This option will be enabled if two figures are selected in the

current drawing window. The Add toolbar option will combine

two selected figures to form one object.

Subtract This option will be enabled if two figures are selected in the

current drawing window. The Subtract toolbar option will
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remove the bottom layered figure from the drawing canvas

along with any portion intersecting the additionally selected

figure.

Intersect This option will be enabled if figures are selected in the current

drawing window. The Intersect toolbar option will remove all

portions of the two selected figures while leaving the section

where they meet.

Exclude This option will be enabled if two figures are selected in the

current drawing window. The Exclude toolbar option will

remove the intersecting portion of two selected figures while

leaving the remaining portions on the drawing canvas.
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4.3. Format Bar
The Format Bar appears between the main toolbar and the drawing canvas of the application window. It can

be used to perform text, stroke, and fill color alterations on a selected object or an entire drawing.

Click on the name of the menu item to find out more details about what action occurs when the menu item is

selected.

Name Description

Text Attributes The Text Attribute buttons are used to change the font family, style, size, color, and

additional text properties for currently selected figures or an entire drawing.

Stroke Attributes The Stroke Attribute buttons are used to change the style, size, and color stroke

properties for currently selected figures or an entire drawing.

Fill Attributes The Fill Attribute button alters the fill color of a selected figure, group of figures, or

an entire drawing.
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4.4. Drawing Canvas
The Drawing Canvas is the area of the screen that displays the currently active drawing. All added figures

appear in this portion of the TouchDraw 2 application.

Besides being able to change the measurement and grid lines, the orientation for the Drawing Canvas itself

may be changed from portrait to landscape as well.

By default, the setting is configured for portrait mode but can be changed by completing these steps:

Step 1: Click on the Page Setup Tab within the Sidebar.
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Step 2: Click on the desired option (portrait or landscape) at the bottom left corner.

The following image shows the drawing canvas in landscape mode.
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Note: The Drawing Toolbar has an intuitive design, meaning that the available tools will be condensed into

expandable groups when your computer has a smaller screen area.
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4.5. Drawing Toolbar
The Drawing Toolbar, located on the left side of the screen, contains all available drawing tools for adding to

or manipulating the current drawing.

The tools and their exact functionality are detailed in the following sections; however, some general concepts

of the toolbar need to be discussed first.

All tools, with the exception of the Move, Zoom, and Selection Tool, can operate in two modes: "Normal" or

"Sticky."

Normal Mode

In Normal Mode, which is activated by selecting the tool through a single click, the tool inserts one figure into

the drawing.

Upon completion of creating that figure, the Move, Zoom and Selection Tool will be reactivated, and the

newly created figure is selected.

A tool is in Normal Mode when its background is highlighted with a blue gradient, as shown in the first figure

below.

Sticky Mode

Sticky Mode, which is activated by selecting a tool by a double click, makes it possible to add many figures to



Page 66

TouchDraw 2 for Windows

the drawing without having to reselect the tool.

Upon completion of creating a figure, the tool will remain selected, and you can immediately begin

creating/inserting additional figures of the same type. To cancel/end creating the selected figure type, select

another tool.

A tool is in Sticky Mode when its background is highlighted with a blue gradient and contains a lock symbol

in the lower right-hand corner, as shown in the figure below.

Collapsed Drawing Tool Options

The Drawing Toolbar has an intuitive design where certain drawing tools are grouped into expandable menus

for smaller screen sizes.

For example, the Move, Zoom, and Selection Tool and Oval Tool can have additional options as indicated by

the arrow at the bottom right of each button in the toolbar.

Perform an Extended Click action to access these features and then click on one of the provided choices to
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make a selection. Available choices will appear as shown below:
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4.5.1. Drawing Toolbar Options

The Drawing Toolbar, located on the left side of the screen, contains all available drawing tools for adding to

or manipulating the current drawing.

The Drawing Toolbar has an intuitive design where similar drawing tools collapse into groups when there is

not enough room on the screen to display them all individually.
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To access these tools when collapsed, you will need to perform an Extended Click on the displayed drawing

tool in the toolbar and then Click on the desired tool in the expanded selection menu.

Click or Tap on the corresponding Drawing Toolbar item name to learn more about its functionality.

Icon Option Name Description

Move, Zoom, and The Move, Zoom, and Selection Tool is the chosen tool
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Icon Option Name Description

Selection Tool default within the application each time a drawing is created or

opened. It can be used to pan the Drawing Canvas , zoom in or

out, and for figure selection.

Move and Zoom

Tool

The Move and Zoom Tool can be used to move the visible

portion of the drawing with a Touch/Drag gesture combination

for performing panning or zooming actions on an entire

drawing rather than moving the objects residing on the Drawing

Canvas.

Zoom Rectangle

Tool

The Zoom Rectangle Tool can be used to draw a rectangle

over a portion of the Drawing Canvas to specify a precise

zooming location. It provides finer control than the Pinch and

Zoom gesture when zooming in on specific figures within the

Drawing Canvas.

Free Form Tool The Free Form Tool is a gesture-recognizing tool that can be

used to draw freehand lines, circles, ovals, etc.  It detects what

is being drawn and automatically turns it into the appropriate

shape. The Free Form Tool will convert the line into a

connection line for lines between shapes

Line Tool The Line Tool can be used to draw straight lines.

Linear Dimension

Tool

The Linear Dimension Tool can be used to draw a linear

dimension line.

Horizontal

Distance

Dimension Tool

The Horizontal Distance Dimension Tool can be used to draw

a horizontal dimension line.

Vertical Distance

Dimension Tool

The Vertical Distance Dimension Tool can be used to draw a

vertical dimension line.

Callout Tool The Callout Tool can be used to draw a callout to a location in

the drawing.

Connection Tool The Connection Tool can be used to draw lines for connecting

one figure to another and makes it easy to create connected
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Icon Option Name Description

graphs such as flow charts.

Polyline Tool The Polyline Tool can be used to draw line segments only and

works similar to the Path Tool. Dragging your finger on the

Drawing Canvas will result in line endpoints. A Double Click

ends the current polyline creation. A Triple Click will end the

creation of the current polyline and close it to create a closed

polygon.

Pen Tool The Pen Tool uses a technique called curve fitting to create a

smooth curve from a drawn freehand path.

Path Tool The Path Tool is the most powerful and complex tool available

within TouchDraw 2. It can be used to create complex curves

and shapes with detailed control on every aspect of the shapes

appearance.

Elliptical Arc Tool The Elliptical Arc Tool is used to create a shape consisting of

half of an ellipse.

Circular Arc Tool The Circular Arc Tool creates a perfect circular arc where the

position, length, and angle increase in proportional increments

as the size of the shape increases.

Oval Tool The Oval Tool can be used to create ovals or circles within a

drawing.

Circle Tool The Circle Tool can be used to create a perfect circle where the

radius increases in increments as the size of the shape increases.

Rectangle Tool The Rectangle Tool can be used to create rectangles or squares

within a drawing.

Rounded

Rectangle Tool

The Rounded Rectangle Tool can be used to create rounded

rectangles or rounded squares within a drawing.

Squircle Tool The Squircle Tool can be used to create squircles within a

drawing.

Polygon Tool The Polygon Tool can be used to create regular polygons

within a drawing.
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Icon Option Name Description

Star Tool The Star Tool can be used to create stars within a drawing.

Text Tool The Text Tool can be used to create a text area within a

drawing.
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4.5.2. Move, Zoom, and Selection Tool

The Move, Zoom, and Selection Tool is the chosen tool default within the application each time a drawing is

created or opened. The following described functions can be performed when this tool is selected.

The simplest and most common method for selecting objects is to perform a click within bounds of a figure (for

ovals, rectangles, rounded rectangles, polygons, filled paths, text, and images) or on a line (for lines and paths).

Handles are displayed as a visual indicator of successful figure selection.

Figures can also be selected by outlining an area within the grid. Click in a grid location where no figures are

present and drag the selection rectangle over the drawing canvas to select all objects within a desired area. All

figures residing in or intersecting the defined area are automatically selected when the drag action is completed.
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Single Selection

Using the methods above, without pressing the Shift key, results in what TouchDraw 2 considers to be single

selection. By single selection, we mean that only the figure or figures selected within the enactment of one

action will be selected.

Multiple Selection

To select multiple figures in an individual manner, hold down the Shift key and click on a desired figure. Each

"shift-click" will add the figure as part of the overall selection when not already selected or deselect the figure
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if it is already selected. This application option allows you to have fine-grained control over the selected

figures.

Zooming

To zoom in or out when viewing a drawing, you can use one of two methods:

1. Use a pinching action on the mousepad. Bring your fingers together on the mousepad to zoom in and
move them away from each other to zoom out.

2. Use the Zoom In and Zoom Out options within the View Menu.

Moving (Panning)

To move around in a drawing, make certain the cursor is within the Drawing Canvas and then drag two fingers

(without pinching or expanding them) on the mousepad to pan around.

The Move and Zoom Tool and Zoom Rectangle Tool

Two additional Selection Tool options are made available when an extended Click action is performed over

the tool button.

The Move and Zoom Tool selection allows the grid to be moved with a Click/Drag option for panning,

zooming in, or zooming out on an entire drawing rather than moving the objects residing on the drawing

canvas. The Zoom Rectangle Tool can be used to draw a rectangle over a portion of the drawing canvas to

specify a precise zooming location.
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4.5.3. Move and Zoom Tool

The Move and Zoom Tool selection allows the visible portion of the drawing to be moved with a Click/Drag

action for performing panning or zooming actions on an entire drawing rather than moving the objects residing

on the Drawing Canvas.

This option is accessible when an extended Click is performed over the Move, Zoom, and Selection Tool

button and will appear as shown below.
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4.5.4. Zoom Rectangle Tool

The Zoom Rectangle Tool selection can be used to draw a rectangle over a portion of the Drawing Canvas to

specify a precise zooming location. It provides finer control than the Pinch and Zoom gesture when zooming in

on specific figures within the Drawing Canvas.

This option is accessible when an extended Click is performed over the Move, Zoom, and Selection Tool

button. Click on the Zoom Rectangle Tool and it will appear in place of the standard Move, Zoom, and

Selection Tool in the Drawing Toolbar.

Use a Click/Drag action to drag the rectangle over a desired area and then release this action to complete the

selection. In this example, the red circle and blue square are selected with the Zoom Rectangle Tool.
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The Drawing Canvas will automatically zoom in on the figures within the selected area.
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4.5.5. Free Form Tool

The Free Form Tool can be used to draw freehand lines, squares, rectangles, circles, and ovals. Once you have

started drawing, the tool will automatically detect what is being drawn and turn it into that shape.

Note: For lines between shapes, the Free Form Tool will convert the line into a connection line automatically.

To use this tool, complete the following steps:

1. Click on the Free Form Tool within the Drawing Toolbar.

2. Begin to draw a shape or line by performing a Click/Drag action on the Drawing Canvas. Do not release
the click until your freehand shape or line has been completed.
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3. Release the click action once you have finished drawing the shape or line. The application will then
complete the shape or line accordingly.
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4.5.6. Line Tool

The Line Tool can be selected to draw straight lines. Use a Click/Drag combination to draw the line from a set

starting point to a desired end point. The trackpad performs the necessary dragging action between two line

points, and a release of the Click action completes this drawing function.

Holding down the Shift Key during line creation constrains the line to increments of 90 degrees.

The length and angle of a line can be altered any time after a line has been created. To alter the length or angle

of a line:

1. Choose the Selection Tool in the Drawing Toolbar and then highlight the desired line.

2. Click on the Geometry Tab located under "Info" on the Sidebar.

3. You will find the Line Length and Line Angle options in the bottom right portion of the Shape Specific
section in the Sidebar. Use the "up" or "down" arrow buttons to change either value or click on the text
entry field to key in a value.
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4. When entering a value into the Line Length or Line Angle options, a different unit of measure other
than the default of Inches or Degrees can be entered. Enter the desired value and unit of measurement.
Then use the Enter Key on your keyboard or click in another area of TouchDraw 2, and the entered
value will automatically be converted to its equivalent value in Inches.

For example, the Line Length value could be 10 centimeters (10 cm) or 50 millimeters (50 mm), and the Line

Angle could be 5 radians (5 rad). Once the desired value and unit of measurement have been entered,

TouchDraw 2 will automatically convert it to the equivalent value in Inches or Degrees.

Example 1: Entering 10 cm for the Line Length:

Example 2: Entering 50 mm for the Line Length:
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Example 3: Entering 5 rad for the Line Angle

The Style As Dimension Line option within the Contextual Menu may be used to add dimensional aspects to

an existing line figure.

When this option is used, TouchDraw 2 automatically adds arrowheads and a {Length} variable to the

selected line(s). At least one line must be selected in the Drawing Canvas for this option to appear within the

Contextual Menu.

Follow the steps shown below to use this option:

1. Select the line figure you would like to alter.

2. Right-click on the Drawing Canvas to bring up the Contextual Menu. Click on Style As Dimension Line.
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3. The selected line figure(s) will appear similar to the example shown below:
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4.5.7. Linear Dimension Tool

The Linear Dimension Tool can be selected to draw a linear dimension line. Use a Click/Drag combination to

draw the linear dimension line from a set starting point to a desired end point and then release the click to

complete the drawing action.

How to Alter Dimension Line Size, Angle, and Position

To alter the length or angle of a linear dimension line, click and drag using one of the connection handles on

each end of the dimension line.

Do not release the click until the end of the dimension line is in the desired location. In the example below, the
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right connection point has been moved down and to the left.

Click and Drag on the blue bounds handle to change the position of the dimension line between the

connection handles.



Page 87

TouchDraw 2 for Windows

Click and Drag on the dimension line to change its position within the Drawing Canvas.

How to Alter the Arrowhead Locations

The arrowhead locations within a linear dimension line can be located on the inside or outside.

When located on the inside, a dimension line will appear, as shown below. This is the default selection.
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To change the arrowhead location to the outside for a selected dimension line, click on the Modify Menu and

click on the Dimensions Submenu.

Next, select the Arrowhead Outside option to change the arrowhead location to outside. A checkmark will be

present for the currently enabled arrowhead option.

The linear dimension line will appear as shown below when arrowheads are on the outside.
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How to Connect a Linear Dimension Line to Images/Figures

For this example, the Linear Dimension Line will be connected to two points within a simple garage floor

plan image. The image and Linear Dimension Line have already been added to the drawing, as shown below.
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Note: A linear dimension line can also be connected to two points on a figure or two separate figures when it is

drawn.

Perform a Click/Drag action on a connection handle within the dimension line to connect it to a point within a

figure.

For more control over the position of each end of the dimension line, disable the Snap to Grid and/or the Snap

to Lines options. A Shift/Click action can also be performed when moving each connection handle.

Perform this action again for the second connection handle within the dimension line.
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Note: A Linear Dimension Line can also be drawn between two points on any figure or from one point on a

figure to a point on another figure.

Using the Scale Attached… optionThe Linear Dimension Tool can be paired with the Scale Attached…

option within the Modify Menu to scale an image, such as a floor plan, to match the grid and trace or perform

other actions within the drawing “at scale.”

For this example, a simple garage floor plan image will be used to demonstrate the Scale Attached… option.

The Linear Dimension Line has been connected to each end of the garage opening, as shown below.
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Step 1: Click on the Linear Dimension Line to select it within the drawing.
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Step 2: Click on Modify Menu and click on the Transform Submenu.

Step 3: Select the Scale Attached… option
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Step 4: Change the linear dimension line length by clicking on the Length field and using the keyboard to

enter a new value.

The “up“ and “down” buttons can also be used to increase or decrease the Length value by 1.

Step 5: Next, use the checkboxes to enable or disable the Scale Proportional and Scale Attributes options

before scaling the image or figure.

• Scale Proportional - Scale the image up to match the grid based on the entered dimension line length.

• Scale Attributes - Scale the attributes (stroke, text, etc.) based on the entered dimension line length.

Step 6: Once finished, click on Scale within the pop-up window.
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Note: If the Scale Attributes option is disabled, then Attributes will not be scaled.
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4.5.8. Horizontal Distance Dimension Tool

The Horizontal Distance Dimension Tool can be used to draw a horizontal distance dimension line. The

dimension line can be drawn between any two points on the grid or be connected to selected connection points

on one or multiple figures within a drawing.

This tool can be selected by performing an extended Click on the Linear Dimension Tool within the

Drawing-Toolbar. Click on the tool to select it.

Use a Click/Drag action to draw the Horizontal Dimension Line from a set starting point to a desired end point

and then release the click to complete the drawing action.
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How to Alter Dimension Line Size and Position

To alter the length of a dimension line, perform a Click/Drag action on one of the dimension line’s connection

handles.

Do not release the click action until the end of the dimension line is in the desired location.

In the example below, the right connection handle has been moved to the right to make the dimension line

larger.
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Click and Drag on the blue bounds handle to change the position of the dimension line.

Click and Drag on the dimension line to change its position within the Drawing Canvas.
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How to Alter the Arrowhead Locations

The arrowhead locations within a horizontal distance dimension line can be located on the inside or outside of

the dimension line.

When located on the inside, a horizontal distance dimension line will appear as shown below. This is the

default selection.

To change the arrowhead location to the outside for a selected dimension line, click on the Modify Menu and

select the Dimensions Submenu.
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Next, click on the Arrowhead Outside option to change the arrowhead location to outside. A checkmark will

be present for the currently enabled arrowhead option.

The Horizontal Distance Dimension Line will appear as shown below when arrowheads are on the outside.

How to connect a Horizontal Distance Dimension Line to Images/Figures

A Horizontal Dimension Line can be connected to specific locations within an image and used to scale the

image. It can also be connected to points within one or more figures.

A garage floor plan image has already been added to the drawing for this example.
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Next, a Horizontal Distance Dimension Line will be drawn along the garage opening.
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Perform a Click/Drag action on a connection handle within the dimension line to connect it to a point within

an image or figure.

For more control over the position of each end of the dimension line, disable the Snap to Grid and/or Snap to

Lines options. A Shift/Click  action can also be performed when moving each connection handle.
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Perform this action again for the second connection handle within the dimension line.
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Note: A Horizontal Distance Dimension Line an also be drawn between two points on any figure or from one

point on a figure to a point on another figure.

Using the Scale Attached… Option

The Horizontal Distance Dimension Tool can be paired with the Scale Attached… option within the Modify

Menu to scale an image, such as a floor plan, to match the grid and trace or perform other actions within the

drawing “at scale.”

For this example, a simple garage floor plan will be used to demonstrate the Scale Attached… option. The

Horizontal Distance Dimension Line has been connected to each end of the rectangle.
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Click on the Horizontal Distance Dimension Line to select it within the drawing.
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Click on Modify Menu and select the Transform Submenu.

Next, click on the Scale Attached… option.
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Click on the Length field to enter a new value. The “up“ and “down” buttons can also be used to increase or

decrease the Length value by 1.

Next, use the checkboxes to enable or disable the Scale Proportional and Scale Attributes options.

• Scale Proportional - Scale the image up to match the grid based on the entered dimension line length.

• Scale Attributes - Scale the attributes (stroke, text, etc.) based on the entered dimension line length.

Once finished, click on the Scale button within the pop-up window.
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Note: If Scale Attributes has been disabled, the Attributes will not scale, only the image or figure.
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4.5.9. Vertical Distance Dimension Tool

The Vertical Distance Dimension Tool can be used to draw a vertical distance dimension line. The dimension

line can be drawn between any two points on the grid or be connected to selected connection points on figures

within a drawing.

This tool can be selected by performing an extended Click on the Linear Dimension Tool in the Drawing

Toolbar. Click on the tool to select it.

Use a Click/Drag action to draw the Vertical Dimension Line from a set starting point to a desired end point,

and then release the click to complete the drawing action.
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How to Alter Dimension Line Size and Position

The length of a Vertical Distance Dimension Line can be altered after it has been created.

Perform a Click/Drag action on one of the dimension line’s connection handles.

Do not release the click until the end of the dimension line is in the desired location.

The bottom connection handle has been moved downward to make the dimension line larger in the example

below.
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Click and Drag on the blue bounds handle to change the position of the dimension line.

Click and Drag on the dimension line to change its position within the Drawing Canvas.
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How to Alter the Arrowhead Locations

The arrowhead locations within a vertical distance dimension line can be located on the inside or outside.

When located on the inside, a vertical distance dimension line will appear, as shown below. This is the default

selection.

To change the arrowhead location to the outside for a selected dimension line, click on the Modify Menu and
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select the Dimensions Submenu .

Next, click on the Arrowhead Outside option to change the arrowhead location to outside. A checkmark will

be present for the currently enabled arrowhead option.

The Vertical Distance Dimension Line will appear as shown below when arrowheads are on the outside.

How to Connect a Vertical Distance Dimension Line to Images/Figures

A Vertical Distance Dimension Line can be connected to any two locations within an image or figure. It can

also be connected to two separate figures in a drawing.



Page 114

TouchDraw 2 for Windows

An image of a garage floor plan has already been added to the drawing for this example.

Next, a Vertical Distance Dimension Line will be drawn on the right side of the garage floor plan image.



Page 115

TouchDraw 2 for Windows

Perform a Click/Drag action on a connection handle within the dimension line to connect it to a point within a

figure.

For more control over the position of each end of the dimension line, disable the Snap to Grid and/or the Snap

to Lines options. A Shift/Click action can also be performed when moving each connection handle.

Perform this action again for the second connection handle within the dimension line.
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Note: A Vertical Distance Dimension Line can also be drawn between two points on any figure or from one

point on a figure to a point on another figure.

Using the Scale Attached… Option

The Vertical Distance Dimension Tool can be paired with the Scale Attached… option within the Modify

Menu to scale an image, such as a floor plan, to match the grid and trace or perform other actions within the

drawing “at scale.”

For this example, a Garage portion of a floor plan will be used to demonstrate the Scale Attached… option.

The Vertical Distance Dimension Line has been connected to the right side of the garage.
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Click on the Vertical Distance Dimension Line to select it within the drawing.
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Click on Modify Menu and click on the Transform Submenu.

Select the Scale Attached… option.
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Change the Vertical Distance Dimension Line length by clicking on the Length field and entering a new

value.

The “up“ and “down” buttons can also be used to increase or decrease the Length value by 1.

Next, use the checkboxes to enable or disable the Scale Proportional and Scale Attributes options before

scaling.

• Scale Proportional - Scale the image up to match the grid based on the entered dimension line length.

• Scale Attributes - Scale the attributes (stroke, text, etc.) based on the entered dimension line length.

Once finished, click on Scale within the pop-up window.
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Note: If Scale Attributes has been disabled, then Attributes (text, stroke, etc.) will not scale according to the

entered length value.
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4.5.10. Connection Tool

The Connection Tool can be used to draw lines for connecting one figure to another and makes it easy to

create connected graphs such as flow charts.

Perform the following actions to create a connected graph on the Drawing Canvas:

1. Begin by creating two figures and then select the Connection Tool. All figures, including path shapes,
text blocks, and images, can be connected with the exception of lines and open paths.

2. Maneuver the mouse to the desired connection point in the first figure and perform a Click action. The
figure will be "highlighted" with a light blue border when the selection has been performed correctly.
The light blue border indicates the ability to connect the figure.

3. Use the trackpad to drag from the start figure to the end figure where the connection will terminate.
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When the mouse is within the "target" figure, it will be "highlighted" with a light blue border. The light
blue border indicates the ability to connect the second figure to the source figure.

4. The connection line is created between the two figures when the Click action is released.

5. Performing a Click/Drag combination on the second figure after the connection is established results in
the connection line position being adapted to keep the two figures connected.

To learn more about using different connector types and the connection tool, please see the following pages:
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• Changing-Connection-Types

• Line Connection Tool

• East-West Connection Tool

• North-South Connection Tool

• Horizontal-Vertical Connection Tool

• Vertical-Horizontal Connection Tool

• Path Connection Tool

• Hub Connection Tool
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4.5.10.1. Changing Connection Types

The Connection Type of a selected connection line can be changed prior to or after creating a connection line

in TouchDraw 2. Follow the steps below to change the Connection Type:

Click on the Connection Type Tab within the Sidebar.

To change the connection type for an existing connection line:

Select the connection line within the Drawing Canvas.
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Follow the steps above to access available connection types and make a selection. In this example, a

North-South connection line is selected.

The connection line will automatically change and adapt based on the selected type, as shown below.
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4.5.10.2. Line Connection Tool

The Line Connection Tool draws a line connection from a source figure and connects in the shortest way to a

target figure. The start, line, and end points of a connection line can be altered in the Stroke Tab located in the

Info portion of the Sidebar. To create a connection with this tool:

1. Select the Line Connection Tool in the Drawing Toolbar.

2. Perform a Click/Drag combination at the desired starting point on the source figure and move the handle
to a desired end point on the target figure.

3. Release the Click action to complete the connection line. Each selected figure will be highlighted in blue
when a valid connection has been made.
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4. The completed connection line will appear as shown below:
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4.5.10.3. East-West Connection Tool

The East-West Connection Tool draws a connection line that originates from the side (either west/left or

east/right) of the source figure and connects to the side (either west/left or east/right) of the target figure. To

select the East-West Connection Tool, perform the following steps:

1. Click on the Connection Type Tab within the Sidebar and choose the East-West Connection Tool.

2. Then click on the Connection Tool within the Drawing Toolbar.

This connection between the figures is created in the same manner as with the Line Connection Tool, but the

connection path remains orthogonal with the source and target lines remaining horizontal.

Perform a Click/Drag combination from the desired starting point on a figure to the desired end point on

another figure and then release the Click action to complete the connection. The selected figures will be

highlighted in blue when a valid connection has been made. Refer to the images below:
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The completed connection line will appear as shown below:
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The connection line will automatically contain squared (90-degree angle) corners. To change the Corner Size

of the created connection line, make certain it is selected. Then click on the Geometry Tab in the Sidebar and

then alter the Corner Size value by clicking on the Up and Down buttons.

Changing the Corner Size to 0.25 inches for a selected connection line causes the corners to be rounded, as

shown below.
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Note: Performing a Click/Drag combination on the second figure after the connection is established results in

the connection line position being adapted to keep the two figures connected.
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4.5.10.4. North-South Connection Tool

The North-South Connection Tool draws a connection line that originates from the side (either north/top or

south/bottom) of the source figure and connects to the side (either north/top or south/bottom) of the target

figure. To select the North-South Connection Tool, complete the following steps:

1. Click on the North-South Connection Tool option within the Connection Type Tab in the Sidebar.

2. Select the Connection Tool in the Drawing Toolbar.

This connection between the figures is created in the same manner as with the Line Connection Tool, but the

connection path remains orthogonal with the source and target lines remaining vertical.

Perform a Click/Drag combination from the desired starting point on the source figure to the desired end point

on the target figure and then release the Click action to complete the connection. The selected figures will be

highlighted in blue when a valid connection has been made. Refer to the images below:
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The completed connection line will appear as shown below.
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The connection line will automatically contain squared, 90-degree angle corners. To change the Corner Size of

the created connection line, make certain it is selected. Then click on the Geometry Tab in the Sidebar and then

alter the Corner Size value by clicking on the Up and Down buttons.
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Changing the Corner Size to zero for a selected connection line causes the corners to become ninety-degree

angles, as shown below.

Note: Performing a Click/Drag combination on the second figure after the connection is established results in

the connection line position being adapted to keep the two figures connected.
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4.5.10.5. Horizontal-Vertical Connection Tool

The Horizontal-Vertical Connection Tool draws a connection line that originates horizontally from the right

or left side of the source figure and connects vertically to the side (top) of the target figure. To select the

Horizontal-Vertical Connection Tool, complete the following steps:

1. Choose the Horizontal-Connection-Tool on the Connection Type Tab in the Sidebar.

2. Click on the Connection Tool within the Drawing Toolbar.

This connection between the figures is created in the same manner as with the Line Connection Tool, but the

connection path remains orthogonal with the source lines remaining horizontal and target lines remaining

vertical.

Perform a Click/Drag combination from the desired starting point on the source figure to a desired end point

on the target figure and then release the Click action to complete the connection. The selected figures will be

highlighted in blue when a valid connection has been made. Refer to the images below:
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The connection line will appear as shown below:
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The connection line will automatically contain squared, 90-degree angle corners. To achieve a rounded corner,

you will need to change the Corner Size of the created connection line. Make certain the connection line has

been selected, and then click on the Geometry Tab in the Sidebar. To alter the Corner Size value, click on the

Up and Down buttons.
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Changing the Corner Size to 0.25 inches for a selected connection line causes the corners to become rounded,

as shown below.

Note: Performing a Click/Drag combination on the second figure after the connection is established results in

the connection line position being adapted to keep the two figures connected.
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4.5.10.6. Vertical-Horizontal Connection Tool

The Vertical-Horizontal Connection Tool draws a connection line that originates vertically from the side

(either top or bottom) of the source figure and connects to the side (either left or right) of the target figure.

To select the Vertical-Horizontal Connection Tool, complete the following steps:

1. Click on the Vertical-Horizontal Connection Tool option in the Connection Type Tab within the
Sidebar.

2. Then select the Connection Tool within the Drawing Toolbar.

This connection between the figures is created in the same manner as with the Line Connection Tool, but the

connection path remains orthogonal with the source lines remaining vertical and target lines remaining

horizontal.

Perform a Click/Drag combination from the desired starting point on the source figure to a desired end point

on the target figure and then release the Click action to complete the connection. The selected figures will be

highlighted in blue when a valid connection has been made. Refer to the images below:
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The completed connection will appear as shown below.
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The connection line will automatically contain a squared 90-degree angle corner. To change the Corner Size of

the created connection line, make certain it is selected. Then click on the Geometry Tab in the Sidebar and then

alter the Corner Size value by pressing on the Up and Down buttons.
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Changing the Corner Size to 0.25 inches for a selected connection line causes the corners to become curved, as

shown below.

Note: Performing a Click/Drag combination on the second figure after the connection is established results in

the connection line position being adapted to keep the two figures connected.
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4.5.10.7. Path Connection Tool

The Path Connection Tool creates a path connection that connects two shapes. As with paths created with the

Path Tool, path connections can be manipulated to add an additional line or curve segments. To select the Path

Connection Tool, complete the following steps:

1. Click on the Path Connection Tool option located on the Connection Type Tab in the Sidebar.

2. Then select the Connection Tool within the Drawing Toolbar.

This connection between the figures is created in the same manner as with the Line Connection Tool, but the

created path can be modified just as items generated with the Path Tool. See the handling paths section of this

documentation to learn more.

Perform a Click/Drag combination from the desired starting point on the source figure to a desired end point

on the target figure and then release the Click action to complete the connection. The selected figures will be

highlighted in blue when a valid connection has been made. Refer to the images below:
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The completed connection will appear as shown below.

Note: Performing a Click/Drag combination on the second figure after the connection is established results in

the connection line position being adapted to keep the two figures connected.

Altering the Route of Path Connection Lines
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Once the Path Connection Line has been added to the desired target figure from the selected source figure, it

can be manipulated in the same manner as a Path Figure. In this example, the connection line currently goes

through the middle rectangle.

To route the Path Connection Line around another figure, handles must be added to the connection line, or it

must be converted to a quadratic or cubic segment. These options can be accessed by performing a Right Click

(Control/Click) on the connection line to open the Contextual Menu and then selecting the Paths Submenu.

Several options will appear within the Contextual Menu for modifying the connection line and routing it

around a specific figure. Handles or curved segments can be added to alter the route of the connection line.

Note: Please note that if you select Delete Segment without adding any additional handles or segments, then

the connection line will be completely removed from the drawing.
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Example 1: Inserting Handles

Inserting handles and then dragging them to desired points in the Drawing Canvas is one method for altering

the route of a Path Connection Line. Follow the steps below to learn how to do so.

Step 1: Perform a Right Click (Control/Click) on the connection line in a location to the left of the crossed

figure and then select Insert Handle from the Paths Submenu.

Step 2: A new Path Handle (Orange) will appear within the Path Connection Line as shown below:
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Step 3: Perform a Right Click (Control/Click) on the connection line in a location to the right of the crossed

figure and then select Insert Handle from the menu again to add another Path Handle (Orange).

Step 4: Then click and drag down or up on the left handle to change the direction/path of the connection line.

Step 5: Notice that the line still intersects the figure. Click and drag on the right handle to continue altering the

direction/path of the connection line. This will result in the straight segment residing below the figure, and a
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successfully routed Path Connection Line.

Note: Please note that the handles may be moved in any direction; however, for this example both are moved

down to route the connection line around the figure.

Example 2: Segment to Quad

A Path Connection Line can also be routed differently by converting the line to a quadratic segment. This

example will use the same original figures as shown previously and will display how to convert the current

connection line to a quadratic segment for path routing.

Step 1: Perform a Right Click (Control/Click) on the connection line and then select Segment to Quad from

the Paths Submenu.
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Step 2: A Control Point Handle (Green) will appear in the middle of the connection line.

Step 3 Click and drag the handle downward (or upward) to create a curved segment. The Control Point

Handle may be moved in any direction; however, for this example, it is moved downward below the figure.
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Example 3: Segment to Cubic

A Path Connection Line can also be routed differently by converting the line to a cubic segment. This

example will use the same original figures as shown previously and will display how to convert the current

connection line to a quadratic segment for path routing.

Step 1: Perform a Right Click (Control/Click) on the connection line and then select Segment to Cubic from

the menu.



Page 153

TouchDraw 2 for Windows

Step 2: Two Control Point Handles (Green) will appear within the connection line.

Step 3: Click and drag in any direction on the left handle to change the position of the Path Connection Line.

In this example, both handles are dragged downward.
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Step 4: Then do the same for the right handle to finish routing the connection line around a figure within a

drawing.



Page 155

TouchDraw 2 for Windows

4.5.10.8. Hub Connection Tool

The Hub Connection Tool creates a connection line that can receive connections and is typically used for

creating network diagrams. The connection line can originate from any side of the source figure and connects

to any side of the target figure or to another hub connection line.

To select the Hub Connection Tool, complete the following steps:

1. Click on the Hub Connection Tool option within the Connection Type Tab in the Sidebar.

2. Click on the Connection Tool within the Drawing Toolbar.

This connection between the figures is created in the same manner as with the Line Connection Tool; however,

the connection path can be placed between two hub connection lines to create a networking or alternative type

of diagram.

Perform a Click/Drag combination from the desired starting point on the source figure to the desired end point

on the target figure or hub connection line and then release the Click action to complete the connection.

The selected figures or hub connection lines will be highlighted in blue when a valid connection has been

made. Refer to the images below to see a hub connection between figures:
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The completed connection line will appear as below.

The following example shows a hub connection line joining two previously drawn hub connection lines.
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Note: Performing a Click/Drag combination on the second figure after the connection is established results in

the connection line position being adapted to keep the two figures connected.
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4.5.11. Callout Tool

The Callout Tool can be used to add a callout to any location within a drawing. A callout figure contains one

connection handle, two bounds handles, and default text.

The connection handle can be used to connect the callout to a figure, and the bounds handles can be used to

alter the appearance of the callout.

This tool can be selected by performing an extended Click on the Linear Dimension Tool. Click on the tool

to select it.

Use a Click/Drag action to draw the callout from a set starting point to a desired end point and then release the

click to complete the drawing action. The arrow will be where the action is completed.
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Using the Bounds Handles

A callout has two Bounds Handles (blue), which can be used to alter its position and size.
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In this example, the bounds handle connecting the two lines will be moved to the right.

Using the Connection Handle

The Connection Handle can be used to alter where the callout figure points to within the drawing.
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Perform a Click/Drag action to change the connection handle’s position within the Drawing Canvas.

The connection handle can also be dragged to a specific connection point on a figure.
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How to Change Callout Text

Perform a Double Click on the default “Callout” text to alter the text for the figure.

After double clicking, the Text Editor will appear as shown below.
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Use the keyboard to enter different text for the callout figure. Once finished, click in any location outside of the

supplied popover to dismiss the editor.

The figure will appear as shown below:
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4.5.12. Polyline Tool

The Polyline Tool can be used to draw line segments only and functions similar to the Path Tool. A click/drag

combination can be used to drag the cursor on the Drawing Canvas and will result in line endpoints.

To use the tool, first Click on the Polyline Tool Button in the Drawing Toolbar to select it and then use the

actions listed below to create a polyline or closed polygon.

The following actions are available when using the Polyline Tool:

Action Description

Click/Drag A Click/Drag combination can be used to create a line end point and corresponding

control point in one action. When using a Click/Drag gesture combination, do not

release your finger until the line has been created. After the line has been created,

additional gestures may be used to continue adding to the polyline figure.

Single Click A Single Click adds a line end point to the figure. The line endpoint can be then be

dragged to any desired location on the Drawing Canvas.

Double Click A Double Click action anywhere on the Drawing Canvas completes the current

polyline connection and causes the Move, Zoom, and Selection Tool to be

automatically chosen as the active drawing tool.

Triple Click A Triple Click will end the creation of the current polyline and close it to create a

closed polygon.
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Action Description

The following screenshots and descriptions show how to use the polyline tool:

Select the Polyline Tool in the Drawing Toolbar.

Perform a Single Click on the Drawing Canvas at the location where the starting point should be established

for the polyline. A gray handle will appear in this specific location to signify the starting point of the polyline.
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Then Click on the Drawing Canvas at the location where the second line end point should be for the polyline.

This action draws a line between these two set points. It also creates a second gray handle at the point where

the first segment ends and the second one begins.
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Click on the Drawing Canvas at the location where the third line end point should be for the polyline. As

before, the action will cause a line to be drawn from the last point to the newest point and add a gray handle to

the drawing.



Page 168

TouchDraw 2 for Windows

Click on the Drawing Canvas at the location where the fourth line end point should be. The same end results

are provided as previously discussed for this additional line segment.

Click on the Drawing Canvas at the location where the fifth line end point should be. The same end results are

provided as previously discussed for this additional line segment.
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Then perform a Double or Triple Click within the Drawing Canvas to finish the polyline. You may also click

on the Move, Zoom, and Selection Tool to complete the polyline.
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Note: A Triple Click on the start point of the figure results in a closed polygon, as illustrated in the screenshot

below.
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4.5.13. Pen Tool

The Pen Tool uses a technique called curve fitting to create a smooth curve from a freehand path that is drawn

by using a Click/Drag combination to drag the tool to desired points on the Drawing Canvas.

To use the tool, select it, and then draw a freehand path by using a Click/Drag combination to maneuver the

pen. The Pen Tool converts the drawn path into a smooth curve once the click action is released.

The following figure illustrates what a curve looks like when drawn by hand and then what it looks like after

the Pen Tool has created the curve.
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Note: The Pen Tool can create shapes instead of paths by using the Shift key in conjunction with the pen tool.

Holding down the Shift key during shape (path) drawing creates a closed shape instead of an open path.
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4.5.14. Elliptical Arc Tool

The Elliptical Arc Tool is used to create a shape consisting of half of an ellipse. To use the tool, select it in the

Drawing Toolbar and then perform a Click/Drag combination at the point in the Drawing Canvas where one of

the bounding corners of the elliptical arc should be. Then drag in any direction and release the Click/Drag

action where the other bounding corner should be.

In the example above, the Click/Drag action began at 1,1 and then dragged down and to the right to 5,5 on the

Drawing Canvas.
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When TouchDraw 2 has been opened within a smaller screen area, certain tools within the Drawing Toolbar

will collapse to form selectable menus.

The Elliptical Arc Tool may be combined with the Circular Arc Tool. The menu can be expanded by

performing an Extended Click over the tool button.
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4.5.15. Path Tool

The Path Tool is the most powerful and complex tool available within TouchDraw 2. It can be used to create

complex curves and shapes with detailed control on every aspect of the shape's appearance. Paths created with

this tool are made up of many segments, and three different types of line segments are possible:

• Straight Lines

• Quadratic Curves (lines with 1 control point)

• Cubic Curves (lines with 2 control points)

It's also important to understand that, like the Pen Tool, the Path Tool can be used to create both paths and

shapes. The Path selection is different from the pen selection in that a continuous line is not drawn. A separate

Click action is required to create each path segment of a line or shape, and this is accomplished in one of either

two ways depending on whether or not the end result should be a path or shape.

Use a Single Click to add each line end point or a Click/Drag combination to add a line end point and a

corresponding control point in one action. To Create a Path, Double Click on the Drawing Canvas or choose

another drawing tool when the path is complete. To Create a Shape, click on the first (start) handle (the orange

handle with a white dot) to automatically draw a line from the current position to the start position to close the

path.

Path Tool Actions

A control point is displayed in gray when it has not been used and is referred to as a "phantom" control point.

This characteristic provides a hint to the TouchDraw 2 application that it should function as a control point in

scenarios where the next drawn segment is a curve.
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A few basic actions can be used to alter the type of created segment, curve positioning, and "phantom" control

point position as a path is being created. Refer to the table below to learn more about each available action.

Action Description

Click/Drag A Click/Drag combination can be used to create a curve segment and allows the

"phantom" control point to be dragged to any Drawing Canvas position to generate

the desired curve segment.

Single Click A Single Click adds a line or curve segment depending on the actions taken during

initial path creation. For example, clicking on two points within the Drawing Canvas

after selecting the path tool causes a straight line segment; however, an initial

Touch/Drag combination creates a curve segment. An additional curve segment

(based on the "phantom" control point position) is created when a Single Click action

is performed in this scenario.

Double Click A Double Click action anywhere on the Drawing Canvas completes the path and

causes the Move, Zoom, and Selection Tool to be automatically chosen as the active

drawing tool.
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4.5.15.1. Adding Straight Line Segments

To create a Straight Line Segment, perform a single click at the starting point and then again at the

corresponding line end point. For example, the objective of drawing a parallelogram could be accomplished

with the Path Tool.

The following screenshots and descriptions outline the steps required for creating a parallelogram with this tool.

1. Select the Path Tool.

2. Click on the Drawing Canvas at the location where the starting point should be established for the path.
An orange handle with a white dot will appear in this specific location to signify the path's starting point.
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3. Click on the Drawing Canvas at the location where the second corner of the parallelogram will be. This
action draws a line between these two set points. It also creates a second handle (orange with no dot) at
the point where the first segment ends and the second one begins.
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4. Click on the Drawing Canvas at the location where the third corner of the parallelogram should be. As
before, the action will cause a line to be drawn from the last point to the newest point and add an orange
handle to the drawing.
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5. Click on the Drawing Canvas at the location where the fourth corner should be. The same end results are
provided as previously discussed for this additional line segment.
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6. Perform a Click on the start point (orange handle with a white dot) to automatically draw the last line to
connect the first point to the last (i.e., closing a path). The action closes the shape and exits the path tool
when Sticky Mode is not enabled. Once a path has been created and selected, a few handles will be seen
in addition to the path point handles created in the steps above. The blue handles are "bounds handles"
that allow for shape resizing with a dragging action. The red handle is a "rotation" handle, which allows
for shape rotation around its center point.

A Double Click in the drawing view creates a path, as illustrated in the screenshot below.
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4.5.15.2. Adding Quadratic Curve Segments

A Quadratic Curve is a line segment with two end points and a control point that determines the exact curve

to be drawn. The figure below illustrates an example of a quadratic curve.

Two core gestures are used when creating path segments. A Single Click adds an end point, and a Click/Drag

combination adds an end point with a corresponding control point.

Since a Quadratic Curve contains two end points and one control point, the above-mentioned core gestures

provide two ways to create this type of path:

• Performing a Single Click and then a Click/Drag combination.

• Performing a Click/Drag combination and then a Single Click.

For example, the Path Tool can be used to draw a shape resembling the fireplace below by combining 3 line

segments and one quadratic curve segment.

The following instructions outline the steps for accomplishing this shape.

1. Select the Path Tool.
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2. Click (but do not release) on the Drawing Canvas at the location where the starting point for the path
should be established. Any of the corner points could be a starting point for creating this shape; however,
the upper left corner point is the starting location for this tutorial. Next, drag the segment to the
established control point location without releasing the click action. TouchDraw 2 will draw a lashed line
from the start point to the control point while the dragging action is performed and then show a slightly
transparent circle in the control point location upon completion.
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3. Next, click on the drawing canvas location where the second corner of the path should be (the upper
right-hand corner). This action creates a quadratic curve between the two end points, with the added
control point functioning as an indicator to TouchDraw 2 as to how to draw the curve.

4. Next, click on the drawing in the location where the third corner of the path should be. As in the previous
examples, it will have drawn a line from the last created point to the new point.
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5. Next, click on the drawing in the location where the fourth corner should be. Again, the same results are
provided as before.
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6. To close the shape, Click on the start point (the orange handle with a white dot in it). This action closes
the shape and exits the path tool (assuming sticky mode has not been enabled).
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In addition to the approach above, the same figure can be drawn performing these actions in a slightly different

order, as shown below:

1. Click in the upper left-hand corner to create the first point of the curved portion of the fireplace.
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2. Perform a Click/Drag combination at the location where the ending point of the curve segment should
be. Drag the "phantom" control point outward to the right and bottom until the desired curve has been
created.
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3. Add a line to the next corner in the shape by clicking where the next end point should be located.

4. Obviously, this is not the desired result. If a "phantom" control point exists and a Click is performed on
the drawing, TouchDraw 2 will use this control point to create a quadratic curve segment. In this case,
the "phantom" control point should be ignored and discarded. Select the Edit Menu and choose Undo or
use the Command-Zkeyboard shortcut to remove this last addition.

5. To draw a straight line from the last end point to the new end point, use the Shift Key as the path end
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point is selected. This action instructs TouchDraw 2 to ignore the "phantom" control point and draw a
straight line.

6. Click on the next corner end point to create the bottom of the fireplace.
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7. To close the shape, Click on the start point (the orange handle with a white dot in it). This action closes
the shape and exits the path tool (assuming sticky mode has not been enabled).
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4.5.15.3. Adding Cubic Curve Segments

A Cubic Curve is a line segment with two end points and two control points that determine the exact curve to

be drawn. The image below illustrates an example of a cubic curve.

Two core gestures are available when creating path segments. A Single Click will add just an end point, and

Click/Drag combination will add an end point with a corresponding control point.

Since a cubic curve contains two end points and two control points, a cubic curve can only be added by

performing a Click/Drag combination at one point and then by performing a Click or Click/Drag combination

at another point.

For example, complete the following steps to draw a path like the one displayed in the example above:

1. Select the Path Tool.



Page 195

TouchDraw 2 for Windows

2. Click on a desired starting point on the Drawing Canvas and drag to another location to establish the first
control point. The orange handle with the white dot signifies the starting point of the path. The gray
circle or "phantom" control point will turn into a control point when a curve segment is drawn.
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3. Next, click on the point within the Drawing Canvas where the segment end point will be, and then drag
the "phantom" control point outward toward the right and bottom of the drawing canvas to create the
desired curve. A real control point will be placed exactly opposite (relative to the endpoint) from the
current location of the "phantom" control point.
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4. Since a path is being created rather than a shape, a Double Click must be performed on the drawing to
inform TouchDraw 2 of the completed path.
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The handles for curve control points are green. The color and look of the control points are an indicator of how

they relate to the selected shape. Refer to the handles reference page to learn about the types of handles.

The next step is to create a shape like the one shown below.

1. Select the Path Tool.
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2. Repeat the steps above to create a curve on the bottom of the shape, as shown below.
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3. Next, draw the edge on the right-hand side of the shape. If a control point exists and a Click is completed
to add a single endpoint, TouchDraw 2 will use the "phantom" control point to create a curve. Hold the
Shift Key down while performing the Click action on the end point location to inform TouchDraw 2 that
a straight line should be added. The following screenshot illustrates what happens when the Shift Key is
not used:
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4. Next, click in the upper left-hand corner where the next end point should be.
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5. Finally, to close the path and create a shape, Click on the start point (the orange handle with a white dot).
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6. To set the color, click on the fill button located on the main toolbar and choose light blue. Refer to the
Handling Colors portion of the documentation to learn more about using colors.
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4.5.16. Circular Arc Tool

The Circular Arc Tool creates a perfect circular arc where the position, length, and angle increases in

proportional increments as the size of the shape increases.

To use this tool, Click on the Circular Arc Tool within the Drawing Toolbar.

A circular arc will appear similar to what is shown below:

Click on the point in the Drawing Canvas where the arc point of the circular arc should be and then Drag

outward without releasing the click until the circular arc consists of the desired length, angle, and size.

Release the Click action to complete the circular arc. The x, y, length, and angle values will increase as the size

of the circular arc increases. Refer to the images below:
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The Circular Arc Tool may not appear by itself within the Drawing Toolbar on smaller screens or when the

application window has been made smaller. This is because the toolbar has been designed to intuitively adjust

based on screen size and collapse similar tools together in these situations.

If tools have been placed in a selectable menu with the drawing toolbar, you will see a right-facing arrow in the

bottom right corner of the tool button. To select the tool, perform an Extended Click on the available button
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and click on the Circular Arc Tool .
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4.5.17. Oval Tool

The Oval Tool is used to create ovals or circles within a drawing.

To use the tool, select it and then perform a Click/Drag combination at the point in the drawing panel where

one of the bounding corners of the oval or circle should be. Drag in any direction and release the Click action

where the other bounding corner should be.

Using the Oval Tool while holding down the Shift key allows for the creation of perfect circles by constraining

the width and the height of the created object to equal values.
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Note: An oval can also contain text. See the Handling Text section for additional details.

The Drawing Toolbar has been designed to intuitively adjust based on screen size and collapse similar tools

together on smaller screens. If tools have been placed in a selectable menu with the drawing toolbar, you will

see a right-facing arrow in the bottom right corner of the tool button.

Perform an Extended Click to open up a pop-over menu and then Click on the desired tool to select it.
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4.5.18. Circle Tool

This Circle Tool creates a perfect circle where the radius increases in increments as the size of the shape

increases.

To select the Circle Tool, perform an extended Click on the Oval Tool button in the Drawing Toolbar to bring

up the pop-over menu.

The Drawing Toolbar has an intuitive design that adjusts to match the screen size of your Android device.

Some tool buttons may be combined to form a pop-over menu for smaller devices.  To select the Circle Tool on

smaller devices, perform an extended Click on the Oval Tool in the Drawing Toolbar to bring up the pop-over

menu.



Page 213

TouchDraw 2 for Windows

Click on the point in the drawing canvas where the center of the circle should be and Drag outward until the

circle consists of a desired radius or size.

Release the Click action to complete the circle. The radius and angle values will increase as the size of the

circle increases. Refer to the images below:
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The radius of a circle can be altered any time after its creation. To set the radius:

1. Choose the Selection Tool in the Drawing Toolbar and then highlight the desired circle.

2. Click on the Geometry Tab in the Sidebar.

3. You will find the Radius option in the bottom right portion of the Shape Specific settings section. Use
the "up" or "down" arrow buttons to change the value or click on the text entry field to key in a value.
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When typing in a Radius value, a different unit of measure (i.e., points, pixels, millimeters, centimeters,

inches, feet, meters, etc.) other than the default of Inches can be entered for the dimensional attribute.

Enter the desired value and unit of measurement. Then use the Enter Key on your keyboard or click in another

area of TouchDraw 2, and the entered value will automatically be converted to its equivalent value in Inches.

Example 1: Entering 1 cm for the Radius

If 1 centimeter (1 cm) is entered for the Radius, it will be converted to 0.394 inches.
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Example 2: Entering 15 mm for the Radius

15 millimeters (15 mm) is entered for the Radius and is converted to 0.591 inches.

Example 3: Entering 100 pixels for the Radius
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If you enter 100 pixels (100 px), then the value would be 1.389 inches.

Note: A circle can also contain text. See Handling Text for further details.
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4.5.19. Rectangle Tool

The Rectangle Tool can be used to create rectangles or squares within a drawing.

To use the tool, select it and then use a Click/Drag combination at the point in the drawing canvas where one

of the bounding corners of the rectangle or square should be. Then drag in any direction and release the Click

action where the other bounding corner should reside on the drawing canvas.

Using the Rectangle Tool while holding down the Shift Key allows for the creation of perfect squares by

constraining the width and the height of the created object to equal values.

In the example below, a square that is 2 inches in height and width has been created:
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Note: A rectangle can also contain text. See the Handling Text section for additional details.

The Drawing Toolbar has an intuitive design that adjusts to match the current size of the application window.

For smaller screen areas, some tool buttons may be combined to form a pop-over menu. To select the

Rectangle Tool on smaller devices, perform an extended Click on the Oval Tool in the Drawing Toolbar and

then Click on the Rectangle Tool within the pop-over menu.
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4.5.20. Rounded Rectangle Tool

The Rounded Rectangle Tool can be used to create rounded rectangles or rounded squares within a drawing.

To use the tool, select it and use a Click/Drag combination at the point in the drawing canvas where one of the

bounding corners of the rounded rectangle or square should be. Then drag in any direction and release the Click

 action where the other bounding corner should reside on the drawing canvas.

Use the Rounded Rectangle Tool in conjunction with the Shift Key to create perfectly rounded squares.

Holding down the Shift key while creating a rounded rectangle constrains the width and the height to equal

values. In the example below, a rounded square that is 2 inches in height and width has been created:

The Drawing Toolbar has an intuitive design that adjusts to match the screen size of your computer or the

application window.
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For smaller screens or application windows, some tool buttons may be combined to form a pop-over menu. To

select the Rounded Rectangle Tool on smaller devices, perform an extended Click on the Oval Tool in the

Drawing Toolbar and then Click on the Rounded Rectangle Tool within the pop-over menu.

Note: A rounded rectangle can also contain text. See Handling Text for additional details.

The size of rounded corners can be specified prior to drawing the shape or altered any time after it has been

created. To set the corner size after creating a shape:

1. Choose the Selection Tool in the Drawing Toolbar and then highlight the desired rounded rectangle or
square.

2. Click on the Geometry Tab located under "Info" on the Sidebar. You will find the Corner Size option in
the bottom right portion of the Shape Specific settings section. Use the "up" or "down" arrow buttons to
change the value or click on the text entry field to key in a value.
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3. In the example below, the corner size has been changed to 1 inch.

When keying in a Corner Size value, another unit of measurement (i.e., pixels, points, millimeters,

centimeters, inches, feet, etc.) can be entered and will be converted into its equivalent measurement in Inches.

Enter the number value and the abbreviation for the desired unit of measurement. The number value will be

converted to Inches after hitting enter on the keyboard or selecting another item in TouchDraw 2.

1. Example 1: A value of 100 centimeters (100 cm) is entered for the corner size and converted to 39.37
inches.
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2. Example 2: A value of 10 millimeters (10 mm) is entered for the corner size and converted to 0.394
inches.

3. Example 3: A value of 25 pixels (25 px) is entered for the corner size and converted to 0.347 inches.

This measurement can also be altered before creating a shape by choosing the Selection Tool and changing the

Corner Size setting located in the Shape Specific settings on the Adjustment Tab in the Info section of the

Sidebar.
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Note: The unit of measure for the corner size is the unit of measure for the drawing; thus, if your unit of

measure is inches, and the corner size is set to .25, that means the corner size is 1/4 of an inch.
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4.5.21. Squircle Tool

The Squircle Tool can be used to create a squircle figure within a drawing. Select the tool and then use a

Click/Drag action at the point in the Drawing Canvas where one of the bounding corners of the squircle should

be. Then drag in any direction and release the Click action where the other bounding corner should reside on

the Drawing Canvas.

Use a Shift/Click action while creating the squircle to constrain the width and the height to equal values. In the

example below, a squircle that is 2 inches in height and width has been created:
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The corner size can be specified before drawing the shape or altered after it has been created. To set the corner

size after creating a shape, complete the following steps:

Step 1: Select a squircle within the drawing.
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Step 2: Select the Geometry Tab within the Sidebar.

Step 3: Use the Corner Size attribute to set the size. Click on the “up” or “down” buttons to change the value

or tap on the text entry field to bring up a keyboard for entering the value by hand.

Step 4: In the example below, the corner size has been changed to 0.75 inches:
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Note: A squircle can also contain text. See the Handling Text section for additional details.
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4.5.22. Polygon Tool

The Polygon Tool can be used to create regular polygons within a drawing.

To use the tool, select it and then use a Click/Drag combination at the point in the drawing canvas where the

center of the polygon will be. Then drag in any direction and release the Click action where one of the outer

points of the polygon should reside on the drawing canvas.

The Drawing Toolbar has an intuitive design that adjusts to match the screen size or application window size

on your computer.

For smaller devices, some tool buttons may be combined to form a pop-over menu. To select the Polygon Tool

for smaller screen sizes or a smaller application window, perform an extended Click on the Oval Tool in the

Drawing Toolbar and then Click on the Polygon Tool within the pop-over menu.



Page 230

TouchDraw 2 for Windows

The number of polygon sides can be specified prior to drawing the shape or altered any time after it has been

created. To set the number of sides after creating a shape:

1. Choose the Selection Tool in the Drawing Toolbar and then highlight the desired polygon.

2. Click on the Geometry Tab located under "Info" on the Sidebar. The # of Sides option is located in the
bottom center portion of the Shape Specific settings section.

3. Use the "plus" or "minus" buttons to change the value or click on the text entry field to key in a value.

4. In the example below, the value has been changed to 8.
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This measurement can also be altered before creating a shape by choosing the Selection Tool and changing the

# of Sides setting located in the Shape Specific settings on the Adjustment Tab in the Info section of the

Sidebar.
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Note: A polygon can also contain text. See the Handling Text section for additional details.
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4.5.23. Star Tool

The Star Tool can be used to create stars within a drawing.

To select the Star Tool, perform an extended Click on the Polygon Tool in the Drawing Toolbar to bring up the

menu and then select the Star Tool in the provided selection menu.

The Drawing Toolbar has an intuitive design that adjusts to match the screen size and application window size

of your computer.

For smaller devices, some tool buttons may be combined to form a pop-over menu. To select the Star Tool on

smaller devices, perform an extended Click on the Oval Tool in the Drawing Toolbar and then Click on the

Star Tool within the pop-over menu.

Click on the point in the drawing canvas where the center of the star should be and Drag outward. Do not

release the Click action until the star consists of the desired radius, angle, and size. The radius and angle values

will increase as the size of the star increases, as shown in the images below.
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The number of star points can be specified prior to drawing the shape or altered any time after it has been

created. To set the number of points:

1. Choose the Selection Tool in the Drawing Toolbar and then highlight the desired star.

2. Click on the Geometry Tab located under "Info" on the Sidebar. You will find the # of Points option in
the bottom left portion of the Shape Specific settings section. Use the "up" or "down" arrow buttons to
change the value or click on the text entry field to key in a value.
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3. In the example below, the value has been changed to 8.

This measurement can also be altered before creating a shape by choosing the Selection Tool and changing the

# of Points setting located in the Shape Specific settings on the Adjustment Tab in the Info section of the

Sidebar.
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Note: A star can also contain text. See Handling Text for further details.
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4.5.24. Text Tool

The Text Tool can be used to create a text area within a drawing.

To use this tool, select it and perform a Click/Drag combination at the point in the drawing canvas where one

of the bounding corners of the text area should be. Then drag in any direction and release the Click action

where the other bounding corner should be located.

After a text area has been added, the image shown below containing the default text "Double tap to edit text"

will appear.

Note: Double Clicking on a figure also causes the text editor to appear for entry.

Entered text is reflected in the drawing view to provide instant feedback as to how the completed text will look,

will wrap, etc.
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The text figure is different from all other types of figures because it only shows text. It cannot have a border

(stroke) or be filled; however, displayed text can include a shadow.

Adding Text to a Figure

To add text to the inside of a rectangle with a border, a circle, or a rounded rectangle:

1. Use one of the drawing tools to create a figure.
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2. Double Click on the desired figure, and the editor shown above will open.

3. Enter text and then click on the figure area to close the editor.
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4.5.25. Option Key

When the Option Key is used, it acts as an indicator to the tools that they should behave in a different manner

than they normally would.

For example, the Option Key can be used to alter the “phantom” control point position within the Drawing

Canvas for a Path or to change a corner point back to a smooth curve after a curve segment has been created

with the Path Tool.

Option/Click

An Option/Click combination allows the “phantom” control point position to be set to a desired location on the

drawing canvas after a Click/Drag combination has been performed to create a curve segment. The following

image shows the “phantom control point at the 3,3.5 position:
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An Option/Click combination is completed at the 4,1 position causing the “phantom” control point to be

moved to this location on the drawing canvas. Refer to the image below:
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Option/Click/Drag

An Option/Click/Drag combination allows the “phantom” control point to be dragged to any point on the

drawing canvas and changes a corner point back to a smooth curve after the initial Click/Drag combination has

been completed for creating the curve segment.
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4.5.26. Easy Drag Mode

TouchDraw 2 includes an Easy Drag Mode that makes it simpler to move and select figures without having to

worry about touching one of the handles (which could lead to an unwanted resize). This is also particularly

useful when trying to move a small object without having to zoom way in.

The following figures show how a selected figure will look when selected without the option enabled and how

they appear when Easy Drag Mode is enabled:
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This option can be enabled by performing the following steps:

1. Click on the View Menu in the Top Toolbar.

2. Then click on the Easy Drag Mode option. A checkmark will appear to the left of the option within the
View Menu when enabled.
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4.6. Sidebar
The Sidebar can be found on the right hand side of the main application window. It is used to make attribute

changes for objects (shapes, lines, paths, and text), to manage drawing layers, and for inserting stencils into a

drawing.

Click on the name of the Sidebar Section to find out more details about what actions are possible when it is

selected.

Icon Section Name Description

Info The Info section contains options for altering shape, line, path,

and text attribute settings.

Layers The Layers Tab provides the capability to incorporate more

than one level of objects into a drawing. Each added layer
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Icon Section Name Description

builds on top of the previous added layer to create a

multi-dimensional drawing.

Stencils The Stencils Tab provides the capability to add, remove, and

manage stencils for use in drawings. A stencil is a pre-defined

object that can be saved, named accordingly, and

dragged/dropped into drawings as needed. Touchdraw 2

provides a vast array of choices and you can create/store your

own objects as well.
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4.6.1. Info

The Info portion of the Sidebar contains attribute options for shapes, lines, paths, and text. Each tab

corresponds to a set of attributes and is explained in further detail below.

Values displayed in the Info portion of the Sidebar default to Inches or Degrees. However, alternative units of

measurement (i.e., centimeters, meters, feet, yards, etc.) or radians can be entered into these fields. The entered

values will be automatically converted to their equivalent in Inches or Degrees.

For example, let's say that 10 centimeters (10 cm) has been entered for the Width of a selected figure. This

value will be automatically converted to Inches after pressing on the Enter Key on your keyboard or selecting

another item within the application.
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If you enter 100 millimeters (mm) for the Width of a selected figure, then it will be automatically converted to

3.937 inches, as shown below:
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Click on the name of a specific Attribute Tab to learn more about available setting changes.

Icon Tab Name Description

Geometry The Geometry Tab contains options for altering attributes on a

selected figure or to make path-related changes to a figure.

Stroke The Stroke Tab contains options for altering the attributes of a

line (stroke).

Fill The Fill Tab contains options for altering the fill attributes of a

shape or pen object.
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Icon Tab Name Description

Text The Text Tab contains options for altering text attributes (size,

style, margins, color, and alignment).

Shadow and

Opacity

The Shadow and Opacity Tab contains options for altering

shadowing, opacity and blending attributes of a figure(s).

Connections Tab The Connections Tab contains options for altering the type of

connector used for the Connection Tool.

Units and Rulers The Units and Rulers Tab contains options for altering the

unit of measure, the background, and other drawing canvas

related settings. These options can be used to control the layout

and divisions of the ruler. Unit settings are additionally used

when drawings are exported in alternative formats such as PNG

images and PDF files.

Page Setup The Page Setup Tab contains options for altering printing

units, page width, page height, and print margin attributes.
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4.6.1.1. Geometry Tab

The Geometry Tab contains options for gaining enhanced control of a selected figure or to make path related

changes to a figure. The tab will appear as shown below when selected in the Sidebar.

Values displayed in the Geometry Tab default to Inches or Degrees. However, you can enter alternative units

of measurement (i.e. centimeters, meters, feet, yards, etc.) or radians. These values will be automatically

converted to their equivalent in Inches or Degrees.

Let's say for example that 10 centimeters (10 cm) has been entered for the Width of a selected figure. This

value will be converted to Inches after pressing on your keyboard's Enter Key or selecting another item within

the application.
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If 100 millimeters (mm) is entered as the Width of a selected figure, then it will be converted to 3.937 inches.
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Conversion can also be used for angle measurements, which use Degrees (°) as the unit of measurement. For

example, if you enter 1 radian (rad) as the Line Angle, it will be converted to 57.296°.
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Click on the corresponding Geometry Attribute name to learn more about what the option does.

Attribute Name Description

X The X attribute can be used to set the X position of the currently selected figure to the

entered value. It functions as a nudge tool when multiple figures are selected by

moving all figures in a manner relative to the entered change.

Y The Y attribute can be used to set the Y position of the currently selected figure to the

entered value. It functions as a nudge tool when multiple figures are selected by

moving all figures in a manner relative to the entered change.

Width The Width attribute can be used to set the width of all currently selected figures to the
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Attribute Name Description

entered value. The width of all figures is set to this value when multiple items are

selected. To scale the width based on the relative size within the selected figures,

group all of the figures and then resize.

Height The Height attribute can be used to set the height of the currently selected figure to

the entered value. The height of all figures is set to this value when multiple items are

selected. To scale the width based on the relative size within the selected figures,

group all of the figures and then resize.

Rotation The Rotation attribute can be used to set the angle of the currently selected figure to

the chosen slider or keyboard entered value. This option will set the angle of all

selected figures to the entered value and rotate them relative to their own centers when

multiple figures have been selected. It is best to group all desired figures and then

rotate them as a group when wanting to make this change relative to the center of the

selection.

Line Length The Line Length attribute can be used to set the length of a selected line(s). A line

must be selected for this option to be enabled.

Line Angle The Line Angle attribute can be used to set the rotation angle of a selected line(s). A

line must be selected for this option to be enabled.

Radius The Radius attribute can be used to set the radius of the currently select circle to the

entered value. In the instance of multiple figure selection, this option will set the

radius of all selected figures to the entered value.

Corner Size The Corner Size attribute can be used to set the size of the corner for a rounded

rectangle. The units for the corner size are the units of measure of the drawing. For

example, if the units of measure for the drawing were inches and the size of the corner

is set to ".25", the corner size is 1/4 of an inch.

# of Points The # of Points attribute can be used to set the number of points for a star. In the

instance of multiple figure selection, this option will set the number of points of all

selected figures to the entered value.

# of Sides The # of Sides attribute can be used to set the number of sides for a polygon. In the

instance of a multiple figure selection, this option will set the number of sides of all

selected figures to the entered value.
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Note: The value displayed in the text field of each attribute setting represents the value of the first selected

figure.



Page 257

TouchDraw 2 for Windows

4.6.1.2. Stroke Tab

The Stroke Tab contains options for setting the attributes of a line (stroke). The tab will appear as shown

below when selected in the Sidebar.

Values displayed in the Stroke Tab default to Points; however, alternative units of measurement may be typed

in: Pixels, Centimeters, Millimeters, Inches, etc. These values will be automatically converted to their

equivalent in Points.

For example, if 5 pixels (5 px) is entered for the Stroke Size, then it will be automatically converted to Points

after pressing on your keyboard's Enter Key or selecting another item in TouchDraw 2.
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Pixels and points will have the same number value after conversion when the default measurement is points;

however, you can enter points or pixels for conversion to inches in other parts of the Sidebar, such as the

Geometry Tab.
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If 5 centimeters (cm) is entered as the Stroke Size, it will be converted to 141.732 points.
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If 10 millimeters (mm) is entered as the Stroke Size, it will be converted to 28.346 points.
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Click on the corresponding Stroke Attribute name to learn more about what the option does.

Attribute Name Description

Stroke The Stroke attribute is an "On/Off" toggle button for setting the visibility of strokes

or lines of a figure(s). The border or line of a figure is not drawn when this option is

disabled.

Dash Pattern The Dash Pattern attribute can be used to set the style of the line being created.

Size The Size attribute can be used to set the width of a stroke in pixels.

Start The Start attribute can be used to set the style of the beginning portion of a created

line.

End The End attribute can be used to set the style of the ending portion of a created line.

Start Scale The Start Scale attribute can be used to scale the start of a line independently from

the stroke size.

End Scale The End Scale attribute can be used to scale the end of a line independently from the

stroke size.

Start Shear The Start Shear attribute can be used to Shear (or skew) the start arrowhead on lines.

The value defaults to degrees.

End Shear The End Shear attribute can be used to enter the Shear value for the end arrowhead

on lines. The value defaults to degrees.
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Attribute Name Description

Line Join The Line Join attribute can be used to set the join of a line to Mitered, Rounded, or

Beveled.

Line Cap The Line Cap attribute can be used to set the cap of a line to Butt, Rounded, or

Square.

Location The Location attribute can be used to set the location where the line will join with

another object.

Miter Limit The Miter Limit attribute can be used to set the angle of connected line segments

where they join. The join will be more jagged or sharp depending on the entered or

selected value. Miter limits are relative to stroke size and become increasingly

noticeable for line segments with increased thickness.

Stroke Color The Color attribute can be used to specify the color of a stroke. Refer to the Handling

Colors section to learn more about color attribute changes.
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4.6.1.3. Fill Tab

The Fill Tab contains options for configuring the fill attributes of all objects with the exception of the Line and

Connection tools. The tab will appear as shown below when selected in the Sidebar.

Click on the corresponding Fill Attribute name to learn more about what the option does.

Attribute Name Description

Fill The Fill attribute is an "On/Off" button for toggling the visibility of the fill of a

figure(s). Shapes have no fill when this option is disabled.

Fill Style The Fill Style attributes options are located underneath the Fill attribute. This option

sets the type of fill pattern used for a figure(s).

Solid - Fills a figure with solid color.

Linear Gradient - Transitions from the specified start color to the specified end color

at a designated angle.

Radial Gradient - A radial gradient transitions from the specified start color to the

specified end color by starting from the center of the figure and then moving outward

in a circular manner.

Color The Color attribute is used to choose the fill color for a figure(s). See the Handling

Colors section for additional details.
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4.6.1.4. Text Tab

The Text Tab contains options for setting the text attributes of a figure(s). The tab will appear as shown below

when selected in the Sidebar.

Values displayed in the Text Tab default to Points; however, alternative units of measurement may be typed in

(i.e., pixels, millimeters, centimeters, inches, feet, etc.). These values will be automatically converted to their

equivalent in Points after pressing the Enter Key on your keyboard or clicking in another area of TouchDraw 2.

If you enter 5 pixels (px) as the Font Size, it will be converted to 5 points (pt).
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Pixels and points will have the same number value after conversion when the default measurement is points;

however, you can enter points or pixels for conversion to inches in other parts of the Sidebar, such as the

Geometry Tab.

For example, if 1 centimeter (1 cm) is entered for the Font Size, it will be automatically converted to Points

after pressing the Enter Key on your keyboard or selecting another item in TouchDraw 2.
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If 5 millimeters (5 mm) is entered as the Font Size, it will be converted to 14.173 points.

Click on the corresponding Text Attribute name to learn more about what the option does.
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Attribute Name Description

Font Family The Font Family attribute is used to choose a set of fonts with the same typeface but

varying qualities such as size and weight.

Font Style The Font Style attribute sets the style or angle of text within a figure(s).

Font Size The Font Size attribute sets the height of characters in a selected font family.

Text Margin The Text Margin attribute sets the margins for text within a figure(s). The

measurement spans from the text box edge to the actual text.

Alignment The Alignment attribute sets the vertical and horizontal text alignment modes for text

within a figure(s).

Text Color The Text Color attribute sets the color of text appearing in a figure(s).

Attached The Attached option is disabled by default. When enabled, the location and

orientation of the attached text can be altered for a line or path.

Text Location The Text Location option can be used to change the location of text that is attached to

a line or path.

Text Orientation The Text Orientation option can be used to change the orientation of the text that is

attached to a line or path. Text orientation can be Absolute or Relative.

Note: Refer to the Handling Text section of this documentation to learn more about attribute changes or editing

text for figures.
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4.6.1.5. Connection Type Tab

The Connection Type Tab can be used to change the type of connection line used in conjunction with the

Connection Tool.

These options are accessible through the Sidebar by clicking on the Connection Type Tab.

Click on the name of an available Connection Type Tab choice to find out more details about what action

occurs when it is selected.

Icon Name Description

Line Connection

Tool

The Line Connection Tool draws a line connection that

connects two shapes in the shortest path.

East-West

Connection Tool

The East-West Connection Tool draws a connection line that

originates from the side (either west/left or east/right) of the

source figure and connects to the side (either west/left or

east/right) of the target figure.

North-South

Connection Tool

The North-South Connection Tool draws a connection line

that originates from the side (either north/top or south/bottom)

of the source figure and connects to the side (either north/top or

south/bottom) of the target figure.

Horizontal-Vertical

Connection Tool

The Horizontal-Vertical Connection Tool draws a connection

line that originates horizontally from the right or left side of the

source figure and connects vertically to the side (top) of the

target figure.

Vertical-Horizontal

Connection Tool

The Vertical-Horizontal Connection Tool draws a connection

line that originates vertically from the side (either top or

bottom) of the source figure and connects to the side (either left
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Icon Name Description

or right) of the target figure.

Path Connection

Tool

The Path Connection Tool creates a path connection that

connects two shapes. As with paths created with the Path Tool,

path connections can be manipulated to add additional line or

curve segments.

Hub Connection

Tool

The Hub Connection Tool creates a connection line that is

able to receive connections. This is typically used for creating

network diagrams.
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4.6.1.6. Shadow and Opacity Tab

The Shadow and Opacity Tab contains options for altering shadowing, opacity and blending attributes of a

figure(s). The tab will appear as shown below when selected in the Sidebar.

Values displayed in the Shadow and Opacity Tab default to Points; however, alternative units of

measurement may be typed in (i.e., pixels, millimeters, centimeters, inches, feet, etc.). These values will be

automatically converted to their equivalent in Points after pressing the Enter Key on your keyboard or clicking

on another item within TouchDraw 2.

For example, if you enter 5 pixels (px) as the X Offset, it will be converted to 5 points (pt).
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Note: Pixels and points have the same number value after conversion when the default measurement is points;

however, you can enter points or pixels for conversion to inches in other parts of the Sidebar, such as the

Geometry Tab

If 1 centimeter (1 cm) is entered for the X Offset, it will be automatically converted to Points after pressing on

the Enter Key or selecting another item in TouchDraw 2.

If 5 millimeters (5 mm) is entered as the X Offset, the value will be converted to 14.173 points.
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Click on the corresponding Shadow Attribute name to learn more about what the option does.

Attribute Name Description

Shadow and

Opacity

The Shadow and Opacity attribute is used to toggle the shadow visibility of a

figure(s). A shadow is not drawn if this option is disabled.

X Offset The X Offset attribute sets the offset of the shadow in the X axis.

Y Offset The Y Offset attribute sets the offset of the shadow in the Y axis.

Blur The Blur attribute sets the amount of blur applied to the shadow.

Shadow Color The Shadow Color attribute sets the shadow color for a figure(s). Refer to the

Handling Colors section of this documentation to learn more about color attribute

alterations.

Opacity The Opacity attribute can be used to alter the opaqueness (opposite of transparency)

of a selected color.
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4.6.1.7. Units and Rulers Tab

The Units and Rulers Tab contains options for altering the unit of measure, background, and additional

drawing canvas related settings.

These options are used to control the layout and divisions of the ruler. Unit settings are additionally used when

drawings are exported in alternative formats such as a PDF file. The tab will appear as shown below when

selected in the Sidebar.

Click on the corresponding Units and Rulers Attribute name to learn more about what the option does.

Attribute Name Description

Drawing Units The Drawing Units attribute sets the form of unit measurement on the drawing

canvas (inches, pixels, etc.).

Grid Type The Grid Type attribute configures what type of grid will be used for your drawing

(i.e., square or isometric).

Major Gridline The Major Gridline attribute sets the interval (in the current unit of measure) that a

major gridline will be drawn. For example, if the unit of measure is centimeters and

the major gridline is set to 2, it will draw the major gridline every two centimeters.

Subdivisions The Subdivisions attribute sets the number of subdivisions (minor gridlines) that are

drawn between the Major Gridlines. For example, if the unit of measure is centimeters
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Attribute Name Description

and the major gridline is set to 2, and the subdivisions is set to 4, it will draw a minor

gridline ever 1/2 cm (5mm)

Grid Color Type The Grid Color Type attribute is used to change the grid color type to auto or fixed.

Auto is the default selection. Fixed can be selected to customize the grid color.

Major Color The Major Color attribute is used to select a color for the major gridlines.

Minor color The Minor Color attribute is used to select a color for the minor gridlines.

Scale The Scale attribute can be used to change the scale of the drawing to the size of the

printed drawing.

Limit Stroke

Scaling

The Limit Stroke Scaling attribute is used to configure TouchDraw 2 so that lines

having a thickness smaller than 1 (based on the current zoom level) are drawn at 1

pixel. This setting makes certain these lines are always visible.

Note: A change from one unit of measurement to another does not numerically change the size of figures. For

example, changing from inches to centimeters where the objects were previously 1 inch wide causes the objects

to become 1 centimeter wide. You can use the "Scale By..." option to scale the drawing after the conversion.
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4.6.1.8. Page Setup Tab

The Page Setup Tab contains options for altering the print margins of a drawing. The tab will appear as shown

below when selected in the Sidebar. Values displayed in the Page Setup Tab default to Inches.

Click or Tap on the corresponding Page Setup Attribute name to learn more about what the option does.

Attribute Name Description

Page Size The Page Size attribute sets the size of the entire page (i.e. letter, legal, A4, etc.). By

default the page size is set to letter.

Page Units The Page Units attribute sets the unit of measurement used to define the attributes

on this page.

Page Width The Page Width attribute sets the width of the page in printing units.

Page Height The Page Height attribute sets the height of the page in printing units.

Top Margin, Bottom

Margin, Left

Margin, and Right

Margin

The Top Margin, Bottom Margin, Left Margin and Right Margin attributes can

be used to set the page margins in user specified printing units.

Orientation The Orientation attribute sets the Drawing Canvas to portrait or landscape mode.

By default the canvas is set to portrait.
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Attribute Name Description

Background Color The Background Color attribute sets the background color of the drawing. Refer to

the Handling Colors section in this documentation to learn more about color

selection.

Transparent The Transparent attribute toggles whether or not the background of the drawing is

transparent. For example, if you want to export your drawing as a transparent PNG,

then you'd want this option selected.

Note: Refer to Printing a Drawing to learn more about setting the print options for drawings.
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4.6.2. Layers

Layers provide the capability to incorporate more than one level of objects into a drawing. Each added layer

builds on top of the previously created layer to create a multidimensional drawing.

They are managed and controlled through the Layers Portion of the Sidebar located on the right-hand side of

the main application window. This section appears as shown below.

Note: Click on the corresponding Layer Function name to learn more about what the option does.

Icon Function Name Description

Add The Add function adds a layer to the bottom of the layer list.

Delete The Delete function removes the top layer from the layer list.

Layer Settings

Menu

The Layers Settings Menu contains options for adding,

deleting, re-ordering and merging layers.

Visibility The Visibility option is an "On/Off" toggle button for setting

the visibility of each created layer. It appears to the right of

each layer name in the list as an "eye" icon and indicates the

visibility of the layer. To hide (or show) a layer, Click on the

eye icon of the layer to be toggled. An eye icon with a line

through it indicates that a particular layer is not visible, whereas

an eye with no line indicates a layer is visible.

Lock The Lock option is an "On/Off" toggle button for locking or

unlocking a layer. It is located to the right of the visibility icon

and indicates whether or not a layer is locked. To lock (or

unlock) a layer, Click on the lock icon of the layer to be
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Icon Function Name Description

toggled. A closed lock icon indicates that a layer is locked, and

an open lock icon indicates a layer is unlocked.

Note: Layers located at the top of the Layers Sidebar List are drawn above the layers below it.
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4.6.2.1. Layers Settings Menu

The Layers Settings drop-down menu is used to perform specific actions on a created layer or set of layers. It

resides in the upper right-hand corner of the Layers section of the Sidebar, as shown in the image below.

Perform a Single Click on this menu to access additional options.

Click on the corresponding Layers Setting Menu name to learn more about what the option does.

Option Name Description

Add Layer The Add Layer option adds a layer above existing layers. A new layer appears at the

top of the sidebar list.

Duplicate Layer The Duplicate Layer option creates an exact copy of a selected layer and adds it to

the top of the sidebar list.

Rename Layer The Rename Layer option can be used to change the current name of a selected layer
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Option Name Description

in the list

Delete Layer The Delete Layer option permanently removes a selected layer from the layers list.

Move Layer Up The Move Layer Up option moves a selected layer up one level in the sidebar list.

Move Layer Down The Move Layer Down option moves a selected layer down one level in the sidebar

list.

Merge Layer Up The Merge Layer Up option merges the selected layer with the one residing above it

in the sidebar list.

Merge Layer Down The Merge Layer Down option merges the selected layer with the one residing below

it in the sidebar list.

Merge All Layers The Merge All Layers option merges all existing layers into a single layer.

Show All Layers The Show All Layers option makes all layers within the currently open drawing

visible.

Hide All Layers The Hide All Layers option hides all layers within the currently open drawing.

Lock All Layers The Lock All Layers option locks all layers within the currently open drawing.

Unlock All Layers The Unlock All Layers option unlocks all layers within the currently open drawing.

Sort Layers

(Ascending)

The Sort Layers (Ascending) option sorts all layers within a drawing in ascending

order alphabetically by name.

Sort Layers

(Descending)

The Sort Layers (Descending) option sorts all layers within a drawing in descending

order alphabetically by name.

 

Note: The Move and Merge options are enabled when two or more layers exist in the sidebar list.

Corresponding up and down options for these categories require a layer to be available above or below the

selected layer to appear as a menu selection.
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4.6.3. Stencils

Stencils are pre-defined or custom objects you can insert into a drawing as needed. Libraries are used to add

and manage Stencils stored within the application and for adding these objects to a drawing.

Both Stencils and Libraries are managed through the Stencils Tab, which can be accessed within the Sidebar.

Click or Tap on the corresponding Stencils Tab item name to learn more about what the option does.

Icon Option Name Description

Libraries Settings

Menu

The Libraries Settings Menu contains options for adding,

removing, and renaming libraries as well as options for

managing stencils within each library.

Library Selection

Menu

The Library Selection Menu can be used to choose a specific

library stored within the application.

Search The Search Feature can be used to find a specific stencil

within the selected library.

Stencil Selection

Area

The Stencil Selection Area shows all stencils within a selected

library and can be used to make drawing additions.
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4.6.3.1. Libraries Settings Menu

The Libraries Settings drop-down menu is used to create, alter, or delete libraries. It is located in the upper

right-hand corner of the Libraries section in the Sidebar, as shown in the image below. Perform a single click

on this menu to access additional options.

Click on the corresponding Libraries Settings Menu name to learn more about what the option does.

Option Name Description

Add Selection To Library

As Group

The Add Selection To Library As Group option inserts a group of stencils

into the selected library.

Add Selection To Library The Add Selection To Library Individually option inserts a new stencil into
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Option Name Description

Individually the selected library.

New Library The New Library option creates a new library in TouchDraw.

Rename Library The Rename Library option assigns a new name to a selected library.

Delete Library The Delete Library option removes a library from TouchDraw.

Import Library... The Import Library... option imports a library into TouchDraw from another

location.

Export Library... The Export Library... option exports a library from TouchDraw to a chosen

directory.

Rename Stencil The Rename Stencil option assigns a new name to a selected stencil.

Delete Stencil The Delete Stencil option removes a stencil from the selected library.

Note: For more information about managing libraries and stencils, please see the Handling Libraries section of

the user guide.
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4.7. Contextual Menu
The Contextual Menu provides quick access to various editing functions made available through the

TouchDraw 2 application.

Hold the Shift Key and Click (right-click) anywhere on the Drawing Canvas or on a selected figure(s) to bring

up this menu.

Note: Choices may or may not be enabled depending on the selected figure where right-clicking occurs.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Option Name Description

Cut The Cut menu item removes the currently selected item from the active drawing and

places it in the clipboard.

Copy The Copy menu item places a copy of the currently selected item into the clipboard.

Paste The Paste menu item adds the most current item residing in the clipboard to the active

drawing.

Paste Special

Submenu

The Paste Special submenu contains special options related to pasting the contents of

the clipboard into the active drawing.
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Option Name Description

Duplicate The Duplicate menu item creates a copy of a selected item in the active drawing.

Duplicate in Place The Duplicate in Place menu item creates a copy of a selected item and places it in

the same location as the original.

Select All The Select All menu item selects all items residing in the currently active drawing.

Deselect All The Deselect All menu item deselects all items residing in the currently active

drawing.

Invert Selection The invert Selection menu item inverts the current selection or the Deselect All

Selection option to deselect all currently selected figures within the Drawing Canvas.

Arrange Submenu The Arrange Submenu contains options for grouping, locking, and ordering figures

within a drawing.

Align Submenu The Align Submenu contains options for aligning selected figures within a drawing.

Canvas Submenu The Canvas Submenu contains an option for resetting the point of origin within a

drawing.

Distribute

Submenu

The Distribute Submenu contains options for distributing the selected figures within

a drawing.

Paths Submenu The Paths Submenu contains options for altering handles and segments of a path.

Move to Layer

Submenu

The Move To Layer Submenu contains options for moving selected figure(s) to a

new or existing layer.

Style as

Dimension Line

The Style as Dimension Line option adds arrowheads and a {Length} variable to a

selected line(s). At least one line must be selected in the drawing canvas for this

option to appear.
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4.7.1. Paste Special Submenu

Use the Paste Special Submenu to access special actions related to pasting the contents of the clipboard into

the active drawing. It is accessed by right-clicking anywhere in the Drawing Canvas.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Paste in Place The Paste in Place menu item copies the current clipboard item into the exact

location of the original.

Paste Multiple The Paste Multiple menu item can be used to paste multiple copies of a clipboard

item at specific offsets.

Paste Style The Paste Style menu item applies the formatting properties of one object to the

currently selected object.
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4.7.2. Arrange Submenu

Use the Arrange Submenu to access actions for grouping, locking, and ordering selected figures within a

drawing. When this submenu is selected, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Group The Group menu item allows currently selected shapes on the drawing canvas to be

manipulated and treated as a single figure. This menu item is enabled when two or

more groupable figures are selected in the drawing canvas. Shapes residing on the

drawing canvas can be manipulated.

Ungroup The Ungroup menu item removes the grouping attribute for selected shapes to allow

for individual manipulation. This menu item is enabled when one or more grouped

figures are selected in the drawing canvas.

Lock The Lock menu item prevents a selected figure(s) or group of figures from being

moved or resized. This menu item is enabled when one or more unlocked (and
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Menu Item Description

lockable) figures are selected in the drawing canvas.

Unlock The Unlock menu item removes a previously instated lock on a figure(s) or group of

figures to allow for moving and resizing. This menu item is enabled when one or more

locked figures are selected in the drawing canvas.

Bring to Front The Bring to Front menu item moves a currently selected figure(s) to the front of all

figures residing in the same layer. This menu item is enabled when one or more

figures are selected in the drawing canvas.

Bring Forward The Bring Forward menu item moves a currently selected figure(s) one step closer to

the top of the stack within the layer they reside in. This menu item is enabled when

one or more figures are selected in the drawing canvas.

Send Backward The Send Backward menu item moves a currently selected figure(s) one step closer

to the bottom of a stack within their residing layer. This menu item is enabled when

one or more figures are selected in the drawing canvas.

Send to Back The Send to Back menu item moves a currently selected figure(s) behind all other

figures residing within the same layer. This menu item is enabled when one or more

figures are selected in the drawing canvas.



Page 289

TouchDraw 2 for Windows

4.7.3. Align Submenu

Use the Align Submenu to access actions for aligning selected figures within a drawing. When this submenu is

selected within the Arrange menu, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Align to Grid The Align to Grid menu item aligns figures with the grid. This menu item is enabled

when two or more unlocked figures are selected in the drawing canvas.

Align Top The Align Top menu item moves all currently selected figures to match the top (Y

position) of the first selected figure. This menu item is enabled when two or more

unlocked figures are selected in the drawing canvas.

Align Vertical

Center

The Align Vertical Center menu item moves all currently selected figures to match

the vertical center (Y position + 1/2 of the height of all figures) of the first selected

figure. This menu item is enabled when two or more unlocked figures are selected in

the drawing canvas.

Align Bottom The Align Bottom menu item moves all currently selected figures to match bottom (Y

position + Height) of the first selected figure. This menu item is enabled when two or
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Menu Item Description

more unlocked figures are selected in the drawing canvas.

Align Left The Align Left menu item moves all currently selected figures to match the left (X

position) of the first selected figure. This menu item is enabled when two or more

unlocked figures are selected in the drawing canvas.

Align Horizontal

Center

The Align Horizontal Center menu item moves all currently selected figures to

match the horizontal center (X position + 1/2 of the width) of the first selected figure.

This menu item is enabled when two or more unlocked figures are selected in the

drawing canvas.

Align Right The Align Right menu item moves all currently selected figures to match the right (X

position + Width) of the first selected figure. This menu item is enabled when two or

more unlocked figures are selected in the drawing canvas.
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4.7.4. Canvas Submenu

Use the Canvas Submenu to reset the point of origin within a drawing. When this submenu is selected, the

submenu will appear as shown below.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Set Origin The Set Origin menu item resets (moves) the top left of the drawing (0,0) to the

specified point on the Drawing Canvas. This will be the point where the extended

click has been performed to bring up the Contextual Menu.
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4.7.5. Distribute Submenu

Use the Distribute Submenu within the Contextual Menu contains options for distributing the selected figures

within a drawing. It is accessed by right-clicking anywhere in the Drawing Canvas.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Distribute

Horizontally

The Distribute Horizontally menu item adjusts the positioning of selected figures to

create an even amount of horizontal space between each figure. This menu item is

enabled when three or more unlocked figures are selected in the drawing canvas.

Distribute

Vertically

The Distribute Vertically menu item adjusts the positioning of selected figures to

create an even amount of vertical space between each figure. This menu item is

enabled when three or more unlocked figures are selected in the drawing canvas.

Pack Horizontally The Pack Horizontally menu item takes a set of selected shapes and “packs” them

into the smallest space possible horizontally.

Pack Vertically The Pack Vertically menu item takes a set of selected shapes and “packs” them into
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Menu Item Description

the smallest space possible vertically.

Pack The Pack menu item takes a set of selected shapes and "packs" them into as small of a

rectangular space as possible. Be aware that the arrangement of selected figures might

be altered in order to pack them into the smallest space.
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4.7.6. Paths Submenu

Use the Paths Submenu to alter selected handles and segments within a path figure on the drawing canvas.

When this menu is selected, the options shown below will appear.

Click on the name of the menu item to find out more details about what action occurs when it is selected.

Menu Item Description

Convert Shape to

Path

The Convert Shape to Path menu item converts a selected shape(s) on the Drawing

Canvas into a path figure.

Insert Handle The Insert Handle menu item inserts a handle into the currently selected path

segment.

Delete Handle The Delete Handle menu item deletes the currently selected handle from a path

segment.

Split Path at

Handle

The Split Path at Handle menu item divides a path into two separate sections at the

chosen handle and allows each section to be altered as an individual figure.

Delete Segment The Delete Segment menu item deletes the currently selected segment from a path.

Segment to Line The Segment To Line menu item can be used to convert a quadratic or cubic path

segment into a line segment.
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Menu Item Description

Segment to Quad The Segment To Quad menu item can be used to convert a line or cubic path

segment into a quadratic segment.

Segment to Cubic The Segment To Cubic menu item can be used to convert a line or quadratic path

segment into a cubic segment.
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4.7.7. Move to Layer Submenu

The Move To Layer Submenu contains options for moving selected figure(s) to a new or existing layer. It is

accessed by right-clicking anywhere in the Drawing Canvas.

Click on the corresponding Move to Layer Submenu item name to learn more about what the option does.

Option Name Description

Existing Layers Existing Layers within the drawing are shown in the top portion of the submenu.

Choose a layer from this menu to move a selected figure(s) to a specified layer within

the active drawing.

Add Layer The Add Layer option creates a new layer and places the selected figure(s) in that

layer.
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4.8. Bottom Bar
At the bottom of the drawing window, to the left of the horizontal scroll bars, is a small Bottom Bar offering

quick access to a few common settings.

Image Control Name Description

Zoom Popup The Zoom Popup allows you to quickly access common zoom

levels from a popup menu.

Layers Popup The Layers Popup allows you to quickly select a layer from

the bottom bar.

Layers Settings

Menu

The Layers Settings Menu allows you to quickly access the

layers settings menu functionality for a selected layer within the

bottom bar.
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5. File Management
TouchDraw 2 provides numerous File Management options to make working with new, saved, or imported

drawings easier. The following pages explain how to perform basic file operations.
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5.1. Creating a New Drawing
Click on the File Menu and select New to create a new drawing from the main application window.

Next, choose a template to use for the new drawing by clicking on the desired selection. The currently selected

template will have a light blue box around it.

Click on Choose in the bottom right corner to create the new drawing or click on Cancel to exit this window

without making a selection.
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The display selection defaults to Common; however, you can click on the Template Type Option (Print,

Mobile, Screens, etc.) in the left selection panel to view additional options.
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Click on an item within the menu to make a selection, and all available templates for that selection will be

displayed. In this example, Mobile has been chosen:
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After a template has been chosen, a blank Drawing Canvas will appear. In the example below, Letter (8 1/2 by

11) has been selected.
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5.2. Opening a Drawing
Click on the File Menu and select Open to open an existing drawing in the main application window for

editing.

Select the file location in the Open Window and then click on Open located in the bottom right corner of the

screen.
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The selected file will appear in the main application window as part of the Drawing Canvas.



Page 306

TouchDraw 2 for Windows

Note: A recently created or edited file can be opened by clicking the File Menu and choosing Open Recent.

To clear the current list of recent drawings, click on Clear Menu at the bottom of the menu.
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5.3. Importing a Drawing
TouchDraw 2 supports the ability to open alternative file types besides native documents. The list of supported

file types are:

• TouchDraw Native (.t2d)

• Scalable Vector Graphics (.svg)

• Visio XML Drawing (*.vdx)

• Portable Network Graphic (.png)

• JPEG (.jpg, .jpeg)

• BMP (.bmp)

• TIFF (.tif, .tiff)

• Enhanced Metafile (.emf)

• Windows Metafile (.wmf)

Note: When a drawing document that is not in the native TouchDraw format is opened, it will automatically be

converted, and a TouchDraw drawing document will be created from it.

Importing Non-Native File Formats

Follow the steps below to complete a file import:

Step 1: Click on the File Menu and select Open.

Step 2: Navigate to the directory containing the file to be imported.
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Step 3: Click on the appropriate file name. In this example, Square.svg in iCloud Drive will be selected.

Step 4: Click on the Open Button.
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Step 5: The selected file will automatically be opened in TouchDraw 2 as a new drawing. In this example, the

Square.svg file has been imported.
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Note: Only files with the appropriate extension will be presented as a selectable item in the shown directory list.
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5.4. Saving a Drawing
TouchDraw 2 offers two methods for Saving a Drawing (Save and Save As...). Follow the steps below if

saving a drawing for the first time.

1. Click on the File Menu and choose Save.

2. Enter a file name, choose a save location, and click Save.
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3. The file name will appear above the Format Bar and next to the Application Toolbar, as shown below:

 

Save

An existing file can be saved at any time by selecting the Save option under the File Menu. The drawing will

automatically be saved if it has been previously saved regardless of any made changes.

Save As

An existing file can be saved under another name by using the Save As... option under the File Menu.
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Enter a new file name in the Save As window, select the save location, and click on Save.

The new name will appear above the application toolbar, as shown below:
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If a file with the same name already exists, TouchDraw 2 shows a warning message asking if the current file

should be replaced. Click Replace to overwrite the existing file or Cancel to exit the operation.
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5.5. Exporting a Drawing
TouchDraw 2 currently support five different exporters to Export a Drawing:

• Bitmap Image (PNG, JPEG, TIFF, BMP)

• PDF (Portable Document Format)

• SVG (Scalable Vector Graphics)

• Microsoft Visio (VDX Format)

• TouchDraw 1

Follow the steps below to export a drawing:

Step 1: Select the File Menu and choose Export... to open the file export popover or use the Control-E

Keyboard Shortcut to open this window.

Step 2: Choose a file format for the drawing export. The popover will reconfigure itself to show all valid

options for the selected format.

The screenshot example shown below represents available options for exporting as an image and includes the

capability of configuring maximum image size among additional options.
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Step 3: Click on the Export Button once the appropriate file format and all corresponding options have been

set.
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When you export a drawing as an Image, PDF, SVG, or TouchDraw 1 format, the popover window will show a

drawing preview. A preview is not given when exporting a drawing in Visio format.

Note: For detailed information on all of the options, limitations, and known issues for the supported file

formats, please refer to the Exporting subsection of the File Format Support section.

Additional Links

The following links can be used to learn more about the available options for each export format:

• Exporting a Bitmap Image

• Exporting to PDF

• Exporting to SVG

• Exporting to VDX

• Exporting to TouchDraw 1
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Exporting a Bitmap Image

A drawing can be exported as an bitmap image file in any of the PNG, JPEG, TIFF, GIF, or BMP file formats.

Click on the name of the Image Export Option to learn more about what actions occur upon selection.

Option Name Description

Content The Content option is used to select what will be exported: current layer, current

selection, all layers, or visible content.

Format The Format option is used to select the type of image file to be created by the export:

PNG, JPEG, TIFF, GIF, or BMP.

Image Size The Image Size option shows the current width and height of the image and can be

altered prior to exporting.

Scale The Scale option sets the dimension of the exported image to a specific percentage

relative to the drawings actual size.
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Option Name Description

Constrain

Proportions

The Constrain Proportions option links the width and height when selected.

Include Grid The Include Grid option tells TouchDraw 2 to include (or not include) the grid in the

generated file.

Half Pixel Shift The Half Pixel Shift option shifts pixel half a pixel-width toward the right.

Force Transparent

Background

The Force Transparent Background option makes the background transparent to

only show the images to be exported.

Include Margin The Include Margin option tells TouchDraw 2 to include (or not include) margins in

the generated file..

Quality The Quality option alters the image quality for JPEG image exports.

Preview Zoom The Preview Zoom slider can be use to increase or decrease the zoom level in the

export preview pane.
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Exporting to PDF

A drawing can be exported as an PDF (Portable Document Format) file format.

Click on the name of the PDF Export Option to learn more about what actions occur upon selection.

Option Name Description

Content The Content option is used to select what will be exported: current layer, current

selection, all layers, or visible content.

Include Grid The Include Grid option tells TouchDraw 2 to include (or not include) the grid in the

generated file.

Include Margin The Include Margin option generates a margin of a specified size around the drawing

to be exported.

Preview Zoom The Preview Zoom slider can be use to increase or decrease the zoom level in the

export preview pane.
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Exporting to SVG

A drawing can be exported as an SVG (Scalable Vector Graphics) file format.

Click on the name of the SVG Export Option to learn more about what actions occur upon selection.

Option Name Description

Content The Content option is used to select what will be exported: current layer, current

selection, all layers, or visible content.

Include Grid The Include Grid option tells TouchDraw 2 to include (or not include) the grid in the

generated file.

Include Margin The Include Margin option generates a margin of a specified size around the drawing

to be exported.

Preview Zoom The Preview Zoom slider can be use to increase or decrease the zoom level in the

export preview pane.
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Exporting to VDX

A drawing can be exported as an VDX (Microsoft Visio XML Drawing) file format.

Click on the name of the VDX Export Option to learn more about what actions occur upon selection.

Option Name Description

Content The Content option is used to select what will be exported: current layer, current

selection, all layers, or visible content.

Preview Zoom The Preview Zoom slider can be use to increase or decrease the zoom level in the

export preview pane.
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Exporting to TouchDraw 1

A drawing can be exported as the native TouchDraw 1 file format.

Click on the name of the TouchDraw 1 Export Option to learn more about what actions occur upon selection.

Option Name Description

Content The Content option is used to select what will be exported: current layer, current

selection, all layers, or visible content.

Preview Zoom The Preview Zoom slider can be use to increase or decrease the zoom level in the

export preview pane.
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5.6. Printing a Drawing
TouchDraw 2 supports the capability of printing drawings to local printers. The print options can be accessed

from two locations: the Main Toolbar and the File Menu as shown below.

The Printer Options view will open. This view is used to configure printers, set the number of copies, choose

the number of pages, and set additional print settings.

Click on the Print button to print the drawing once all optinos have been selected/configured.
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5.7. Closing a Drawing
To Close a Drawing, select the File Menu and click on the Close option as shown below.

Note: You may also use the Control-W keyboard shortcut to perform the same action within TouchDraw 2.
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5.8. Inserting an Image
An image file can be inserted as part of a drawing. These image types are supported by the TouchDraw 2

application:

• Portable Network Graphic (.png)

• JPEG (.jpg, .jpeg)

• BMP (.bmp)

• TIFF (.tif, .tiff)

• GIF (.gif)

Follow the steps below to Insert an Image:

Step 1: Select the File Menu and click on Insert Image...

Step 2: Navigate to the directory location of a desired image file. Then click on the appropriate file name to

select it.

Next, click on the Open button in the bottom right of the window.



Page 328

TouchDraw 2 for Windows

Step 3: The selected image will appear in the drawing canvas.
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Note: Only files with the appropriate extension will be presented as a selectable item in the shown directory list.
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6. Editing Drawings
The options for Editing Drawings in TouchDraw 2 are designed to make working with figures, lines, paths,

and handles easier.
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6.1. Editing Basics
The options for Editing Drawings in TouchDraw 2 are designed to make working with figures, lines, paths,

and handles easier.

The following pages explain how to perform drawing editing operations.

• Selecting a Figure

• Deleting a Figure
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6.1.1. Selecting a Figure

TouchDraw 2 contains five types of figures:

• Lines (including open paths)

• Shapes (including closed paths)

• Text

• Images

• Stencils and Groups (compound figures)

For the purposes of selecting a figure, there are really only two types: Lines and Shapes.

Images, text figures, and compound figures all behave like shapes for selection, so we won't discuss them

separately.

To select a line, click on the line, and its handle endpoints will appear.

To select a shape, click anywhere within the shape, and its handles will appear.
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Multiple Selections

By default, a previously selected shape will be deselected when another is selected; however, TouchDraw 2

does support multiple selections.

Hold down the Shift key and Click to select multiple lines or shapes. Continue to hold the Shift key while

clicking on each desired figure to complete a multiple selection in the drawing canvas.
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The Selection Rectangle may also be used to select multiple figures.

Click and drag the Selection Rectangle from left to right or right to left over an area within the Drawing

Canvas and then release the click action once the rectangle covers the desired area to complete the selection.

As shown below, when the rectangle is dragged from left to right, it will select all figures within its bounds and

every figure intersecting it.
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Dragging the Selection Rectangle from right to left from any point within the Drawing Canvas informs

TouchDraw 2 to select only the figures within the rectangle's bounds, as shown below.
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Using the Contextual Menu

The Contextual Menu contains options for selecting all figures within a currently open drawing and inverting

or clearing a current selection within the Drawing Canvas.

Perform a Right Click on the Drawing Canvas to access these options.

Next, click on the Select All option to select all figures within a drawing.
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Use the Invert Selection option to invert the current selection or the Clear Selection option to deselect all

currently selected figures within the Drawing Canvas.

Using the Edit Menu

The Edit Menu contains options for selecting all figures within a currently open drawing and inverting or

clearing a current selection within the Drawing Canvas. Click on the Edit Menu in the Top Toolbar to access

these options.
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Click on the Select All option to select all figures within a drawing.

The Deselect All option to deselect all currently selected figures within the Drawing Canvas.
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Use the Invert Selection option to invert the current selection. Let's say, for example, that two squares reside

in the Drawing Canvas, and the one on the left is selected.

The Invert Selection will automatically deselect it and select the square on the right, as shown below:
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Note: The Command-A keyboard shortcut may also be used to access these options.
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6.1.2. Deleting a Figure

An object must be selected before it can be deleted. A currently selected figure can be deleted in one of two

ways:

1. Select the Edit Menu and click on Delete.

2. Press the Delete key on the keyboard.Note: Please keep in mind that TouchDraw has support for Undo
and Redo. If a figure is deleted by accident, choose the Undo option under the Edit Menu to redisplay the
object.
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6.2. Using the Clipboard
The Clipboard holds the most recent change made to a figure within the Drawing Canvas. Changes are stored

on the clipboard when an item is copied, cut, or undone. They are reapplied by choosing the Paste, Paste Style,

or Redo commands.

All Clipboard actions are accessible through the Edit Menu or Contextual Menu as shown below:

Additional options are available under the Paste Special Submenu for pasting in the same exact location, a

formatting style, and multiple figures.
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Note: The command shortcuts may also be used to gain quick access to Clipboard actions.
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6.2.1. Paste Style

The Paste Style command allows formatting to be copied from one shape and pasted (applied) to another.

The process for this command is shown in the following example:

1. Select the source shape/figure with the formatting to be applied to another object.

2. Copy the shape to the clipboard.
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3. Select the target shape.

4. Select the Paste Style command from the Edit Menu or the Contextual Menu to apply formatting from
the source figure to the target figure.
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6.2.2. Copying a Figure

A figure or group of figures must be selected before copying can occur. Figures can be copied in one of three

ways after a selection has been made.

1. Click on the Edit Menu and choose Copy.

2. Open the Contextual Menu and choose Copy.

3. Use the Control-Ckeyboard shortcut.Note: Once a figure(s) has been copied, use the same menus or the
Control-Vkeyboard shortcut to Paste in a desired location. The Paste Style command may also be used
to copy the formatting of one figure to another.
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6.2.3. Duplicating a Figure

A figure can be duplicated to make sharing the same attributes easy. At least one figure or a group of figures

must be selected for the Duplicate and Duplicate in Place options to be available.

The Duplicate option creates a copy of a selected figure(s) and places it at an offset position in the drawing

canvas.

The Duplicate in Place option creates a copy of a selected figure(s) and places it in the same exact location as

the original. Click and drag on the top figure to move it to a new position in the drawing canvas.
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Figures can be duplicated in one of three ways after a selection has been made:

1. Click on the Edit Menu and choose Duplicate or Duplicate in Place.
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2. Open the Contextual Menu and choose Duplicate or Duplicate in Place.
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3. Use the Control-D or Control-Shift-DKeyboard Shortcuts.
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6.2.4. Cut and Paste

Cutting and pasting works in the same manner as copy and delete.

Cut Command

The Cut command removes the figure from the drawing canvas and adds it to the clipboard. Select a figure or

group of figures and use one of the following three methods to perform a cut:

1. Select the Edit Menu and select Cut.

2. Open the Contextual Menu and choose Cut.
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3. Use the Control-X keyboard shortcut.

Paste Command

The Paste command adds the current clipboard contents to the drawing canvas. To Paste current clipboard

contents:

1. Select the Edit Menu and select Paste.

2. Open the Contextual Menu and choose Paste.

3. Use the Control-Vkeyboard shortcut.

Pasting the clipboard contents multiple times into the Drawing Canvas causes the figure(s) to be placed in

slightly offset positions, as shown below.
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Paste Special Submenu

The Paste Special Submenu can be used to perform additional pasting actions.
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To paste a figure in the same exact location, click on the Edit Menu or Contextual Menu, select Paste Special,

and choose Paste in Place.

To see the pasted figure select the figure and drag in any direction. In the example below, the pasted figure is

dragged to the right.
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To paste multiple instances of a figure in the clipboard, bring up one of the above shown menus, select Paste

Special, and choose Paste Multiple

Multiple pastes of the clipboard content will cause each figure to be placed in slightly offset positions, as

shown below:
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To paste the style of a figure, bring up one of the above shown menus, select Paste Special, and choose Paste

Style. Refer to the Paste Style section of this documentation to learn more.
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6.2.5. Undo and Redo

The Undo command reverts the last change that was made to a drawing. This option is disabled (dimmed)

when no changes have been made and enabled as soon as something is altered on the drawing canvas.

Perform one of the following actions to revert the last made change:

1. Select the Edit Menu and choose Undo.

2. Use the Control-Zkeyboard shortcut.

The Redo command cancels the last undone change made to the drawing canvas. This option is disabled

(dimmed) when nothing has been undone and is enabled as soon as the Undo command has been used, or

something is altered.

Perform one of the following actions to reapply the last undone change:

1. Select the Edit Menu and choose Redo.
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2. Use the Control-Shift-Zkeyboard shortcut.Note: The Undo and Redotoolbar buttons may also be used
to perform these actions within TouchDraw 2.
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6.3. Handling Figures
TouchDraw 2 supplies a variety of options for handling figures within a drawing. An individual shape or group

of figures can be:

• Moved

• Stretched

• Resized

• Rotated

• Flipped

• Scaled

• Shifted

The following pages describe these actions in further detail and provide steps for using each method of figure

handling.
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6.3.1. Moving a Figure

A figure must be selected to be moved to another location on the drawing canvas. Perform a Drag action to

move an already selected figure or use a Click/Drag combination within the figure's bounds to accomplish the

move in one step.

To change the position of a group of selected figures, perform a Click/Drag combination within bounds of any

selected object to move the entire selection. A move is completed when the Click action is released.

See the Easy Drag Mode section to learn more about an easier way to move smaller objects around the drawing

view without worrying about inadvertently dragging one of their handles.
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6.3.2. Stretching a Figure

Most shapes have handles in the top, center, bottom center, left middle, and right middle that allow the figure to

be stretched and made wider or taller. The screenshot below demonstrates these handles for a rounded rectangle.

To Stretch a Figure, click on one of the above shown handles and drag it to a desired location. The figure will

stretch itself dynamically as the handle is dragged.

When the Selection as Group (Default) option is enabled, and multiple figures are selected, all figures can be

stretched at the same time by touching and dragging on the same handles for the selection group, as shown

below:

Tip: Pressing the Shift Key as a figure is stretched allows its current aspect ratio to be maintained.

Note: Multiple figures can be stretched at once by placing them into a group.
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6.3.3. Resizing a Figure

In addition to the handles for stretching a figure, shapes also have handles in the upper left, upper right, lower

left and lower right for resizing the figure. The screenshot below shows these handles for a rounded rectangle:

To Resize a Figure, perform a Click/Drag combination on one of the above shown handles. The width and

height of a figure will change dynamically as the handle is dragged.

When the Selection as Group (Default option is enabled, and multiple figures are selected, all figures can be

resized at the same time by touching and dragging on the same handles for the selection group, as shown below:

Tip: Pressing the Shift Key while resizing a figure allows its current aspect ratio to be maintained.

Note: Multiple figures can be resized at once by placing them into a group.
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6.3.4. Rotating a Figure

Every figure, with the exception of lines, can be rotated. A red handle will be shown to the right of a figure

when it is selected for rotation. This red handle can be dragged to change the rotation angle of a selected shape.

A semi-transparent gray line going from the rotation handle to the figure's center of rotation point (typically

represented by a gray circle in the middle) will also be displayed.

Perform a Click/Drag combination on the red handle to rotate the object in increments of 1° around its center

of rotation point. In the example below, the red handle is dragged down and to the left.
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Note: Pressing the Shift Key as a figure is rotated causes this action to occur in 15° increments.

A figure may be rotated at 90° increments to the right or left by using the Rotate 90° Right or Rotate 90° Left

options in the Rotate Submenu. To access this submenu, click on the Modify Menu and then click on the

Rotate Submenu.

The example below shows what a figure looks like prior to and after being rotating 90 degrees to the left.
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The Rotate 180° command may also be used to rotate a figure and is accessible through the same menu as

discussed above. Below is an example of what a figure looks like prior to and after being rotated 180 degrees.

Note: The Center of Rotation can be changed to a different point within a shape or reset after it has been

altered. See Changing the Center of Rotation or Resetting the Center of Rotation for additional information.
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6.3.4.1. Changing the Center of Rotation

A selected shape will show a gray semi-transparent circle connected to the rotation handle. This gray circle

indicates a selected shape's Center of Rotation and can be changed to any desired point within the shape's

bounds.

By default, the option to change a shape's Center of Rotation is not enabled.

Click on the View Menu and then the Handles Submenu to enable the "Center of Rotation" handle.

A new handle will replace the original semi-transparent circle once this option has been enabled.
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To alter the Center of Rotation, drag the newly visible handle to a desired location.

The shape will rotate around the new point rather than its natural center once it has been set.
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6.3.4.2. Resetting the Center of Rotation

A selected shape will show a gray semi-transparent circle connected to the rotation handle. This gray circle

indicates a selected shape's Center of Rotation and can be changed to any desired point within the shape's

bounds.

This point can be set back to its natural center after its location has been altered. Follow the steps below to

Reset the Center of Rotation:

1. Select the desired Shape.

2. Select the Modify Menu.

3. Choose the Rotate Submenu and click on Reset Center of Rotation.

4. The point will be adjusted back to its natural center.
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6.3.5. Flipping a Figure

A figure can be flipped either horizontally or vertically in the drawing canvas. These options can be found in

the Flip Submenu under the Modify Menu. See the image below:

Note: A figure must be selected to choose one of the above options.

Choose Flip Horizontally from this menu to interchange a figure horizontally. The images below show a

before and after of this figure transition:
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Choose Flip Vertically from the above menu to interchange a figure vertically. The images below show a

before and after of this figure transition.
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6.3.6. Scaling a Figure

The Scale By... option can be used to alter figure size based on input coordinates to create a smaller or larger

figure spanning over a specific area. It is accessible through the Transform Submenu of the Modify Menu.

To Scale a Figure or group of figures:

1. Select a figure(s) to be altered.

2. Select the Modify Menu, choose Transform, and click on Scale By...

3. Enter the desired X and Y coordinates into the Scale By popup window by using the incremental buttons
to the right of each field or by performing a Click/Keyboard entry action.
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4. Select or deselect desired options in the Scale By popup window.

5. Click on the Scale Button when finished.

6. The selected figure will be scaled according to the entered coordinates and selected options. It will
appear in scaled form with the Scale By popup window remaining available to make further changes.
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6.3.6.1. Scale Size

The Scale Size option informs TouchDraw 2 to scale the selected figure(s) size based on the entered Factor X

and Factor Y values. If enabled, the check box will have a checkmark with a blue background, as shown below:

This option must be enabled for the selected figure(s) to be scaled by the entered values.

If Factor Y is changed to 4 for the above figure, it will appear as shown below:
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If the Scale Size option is disabled (no checkmark), the size will not be scaled. However, if the Scale Attributes

option remains enabled, then the attributes (stroke, text, etc.) will be scaled according to the entered values, as

shown below:
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Note: Please note that if both options have been disabled, then the selected figure(s) will not be scaled.
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6.3.6.2. Scale Attributes

The Scale Attributes option informs TouchDraw 2 to scale the attributes (stroke, text, etc.) of the selected

figure(s) based on the entered Factor X and Factor Y values.

If enabled, the check box will appear with a checkmark and blue background, as shown below:

If the Scale Size option has been enabled as well, then the selected figure's size and attributes will be scaled

according to entered values. If 4 is entered for Factor Y, then the height of the selected figure(s) will be scaled

by that value.

The above figure would appear as shown below:
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When the Scale Attributes option is disabled (no checkmark), only the size of the selected figure(s) will be

scaled by the entered Factor values.

In the example below, the size of the figure is scaled; however, the stroke and text attributes are not.
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If Scale Attributes is the only enabled option, then only the selected figure(s) attributes will be scaled

according to the entered Factor values.
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Note: Please note that if both options have been disabled, then the selected figure(s) will not be scaled.
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6.3.7. Shifting a Figure

The Move By... option can be used to shift a selected figure or group of figures by an entered set of

coordinates. This option changes the location of a figure based on input coordinates and is accessible through

the Transform Submenu of the Modify Menu.

To Shift a Figure or group of figures:

1. Select a Figure or grouping of figures to be shifted.

2. Select the Modify Menu, choose Transform, and click on the Move By... option.

3. Enter the desired X and Y grid coordinates in the Move By popup window.
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4. Click on the Move Button to finish the shift.

5. The selected figure or group of figures will shift in accordance to the entered coordinates.



Page 385

TouchDraw 2 for Windows

6.4. Arranging Figures
TouchDraw 2 allows figures within the drawing canvas to be grouped or locked. Grouped figures are treated as

a single object where all attribute, movement, and sizing changes are applied to the group as a whole.

Locked figures cannot be moved or resized but still allow for attribute changes such as the fill color or stroke

properties. Figures can be ungrouped or unlocked any time object modification requirements change and then

regrouped or locked again as needed.
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6.4.1. Grouping Figures

Shapes residing on the Drawing Canvas can be manipulated and treated as a single figure with the Group

feature. More than one figure will need to be selected for this option to be enabled.

Use a Shift Key/Click combination to select multiple figures. The methods for Grouping Figures are

described below:

1. Select the Arrange Menu and choose Group.

2. Open the Contextual Menu, select the Arrange Submenu, and choose Group.

3. Use the Group Button located on the Main Toolbar.
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4. Use the Control-Gkeyboard shortcut.

Note: Paths are an exception to the multiple selection rule because a path or path shape can be added to a group

by itself. This allows for path interaction without having to worry about the occurrence of reshaping when

grabbing one of the available handles.

The screenshots below show a before and after for creating a group from multiple selected figures.

New bounds handles will appear after the selected figures are grouped. These handles correspond to the group

as a whole rather than each individual figure. A new rotation handle is provided for making an entire group

rotation. The standard "blue" handles are replaced by "blue handles with dots" to provide a visual indicator as

to whether the entire group or a separate figure has been selected.
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6.4.2. Ungrouping Figures

A Group must be selected for the ungrouping option to be enabled. Use one of the following methods to

ungroup a set of grouped figures:

1. Select the Arrange Menu and choose Ungroup.

2. Open the Contextual Menu, select the Arrange Submenu, and choose Ungroup.

3. Use the Ungroup Button located on the Main Toolbar.
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4. Use the Control-Shift-Gkeyboard shortcut.Note: Any transformations made to the group (such as
rotating, resizing, etc...) will be retained by previously grouped objects after the ungrouping action has
been completed. Grouping provides an excellent way to quickly make bulk changes to multiple figures or
all objects within a drawing.
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6.4.3. Locking Figures

A Locked Figure is one that cannot be moved or resized until it has been unlocked. Attributes such as stroke,

fill, shadow, etc... can still be manipulated on a locked figure. A minimum of one figure must be selected for

this option to be enabled. Use one of the following methods to Lock a Figure(s):

1. Select the Arrange Menu and choose Lock.

2. Open the Contextual Menu, select the Arrange Submenu, and choose Lock.

3. Use the Lock Button located on the Main Toolbar.

4. Use the Control-Lkeyboard shortcut.
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Note: Use a Shift/Click combination to select multiple figures for locking. All objects within a drawing can be

selected at once by choosing Select All in the Edit Menu or by using the Command-Akeyboard shortcut.

A group of figures will appear as shown below when they are unlocked.

The group will appear as shown below once they have been locked. The handles appear gray after a figure(s) or

group of figures are locked. This handle attribute change serves as a visual indicator of the selected figure(s)

being locked.

Note: The handles appear gray after a figure(s) or group of figures are locked. This handle attribute change

serves as a visual indicator of the selected figure(s) being locked.
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6.4.4. Unlocking Figures

A figure(s) or group of figures can be unlocked to allow for moving and resizing. Use one of the following

methods to Unlock Figures:

1. Select the Arrange Menu and choose Unlock.

2. Open the Contextual Menu, select the Arrange Submenu, and choose Unlock.

3. Use the Unlock Button on the Main Toolbar.

4. Use the Control-Shift-Lkeyboard shortcut.Note: This Arrange Menu item will only be enabled when a
locked figure(s) or group of figures has been selected within the drawing panel.
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6.5. Aligning Figures
TouchDraw 2 provides methods for aligning a set of figures to an attribute of the first selected figure in the set.

Relative Alignment

The first type of alignment that can be done is relative alignment, where figures are aligned in relation to one

another. The list below outlines the relative alignment options available.

• Top

• Vertical Center

• Bottom

• Left

• Horizontal Center

• Right

Grid Alignment

In addition to relative alignment, a figure (or set of figures) can also be aligned to the grid of the drawing

canvas in the case that they were drawn or modified while the snap to grid option was disabled.
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6.5.1. Align to Grid

The Align to Grid option is available to align figures with the grid. Select each desired figure and use one of

the following methods to align a figure(s) to the grid:

1. Click on the Arrange Menu, select the Align Submenu, and choose Align to Grid.

2. Open the Contextual Menu, select the Align Submenu, and choose Align to Grid.

3. Use the Align to Grid Button located on the main toolbar.
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The option will first align the upper left-hand corner of the selected figures to the grid and then resize it to

make all four corners align with the grid.

The following screenshots show a before and after of a shape that has been aligned to the grid.

Note: The Snap To Grid option must be disabled to place a figure anywhere within the grid lines on the

Drawing Canvas. This option must be enabled for the Align to Grid option to provide the results shown above.



Page 396

TouchDraw 2 for Windows

6.5.2. Align Top

The Align Top option moves all currently selected figures to match the top (Y position) of the first selected

figure. At least two figures must be selected for this application feature to be enabled.

Use one of the following methods to align selected figures with to the top position of the first selected figure:

1. Click on the Arrange Menu, select the Align Submenu, and choose Align Top.

2. Open the Contextual Menu, select the Align Submenu, and choose Align Top.
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3. Use the Align Top Button located on the main toolbar.

The following images display the selection order of items to be aligned.

The following image displays the selected objects after the alignment has been performed.
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Note: Perform a Shift/Click to select multiple figures.
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6.5.3. Align Vertical Center

The Align Vertical Center option moves all currently selected figures to match the vertical center (Y position

+ 1/2 of the height of all figures) of the first selected figure. At least two figures must be selected for this

application option to be enabled.

Use one of the following methods to align the vertical center of a figure(s):

1. Click on the Arrange Menu, select the Align Submenu, and choose Align Vertical Center.

2. Open the Contextual Menu, select the Align Submenu, and choose Align Vertical Center.
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3. Use the Align Vertical Center Button located on the main toolbar.

The following images display the selection order of items to be aligned.

The following image displays the selected objects after the alignment has been performed.



Page 401

TouchDraw 2 for Windows

Note: Perform a Shift/Click to select multiple figures.



Page 402

TouchDraw 2 for Windows

6.5.4. Align Bottom

The Align Bottom option moves all currently selected figures to match the bottom (Y position + Height) of the

first selected figure. At least two figures must be selected for this application feature to be enabled.

Use one of the following methods to align figures with the bottom position of the first selected figure:

1. Click on the Arrange Menu, select the Align Submenu, and choose Align Bottom.

2. Open the Contextual Menu, select the Align Submenu, and choose Align Bottom.
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3. Use the Align Bottom Button located on the main toolbar.

The following images display the selection order of items to be aligned.

The following image displays the selected objects after the alignment has been performed.



Page 404

TouchDraw 2 for Windows

Note: Perform a Shift/Click to select multiple figures.
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6.5.5. Align Left

The Align Left option moves all currently selected figures to match the left (X position) of the first selected

figure. At least two figures must be selected for this application feature to be enabled.

Use one of the following methods to align figures with the left position of the first selected figure:

1. Click on the Arrange Menu, select the Align Submenu, and choose Align Left.

2. Open the Contextual Menu, select the Align Submenu, and choose Align Left.
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3. Use the Align Left Button located on the main toolbar.

The following images display the selection order of items to be aligned.

The following image displays the selected objects after the alignment has been performed.
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Note: Perform a Shift/Click to select multiple figures.

The following figures show an example of using the Align Left action.
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6.5.6. Align Horizontal Center

The Align Horizontal Center option moves all currently selected figures to match the horizontal center (X

position + 1/2 of the width) of the first selected figure. At least two figures must be selected for this application

feature to be enabled.

Use one of the following methods to align figures with the horizontal center of the first selected figure:

1. Click on the Arrange Menu, select the Align Submenu, and choose Align Horizontal Center.

2. Open the Contextual Menu, select the Align Submenu, and choose Align Horizontal Center.



Page 410

TouchDraw 2 for Windows

3. Use the Align Horizontal Center Button located on the main toolbar.

The following images display the selection order of items to be aligned.
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The following image displays the selected objects after the alignment has been performed.

Note: Perform a Shift/Click to select multiple figures.
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6.5.7. Align Right

The Align Right option moves all currently selected figures to match the right (X position + Width) of the first

selected figure. At least two figures must be selected for this application feature to be enabled.

Use one of the following methods to align figures with the right position of the first selected figure:

1. Click on the Arrange Menu, select the Align Submenu, and choose Align Right.

2. Open the Contextual Menu, select the Align Submenu, and choose Align Right.
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3. Use the Align Right Button located on the main toolbar.

The following images display the selection order of items to be aligned.

The following image displays the selected objects after the alignment has been performed.
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Note: Perform a Shift/Click to select multiple figures.
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6.6. Snapping Figures
TouchDraw 2 supplies options for snapping figures to specific points on the grid, positions on the Drawing

Canvas, or positions relative to other shapes. Figures can be snapped to these locations:

• Grid

• Lines

• Pixels

• Points

• Shapes

The Snapping Submenu provides access to these settings and can be used to make changes for the currently

active Drawing Canvas. This menu is located in the View Menu, as shown below.
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6.6.1. Snap to Grid

The Snap to Grid option toggles whether or not figures (and their handles) should be aligned to the grid as

they are created and modified. Use one of the following methods to enable/disable this option:

1. Click on the View Menu, select the Snapping Submenu, and choose Snap to Grid.

2. Use the Control-Shift-Apostrophekeyboard shortcut.

The Snap to Grid option will show a checkmark symbol next to the menu selection area when enabled.
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6.6.2. Snap to Lines

The Snap to Lines option allows dragged handles to be snapped to the endpoints or the midpoints of lines in

the Drawing Canvas. Click on the View Menu, select the Snapping Submenu, and choose Snap to Lines to

enable/disable this option.

The Snap to Lines option will show a checkmark symbol in the menu selection area when enabled.
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6.6.3. Snap to Pixels/Points

The Snap to Pixels/Points option aligns objects to whole pixel numbers for simplified modification and

increased accuracy. This option remains disabled until the unit of measure for the drawing is changed to pixels

or points.

To change the Units attribute, click on the Units and Rulers Button located in the Info portion of the Sidebar.

To enable/disable this option, click on the View Menu, select the Snapping Submenu, and choose Snap to

Pixels/Points.
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The Snap to Pixels/Points option will show a checkmark symbol in the menu selection area when enabled.
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6.6.4. Snap to Shapes

The Snap to Shapes option snaps a figure to a selected shape vertex or center point. This option is enabled by

default in TouchDraw 2. To enable/disable this option, click on the View Menu, select the Snapping Submenu,

and choose Snap to Shapes.

The Snap to Shapes option will show a checkmark when enabled and no checkmark when disabled.

To see this option in action, disable the Snap to Grid option, make certain Snap to Shapes is enabled, and then

draw a star or rectangle. Once the shape is completed, select the Line Tool and try to draw a line from one of

the vertexes of the shape or its center point. The drawn line will snap to one of these locations.
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In the example below, the line snaps to the center point of the rectangle.
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6.7. Ordering Figures
TouchDraw 2 supplies application functions for altering the order of a figure or multiple figures within a

specific layer on the Drawing Canvas.

Figures can be moved to the front of a layer or moved forward by one level from their previous position. They

may also be moved to the back of a layer or moved backward by one level within a layer.
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6.7.1. Bring to Front

The Bring to Front option moves a currently selected figure(s) to the front of all figures residing in the same

layer. At least one figure within a layer must be selected for this option to be enabled. Use one of the following

methods to bring a figure(s) to the front of a layer:

1. Select the Arrange Menu and choose Bring to Front.

2. Open the Contextual Menu, select the Arrange Submenu, and choose Bring to Front.

3. Use the Bring to Front button located on the main toolbar.

4. Use the Control-Shift-Closing Bracketkeyboard shortcut.
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The following images display the position of a selected rectangle before and after using the Bring to Front

option.
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6.7.2. Bring Forward

The Bring Forward option moves a currently selected figure(s) one step closer to the top of the stack within

the layer they reside in. At least one figure within the desired layer must be selected for this option to be

enabled. Use one of the following methods to bring a figure(s) forward within a layer:

1. Select the Arrange Menu and choose Bring Forward.

2. Open the Contextual Menu, select the Arrange Submenu, and choose Bring Forward.

3. Use the Bring Forward button located on the main toolbar.

4. Use the Control-Closing Bracketkeyboard shortcut.
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The following images display the position of a selected rectangle before and after using the Bring Forward

option.

Note: The Bring Forward option can be chosen multiple times to continue moving a selected figure(s) to the

front of a layer.
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6.7.3. Send Backward

The Send Backward option moves a currently selected figure(s) one step closer to the bottom of a stack within

their residing layer. At least one figure within a layer must be selected for this option to be enabled. Use one of

the following methods to send a figure(s) back one step within a layer:

1. Select the Arrange Menu and choose Send Backward.

2. Open the Contextual Menu, select the Arrange Submenu, and choose Send Backward.

3. Use the Backward button located on the main toolbar.

4. Use the Control-Opening Bracketkeyboard shortcut.
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The following images display the position of a selected pentagon before and after using the Send Backward

option.

Note: The Send Backward option can be chosen multiple times to continue moving a selected figure(s) to the

back of a layer.
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6.7.4. Send to Back

The Send to Back option moves a currently selected figure(s) behind all other figures residing within the same

layer. At least one figure within a layer must be selected for this option to be enabled. Use one of the following

methods to send a figure(s) to the back of a layer:

1. Select the Arrange Menu and choose Send to Back.

2. Open the Contextual Menu, select the Arrange Submenu, and choose Send to Back.

3. Use the Sent to Back button located on the main toolbar.

4. Use the Control-Shift-Opening Bracketkeyboard shortcut.



Page 430

TouchDraw 2 for Windows

The following images display the position of a selected pentagon before and after using the Send to Back

option.
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6.8. Distributing Figures
TouchDraw 2 offers options for apportioning figures evenly in relation to each other. A set of figures can be

laid out to have equal spacing between each figure measured horizontally or vertically.

A group of selected figures may also be packed into the smallest rectangular space possible with the Pack

Horizontally, Pack Vertically, or Pack options.
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6.8.1. Distribute Horizontally

The Distribute Horizontally option adjusts the positioning of selected figures to create an even amount of

horizontal space between each figure. This option is enabled when three or more unlocked figures are selected

in the drawing canvas.

Use one of the following methods to distribute a set of figures horizontally:

Method 1: Click on the Arrange Menu, select the Distribute Submenu, and choose Distribute Horizontally.

Method 2: Open the Contextual Menu, select the Distribute Submenu, and choose Distribute Horizontally.
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The following images display the positions of a selected set of figures before and after using the Distribute

Horizontally option.

In the above example, the first and middle figures were originally 2.5 inches apart. The spacing between the

middle and last figure totaled 1.5 inches. After this option has been applied, the horizontal space between each

figure is adjusted to 2 inches to provide three evenly spaced figures.
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6.8.2. Distribute Vertically

The Distribute Vertically option adjusts the positioning of selected figures to create an even amount of

vertical space between each figure. This option is enabled when three or more unlocked figures are selected in

the drawing canvas.

Use one of the following methods to distribute a set of figures vertically:

Method 1: Click on the Arrange Menu, select the Distribute Submenu, and choose Distribute Vertically.

Method 2: Open the Contextual Menu, select the Distribute Submenu, and choose Distribute Vertically.
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The following images display the positions of a set of figures before and after using the Distribute Vertically

option.
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In the above example, the spacing between the top and middle squares totals 2 inches. The middle and bottom

figures have a vertical spacing of 1.5 inches. After this option has been applied, the vertical space between each

figure is adjusted to 1.75 inches to provide three evenly spaced figures.
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6.8.3. Pack Horizontally

The Pack Horizontally menu item takes a set of selected shapes and "packs" them into the smallest space

possible horizontally.

This option is enabled when three or more unlocked figures are selected in the drawing canvas.

Complete the following steps to pack a set of figures horizontally:

1. Select the figures or shapes to be packed horizontally.

2. Then click on the Arrange Menu, select the Distribute Submenu, and choose Pack Horizontally.
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3. The following image displays the positions of a selected set of figures after using the Pack Horizontally
option.
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6.8.4. Pack Vertically

The Pack Vertically menu item takes a set of selected shapes and "packs" them into the smallest space

possible vertically.

This option is enabled when three or more unlocked figures are selected in the drawing canvas. Complete the

following steps to pack a set of figures vertically:

1. Select the figures or shapes to be packed vertically.

2. Click on the Arrange Menu, select the Distribute Submenu, and choose Pack Vertically.
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3. The following image displays the positions of a selected set of figures after using the Pack Vertically
option.
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6.8.5. Pack

The Pack option can be used to "pack" a group of selected figures into the smallest possible rectangular space

within the drawing canvas. This option is enabled when two or more unlocked figures are selected in the

drawing canvas.

To pack a set of figures, complete the following steps:

Step 1: Select the figures to be packed in the Drawing Canvas.

Step 2: Click on the Arrange Menu, select the Distribute Submenu, and choose Pack.
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The following images display the positions of a selected set of figures prior to and after using the Pack option.

Four shapes have been added to the Drawing Canvas and placed in random positions in the example shown

below. This is how they appear before the action is performed:

After the pack, they appear as shown below:
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6.9. Combining Shapes
TouchDraw 2 offers multiple options for combining two shapes within the drawing canvas. Options for

selected shapes include:

• Add Shapes

• Subtract Shapes

• Intersect Shapes

• Exclude Shapes
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6.9.1. Add Shapes

The Add Shapes option combines two selected shapes into one figure. It remains disabled until two figures

have been selected. Use one of the following methods to Add selected shapes:

1. Select the Modify Menu and choose Add Shapes.

2. Use the Add Shapes button located on the main toolbar.

Note: The selection of two non-intersecting shapes has no effect on their appearance but does cause the figures

to be treated as one shape.

The properties of the first selected shape will be applied to the combined shape. In the example below, the

circle is selected first.
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The following images display two selected shapes before and after using the Add Shapes option.
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6.9.2. Subtract Shapes

The Subtract Shapes option removes the intersecting portions of the second selected shape from the first

figure selected in the drawing canvas. This option remains disabled until two figures have been selected. Use

one of the following methods to Subtract selected shapes:

1. Select the Modify Menu and choose Subtract Shapes.

2. Use the Subtract Shapes button located on the main toolbar.

Note: The selection of two non-intersecting shapes causes the second shape to be removed entirely.

The properties of the first selected shape will be applied to the combined shape. In the example below, the

circle is selected first.
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The following image shows the resulting shape after using the Subtract Shapes option.
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6.9.3. Intersect Shapes

The Intersect Shapes option removes all non-intersecting portions of selected figures from the drawing

canvas. This option remains disabled until two figures have been selected. Use one of the following methods to

Intersect selected shapes:

1. Select the Modify Menu and choose Intersect Shapes.

2. Use the Intersect Shapes button located on the main toolbar.

Note: The selection of two non-intersecting shapes results in the complete removal of both objects.

The properties of the first selected shape will be applied to the combined shape. In the example below, the oval

is selected first.



Page 452

TouchDraw 2 for Windows

The following images display two intersecting shapes before and after using the Intersect Shapes option.
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6.9.4. Exclude Shapes

The Exclude Shapes option removes the intersecting portions of selected figures from the drawing canvas.

This option remains disabled until two figures have been selected. Use one of the following methods to Exclude

 selected shapes:

1. Select the Modify Menu and choose Exclude Shapes.

2. Use the Exclude Shapes button located on the main toolbar.

Note: The selection of two non-intersecting shapes has no effect on appearance but does cause the figures to be

treated as one shape.

The properties of the first selected shape will be applied to the combined shape. In the example below, the oval

is selected first.
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The following images display two intersecting shapes before and after using the Exclude Shapes option.
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6.10. Handling Colors
TouchDraw 2 provides multiple ways to select and change the color attributes of figures or text within the

Drawing Canvas. Color attributes can be changed for these items:

• Shapes

• Strokes

• Text

• Canvas Background

Additional attributes are available for changing the shadow and fill style of a selected figure(s). All color

attributes are accessible through the Drawing Toolbar and are managed through the standard Color Picker.
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6.10.1. Color Picker

The Color Picker is used to set the fill, stroke, text, and shadow color for currently selected figures or new

additions to an active drawing. As shown in the image below, the Color Picker is made up of different

components which allow for varying interactions with the Color Picker.

Click or tap on the corresponding Color Picker item name in the table below to learn more about what the

control does.

Control Name Description

Add to Favorites The Add to Favorites button can be used to add the current color selection to a

favorites list for easier access during future changes.

HEX Editor The HEX Editor control shows the hex value of a selected color and can be used to
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Control Name Description

change the color by editing this value.

Color Selection

Method

The Color Selection Method controls offer seven methods for selecting a color:

Color Square, Color Wheel, RGB, HSV, Gray Scale, Favorite Colors, Named Colors,

Colors In Use.
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6.10.1.1. Color Square

The Color Square provides a quick way to select a color from the standard operating system colors. It is the

default view when the Color Picker is opened to set the fill color, stroke color, etc.

To make a selection, click on any color in the square, and it will be set automatically. The selected color will be

shown in the square located in the top left corner of the color square, and the Hex value will also appear in the

top right corner.

Note: The Hex Editor may be used to change the color by performing a click and entering a different value.
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6.10.1.2. Color Wheel

The Color Wheel is the most common way to select a color within TouchDraw 2. This color selection method

consists of a Color Wheel for selecting an exact color hue and a Saturation Box for altering the lightness or

darkness of a hue.

To access this color selection method, click on the Color Selection Menu and then choose Color Wheel.

Click on the desired hue in the Color Wheel and then click on the desired lightness or darkness value in the

Saturation Box.
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Note: The Opacity Slider (Alpha) may be used to the opaqueness of a selected color. Click on the Hex Editor

to type in a specific value and alter the color.
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6.10.1.3. RGB

The RGB Editor control can be used to alter the amount of red, green, and blue of the color being selected. To

access these options, click on the Color Selection Menu and then select RGB.

To change the values, click on a slider and then drag the slider to the right or left to set the desired color value.

You may also click on the number to type in a different value.
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Note: Click on the Hex Editor to alter the color by changing the value or use the Favorites Button to save it

to the list of favorite colors.
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6.10.1.4. HSV

The HSV Editor control can be used to alter the hue, saturation, and value of a color being selected. To access

this color selection option, click on the Color Selection Menu and then select HSV.

To change the values, click on a slider and then drag the slider to the right or left to set the desired color value.

You may also click on the number to type in a different value.
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Note: Click on the Hex Editor to alter the color by changing the value or use the Favorites Button to save it

to the list of favorite colors.
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6.10.1.5. Gray Scale

The Gray Scale color selection option can be used to alter the brightness and opaqueness (opposite of

transparency) of a color. To access this option, click on the Color Selection Menu and then select Gray Scale.

To change the values, click on a slider and then drag the slider to the right or left to set the desired color value.

You may also click on the number to type in a different value.
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Note: Click on the Hex Editor to alter the color by changing the value or use the Favorites Button to save it

to the list of favorite colors.
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6.10.1.6. Named Colors

The Named Colors option is an alternative method for selecting a color within TouchDraw 2. The list consists

of pre-configured color options which are chosen by pressing on the desired color name in the list. To access

this option, click on the Color Selection Menu and then click on Named Colors

Click on a color to select it. In the example below, Black was originally chosen and is being changed to Dark

Sea Green. The currently selected color will be highlighted in blue.
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6.10.1.7. Favorite Colors

In TouchDraw 2, a color can be saved as a favorite to make it easier to find and use the color in a drawing(s).

This can be done by clicking on the Favorites Button (Star) after configuring the exact hue you want to save.

A few pre-defined colors are also present in the favorites list and can be used for drawings.

To access saved colors, click on the Color Selection Menu and click on Favorite Colors.
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Then click on a color in the list to make a selection.
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6.10.1.8. Colors in Use

The Colors in Use option will display every color currently applied in your drawing, and the displayed hues

come from the fill, stroke, shadow, and text colors that have been used within the drawing.

To access this option, click on the Color Selection Menu and then choose Colors in Use.

You can click on a color to apply it to the selected attribute (stroke, fill, etc.) for all figures or only selected

figures within the drawing. This is an easy way to switch between common colors in your drawing and to

maintain the same hues without having to perform additional steps to use the same colors.
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6.10.2. Stroke Color

The Stroke Color of a selected figure can be changed to meet a desired preference. It can be altered for a

selected figure(s) or in instances where no figures have been selected.

If a figure has not been selected, the color change applies to any figure added after the change. This attribute

can be altered in the following ways:

Method 1: Click on the Stroke Tab and click on the Stroke Color attribute.
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Method 2 Click on the Stroke Color Button in the Format Bar.

To alter the Stroke Color:

1. Click on the On/Off toggle slider in the upper right-hand corner of the Stroke Window to turn on this
option. The slider will appear with a green background when this option is enabled.

2. Click on the Stroke Color attribute on the Stroke Tab.

3. To select a pre-defined color in the Color Square, click on the desired color.
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4. You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,
RGB, HSV, Gray Scale, Named ColorsFavorite Colors, or Colors in Use. To do so, click on the menu
and then click on an option.
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5. If using the Color Wheel, first click on the desired color range within the outside of the wheel view.
Then choose the desired lightness or darkness of the selected color in the center (saturation) square.
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6. Alter the Stroke Style options (arrowhead, dashed, solid, etc.) by clicking on an option and then clicking
on the desired selection in the Stroke Window. Click on additional options (opacity, line join, etc.)to
make further attribute changes.

7. Click anywhere within the Drawing Canvas to close the window.



Page 480

TouchDraw 2 for Windows

6.10.3. Fill Color

The Fill Color of a selected figure can be changed to meet a desired preference. It can be altered for a selected

figure(s) or in instances where no figures have been selected.

If a figure has not been selected, the color change applies to any figure added after the change. This attribute

can be altered in one of the following ways:

1. Click on the Fill Tab to open the popover window shown below.

2. Click on the Fill Color Button in the Format Bar.

To alter the Fill Color:

1. Click on the Fill Checkbox in the upper right-hand corner of the Fill Window to turn on the Fill option.
The checkbox will have a checkmark when this option is enabled.

2. Then choose a Fill option (Solid, Gradient, Pattern, or Image). The current selection will be highlighted
in gray.
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3. Click on the Color Attribute located below the style options.

4. To select a pre-defined color in the Color Square, click on the desired color.

5. You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,
RGB, HSV, Gray Scale, Named Colors, Favorite Colors, or Colors in Use. To do so, click on the menu
and then click on an option.
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6. If using the Color Wheel, first click on the desired color range within the outside of the wheel view.
Then choose the desired lightness or darkness of the selected color in the center (saturation) square.
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7. Perform a Click/Drag gesture combination or Click on additional options such as the opacity slider
within the Fill Window to make further attribute changes.

8. Click anywhere within the Drawing Canvas to close the window. The following screenshots show a
figure with a light blue fill.
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6.10.3.1. Fill Visibility

The Fill Visibility toggle may be used to show or hide the fill for one or more figures within a drawing. If a

figure(s) is selected, then the fill color will be enabled/disabled for that figure only. Otherwise, if no figures

have been selected in the Drawing Canvas, the fill visibility will be enabled/disabled for every figure within the

drawing.

To access this option and enable/disable it:

1. Click on the Fill Tab within the Sidebar.

2. To enable/disable the Fill Visibility toggle, click on the checkbox in the top left corner of the Fill Tab. It
will have a checkmark when enabled and no checkmark when disabled.

3. When Fill Visibility is disabled, you will see the Drawing Canvas within each figure or only the ones
that were selected, as shown below:
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6.10.3.2. Solid

The Solid fill style option is located on the Fill tab in the Info portion of the Sidebar. This attribute sets the fill

of a selected or any created figure(s) to a solid color.

The Fill option must be enabled for a change in this tab to be applied to currently selected or new figures. Click

on the box next to the option name to enable/disable it, as shown below:

Follow the steps below to set this attribute to Solid:

1. Select the Fill Tab located in the Sidebar.

2. Choose the Solid fill style by clicking on its name.
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3. Then click on the Color Square to configure the color attribute.

Note: A style change will be seen instantaneously when a figure is selected. If figures have not been selected,

the style change will apply to all subsequently created figures.

The following example shows a rectangle with the Fill Style set to solid and Color set to blue:
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6.10.3.3. Linear Gradient

The Linear Gradient fill style option is located on the Fill tab in the Info portion of the Sidebar. This attribute

transitions the fill from a specific start color to the specified end color at a designated angle within a selected or

created figure(s).

The Fill option must be enabled for a change in this tab to be applied to currently selected or new figures. Click

on the box next to the option name to enable/disable it, as shown below:

Follow the steps below to set this attribute to Linear Gradient:

1. Select the Fill Tab located in the Sidebar.

2. Click on Gradient.
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3. Then make certain Linear Gradient has been chosen in the Gradient drop-down menu.

4. The following example shows a rectangle with the Fill Style set to linear gradient and Colors set to white
and blue:

Note: A style change will be seen instantaneously when a figure is selected. If figures have not been selected,

the style change will apply to all subsequently created figures.

Working with Linear Gradients
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Click on a Gradient Handle to select a color from the color picker or click anywhere within the color slider to

add additional handles. The Gradient Handles can be moved to any desired position by clicking and dragging

to the right or left on the color slider.

More than one color can be added by setting each gradient handle to one of the desired colors. In the example

below, three gradient handles are used with these colors: white, blue, and green.
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Angle

Type in a value or use the incremental buttons to change the Angle of the linear gradient. This option remains

unavailable unless a figure has been selected within the Drawing Canvas. In the example below, a value of 75

has been entered for the angle.
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Reset Button

Click on the Reset Button to reset the angle back to zero, and the gradient handles on the figure back to their

original position.
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The Reset Button can also be used to reset the gradient handles on a figure(s) after they have been moved to

another location. For this to be seen, you must have the Gradient Locations option enabled.
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This can be done by clicking on the View Menu and then the Handles Submenu. Then click on Gradient

Locations. When this option is enabled, it will have a checkmark next to its name in the menu.

Once this option is enabled, you will be able to click and drag to move each gradient handle to another location

within a figure (see below).
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After one or both gradient handles have been moved, click on the Reset Button to set the linear gradient

handles back to their original location.
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Swap Button

Click on the Swap Button to reverse the current color slider settings.
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6.10.3.4. Radial Gradient

The Radial Gradient fill style option is located on the Fill tab in the Info portion of the Sidebar. This attribute

transitions the fill from the specified start color to the specified end color by starting from the center of a

selected or created figure(s) and then moving outward in a circular manner.

The Fill option must be enabled for a change in this tab to be applied to currently selected or new figures. Click

on the box next to the option name to enable/disable it, as shown below:

Follow the steps below to set this attribute to Radial Gradient:

1. Select the Fill Tab located in the Sidebar.

2. Click on the Gradient fill style.
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3. Choose the Radial Gradient option from the Gradient drop-down menu.

4. The following example shows a rectangle with the Fill Style set to radial gradient and Color set to blue:

Note: A style change will be seen instantaneously when a figure is selected. If figures have not been selected,
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the style change will apply to all subsequently created figures.

Working with Radial Gradients

Click on a Gradient Handle to select a color from the color picker or click anywhere within the color slider to

add additional handles. The Gradient Handles can be moved to any desired position by clicking and dragging

to the right or left on the color slider.

More than one color can be added by setting each individual gradient handle to one of the desired colors. In the

example below, three gradient handles are used with these colors: white, blue, and green.
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Reset Button

The Reset Button can be used to reset the center point of the radial gradient after it has been moved. In order

for this to be seen, you must have the Gradient Locations option enabled.

To do this, click on the View Menu and the Handles-Submenu. Then click on Gradient Locations. When this

option is enabled, it will have a checkmark by its name.

Once this option is enabled, you will be able to click and drag to move the center point to another location

within a figure (see below).
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After the center point has been moved, click on the Reset Button to set the radial gradient back to its true

center point.
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Swap Button

Click on the Swap Button to reverse the current color slider settings.
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6.10.4. Shadow Color

The Shadow Color of a selected figure can be changed to meet a desired preference. It can be altered for a

selected figure(s) or in instances where no figures have been selected. If a figure has not been selected, the

color change applies to any figure added after the change. To alter the shadow color:

1. Click on the Shadow and Opacity Tab in the Sidebar.

2. Changes made to this attribute are only reflected on current or new figures within the Drawing Canvas
when the Shadow Visibility option has been enabled. To enable/disable this option, click on the
checkbox next to the option labeled "Shadow and Opacity." It will have a checkmark and blue
background when enabled.

3. Then Click on the Shadow Color attribute in the Shadow and Opacity Tab.



Page 507

TouchDraw 2 for Windows

4. To select a pre-defined color in the Color Square, click on the desired color.

5. You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,
RGB, HSV, Gray Scale, Named ColorsFavorite Colors, or Colors in Use. To do so, click on the menu
and then click on an option.
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6. If using the Color Wheel, first click on the desired color range within the outside of the wheel view.
Then choose the desired lightness or darkness of the selected color in the center (saturation) square.
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7. Perform a Click/Drag gesture combination on the Opacity Slider to change the degree to which the
shadow can be seen through. Then click anywhere within the Drawing Canvas to close the window.

8. The following examples show a square before adding a shadow and after the color has been altered.
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Note: A color change will be seen instantaneously when a figure is selected. If no figures have been selected,

the color change will apply to all subsequently created figures.

X and Y Offset

The X Offset and Y Offset attributes set the offset of the shadow in the X axis and Y axis. Type a value in the

text field or use the "Up" or "Down" Buttons to alter the shadow offset for a figure(s). In the example below,

the X and Y Offset has been changed to 15 points.
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Blur

The Blur attribute sets the amount of blur applied to the shadow. Type in a number in the text field or use the

"Up" or "Down" Buttons to alter the Blur value for the shadow. The Blur value has been changed to 20 points

in the example below.
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Opacity

Use the Opacity slider, text field, or "Up" and "Down" Buttons to alter the opaqueness (opposite of

transparency) of a selected color. In the example below, the Opacity has been changed to 50.
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6.10.5. Text Color

The Text Color of a selected figure can be changed to meet a desired preference. It can be altered for a selected

 figure(s) or in instances where no figures have been selected. If a figure has not been selected, the color

change applies to any figure added after the change. This attribute can be altered by:

1. Click on the Text Tab to view the text attributes.

2. Click on the Text Color Button in the Format Bar.

To alter the Text Color:

1. Click on the Text Color attribute in the Text Tab.

2. To select a pre-defined color in the Color Square, click on the desired color.
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3. You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,
RGB, HSV, Gray Scale, Named ColorsFavorite Colors, or Colors in Use. To do so, click on the menu
and then click on an option.
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4. If using the Color Wheel, first click on the desired color range within the outside of the wheel view.
Then choose the desired lightness or darkness of the selected color in the center (saturation) square.
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5. Scroll through the Font Family and Font Style options by clicking and dragging in an upward or
downward direction on the wheel to make a selection or Click on additional options (opacity slider, fill
type, etc.) within the popover window to make further attribute changes.

6. Click anywhere within the Drawing Canvas to close the window.
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6.10.6. Canvas Background Color

The Canvas Background Color can be changed to meet a desired preference. Follow the steps below to alter

this attribute:

1. Click on the Page Setup Tab in the Sidebar.

2. Click on the Background Color attribute in the Page Setup Tab.

3. To select a pre-defined color in the Color Square, click on the desired color.
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4. You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,
RGB, HSV, Gray Scale, Named ColorsFavorite Colors, or Colors in Use. To do so, click on the menu
and then click on an option.
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5. If using the Color Wheel, first click on the desired color range within the outside of the wheel view.
Then choose the desired lightness or darkness of the selected color in the center (saturation) square.
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6. Click anywhere within the Drawing Canvas to close the window.

7. The Canvas Background Color change will appear instantaneously.
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6.11. Handling Strokes
TouchDraw 2 provides multiple options for altering the attributes of a stroke (line) for existing or new

figures(s) within the drawing canvas. Stroke attributes are accessible through the Info of the Sidebar and can

be used to change:

• Stroke Visibility

• Line or Endpoint Styles

• Stroke Size

• Start or End Scale

• Start or End Shear

• Line Caps

• Line Joins

• Line Location

• Miter Limit

• Line Colors

The Stroke Tab appears as shown below:
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6.11.1. Stroke Visibility

The Stroke Visibility option is an On/Off toggle used to set the visibility of strokes/lines of a figure(s). If the

visibility option is turned off, the border/line of a selected or added figure(s) is not drawn at all.

The Stroke Visibility toggle is accessed by clicking on the Stroke Tab in the Sidebar, as shown below:

Click on the check box next to the Stroke label to enable or disable the Stroke Visibility option.
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If Stroke Visibility is on, an outline around the figure will be present, and if it is off and Fill Visibility is on,

the figure will appear with no border, as shown below:

Note: Stroke attribute changes will not be reflected in a selected or added figure(s) until this option has been

enabled.
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6.11.2. Stroke Style

The Stroke Style or line dash pattern and end decorations of a figure can be altered in one of the following

ways:

1. By clicking on the Stroke Tab in the Sidebar, as shown below.

2. By using the Stroke Style Buttons in the Format Bar.

The Stroke Visibility option must be enabled for a Stroke Style change to appear in the Drawing Canvas.
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To alter the Stroke Style of a currently selected figure(s) or new figure(s):

1. Click on the desired section (Dash Pattern, Start, or End) of the Line Style section in the Stroke Tab.

2. Select a style from the Start,Line, or End drop-down menus. In this example, the Start Stroke Style is
altered.
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3. The new selection will appear in the Stroke Panel.

4. For example, a Line with an arrowed Start and End Style and a Stroke Size of 3 would appear as shown
below:
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6.11.3. Stroke Size

The Stroke Size of a figure (width of a stroke in pixels) can be altered in one of the following ways:

1. By selecting the Stroke Tab in the Sidebar, as shown below.

2. Altering the Stroke Size in the Format Bar.

Note: The Stroke Visibility option must be enabled for a Stroke Size change to appear in the Drawing Canvas.

To alter the Stroke Size, click on the "Up" or "Down" arrow buttons next to the text entry field to increase or

decrease the size by increments of one or click on the text entry field to open the text editor and type in a value.
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The Stroke Size attribute provides the ability to convert other measurements (Pixels, Millimeters, Centimeters,

Inches, Feet, Meters, Kilometers, Yards, etc.) into points.

For example, if 1 centimeter (cm) is typed into this field, it will automatically be converted to its equivalent in

points when the Enter Key is pressed, or you click in another area of the application.
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If 25 millimeters (25 mm) is entered as the Stroke Size, it will be converted to 70.866 points.
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Note: A size change will be seen instantaneously when a stroke figure is selected. If no figures have been

selected, the size change will apply to all subsequently created stroke figures.
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6.11.4. Start/End Scale

The Start or End Scale for the Stroke Style of a figure can be altered by clicking on the Stroke Tab in the

Sidebar, as shown below.

Note: The Stroke Visibility option must be enabled for a Start/End Scale change to appear in the Drawing

Canvas.

To alter the Start/End Scale of a currently selected figure(s) or new figure(s):

1. Click on the figure to make a selection and alter the start/end scale for a single figure or simply change
the value within Stroke Tab to change it for all new figures within the drawing.
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2. The Start Scale can be used to change the size of the Start Line for a figure. Click on the text field to
type in a value or use the "Up" or "Down" Buttons to change the value by 1. In this example, the value
has been changed to 5.
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3. The figure will appear as shown below when the Start Scale has been altered.

4. The End Scale can be used to change the size of the End Line for a figure. Click on the text field to type
in a value or use the "Up" or "Down" Buttons to change the value by 1. In this example, the value has
been changed to 5.
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5. The figure will appear as shown below after both the Start and End Scale values have been changed.
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6.11.5. Start/End Shear

The Start Shear and End Shear stroke style attributes can be used to shear (or skew) arrowheads on lines

within a drawing. Values default to degrees, and negative values may be entered.

The Start or End Shear for the Stroke Style of a figure can be altered by clicking on the Stroke Tab in the

Sidebar, as shown below.

Note: The Stroke Visibility option must be enabled for a Start/End Shear change to appear in the Drawing

Canvas.

To alter the Start/End Shear of a currently selected figure(s) or new figure(s):

Step 1: Click on the figure to make a selection and alter the start/end shear for a single figure or simply change

the value within Stroke Tab to change it for all new figures within the drawing.
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Step 2: The Start Shear can be used to shear the arrowhead of the Start Line for a line figure. Click on the

text field to type in a value or use the "Up" or "Down" Buttons to change the value by 1. In this example, the

value has been changed to 25 degrees.



Page 539

TouchDraw 2 for Windows

Step 3: The figure will appear as shown below when the Start Shear has been altered.

Step 4: The End Shear can be used to change the shear of the arrowhead of the End Line for a line figure.

Click on the text field to type in a value or use the "Up" or "Down" Buttons to change the value by 1. In this

example, the value has been changed to 25 degrees.
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The figure will appear as shown below after both the Start and End Shear values have been changed.



Page 541

TouchDraw 2 for Windows

Below is an example of how the Start and End Shear options can be used within a drawing:
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6.11.6. Line Join

The Line Join (Mitered, Rounded, or Bevelled) of a figure can be altered by clicking on the Stroke Tab in the

Sidebar, as shown below.

Note: The Stroke Visibility option must be enabled for a Line Join change to appear in the Drawing Canvas.

To alter the Line Join Type, click on one of the choices (Mitered, Rounded, or Beveled) under the line join

heading. The selection will appear in blue as a visual indicator of the currently active line join type.
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The image below shows what a Square would look like with a Mitered, Rounded, and Beveled Line Join.

Note: A line join change will be seen instantaneously when a stroke figure is selected. If no figures have been

selected, the line cap change will apply to all subsequently created stroke figures.



Page 544

TouchDraw 2 for Windows

6.11.7. Line Cap

The Line Cap (Butt, Rounded, or Square) of a figure can be altered by clicking on the Stroke Tab in the

Sidebar, as shown below.

Note: The Stroke Visibility option must be enabled for a Line Cap change to appear in the Drawing Canvas.

To alter the Line Cap Type, click on one of the choices (Butt, Rounded, or Square) under the line cap heading.

The selection will appear in blue as a visual indicator of the currently active line cap type.
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For example, the image below shows what a Line would look like with a Butt, Rounded, and Square Line

Cap.

Note: A line cap change will be seen instantaneously when a stroke figure is selected. If no figures have been

selected, the line cap change will apply to all subsequently created stroke figures.
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6.11.8. Line Location

The Line Location of a figure can be altered by clicking on the Stroke Tab in the Sidebar, as shown below.

Note: The Stroke Visibility option must be enabled for a Line Location change to appear in the Drawing

Canvas.

To alter the Line Location, click on one of the choices under the line location heading. The selection will

appear in blue as a visual indicator of the currently active line location setting.
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The example below shows what a Rectangle looks like when each Line Location choice is selected: Inside,

Center, and Outside.

Note: A line location change will be seen instantaneously when a stroke figure is selected. If no figures have

been selected, the line join change will apply to all subsequently created stroke figures.
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6.11.9. Miter Limit

The Miter Limit attribute can be used to set the angle of connected line segments where they join. The join

will be more jagged or sharp depending on the entered or selected value. Miter limits are relative to stroke size

and become increasingly noticeable for line segments with increased thickness.

The Miter Limit of a stroke (or line) can be altered by selecting the Stroke Tab in the Sidebar, as shown

below.

Note: The Stroke Visibility option must be enabled for a Miter Limit change to appear in the drawing canvas.

To alter the Miter Limit, click on the "Up" or "Down" arrow buttons next to the text entry field to increase or

decrease the miter limit by increments of one or click on the text entry field to open the text editor and type in a

value.
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The Miter Limit attribute provides the ability to convert other units of measurement (Pixels, Millimeters,

Centimeters, Feet, Meters, Kilometers, Yards, etc.) into points.

For example, if 10 millimeters (mm) is typed into this field, it will automatically be converted to its equivalent

in points when the Enter Key is pressed, or you click in another area of the application.
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If 2 centimeters (2 cm) is entered as the Miter Limit, then it will be converted to 56.693 points.



Page 551

TouchDraw 2 for Windows

Note: A miter limit change will be seen instantaneously when a stroke figure is selected. If no figures have

been selected, the line cap change will apply to all subsequently created stroke figures.
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6.11.10. Line Color

The Stroke Color of a selected figure can be changed to meet a desired preference. It can be altered for a

selected figure(s) or in instances where no figures have been selected.

If a figure has not been selected, the color change applies to any figure added after the change. This attribute

can be altered in one of two ways:

Method 1

Step 1: Click on the Stroke Tab in the Sidebar.

Step 2: Click on the Stroke Color attribute.
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Method 2

Click on the Stroke Color Button in the Format Bar.

To alter the Stroke Color:

Step 1: Click on the Stroke checkbox in the upper left-hand corner of the Stroke Window to turn on this

option. A checkmark will be present when this option is enabled.
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Step 2: Click on the Stroke Color attribute on the Stroke Tab.

Step 3: To select a pre-defined color in the Color Square, click on the desired color.
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Step: 4 You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,

RGB, HSV, Gray Scale, Named Colors, Favorite Colors, or Colors in Use. To do so, click on the menu and

then click on an option.

Step 5: If using the Color Wheel, first click on the desired color range within the outside of the wheel view.

Then choose the desired lightness or darkness of the selected color in the center (saturation) square.
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For more information about using the different color selection options, please see the Color Picker section.
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Step 6: Alter the Stroke Style options (arrowhead, dashed, solid, etc.) by clicking on an option and then

clicking on the desired selection in the Stroke Window. Click on additional options (opacity, line join, etc.)to

make further attribute changes.

Step 7: Click anywhere within the Drawing Canvas to close the window.
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Note: A color change will be seen instantaneously when a stroke figure is selected. If no figures have been

selected, the color change will apply to all subsequently created stroke figures.
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6.12. Handling Text
TouchDraw 2 provides multiple options for changing the text attributes of figures capable of displaying text.

The Text Tool can be used to add a text box anywhere on the Drawing Canvas. Text may also be added as part

of these shapes:

• Rectangles

• Rounded Rectangles

• Ovals

• Circles

• Polygons

• Closed Paths (Custom Shapes)

The attributes for entered text can be changed to meet specific preferences and include:

• Font Family

• Font Size

• Font Style

• Font Color

• Text Alignment

• Text Margin

Additionally, the location and orientation for text attached to lines and paths can be altered:

• Text Location

• Text Orientation

Variables may also be used to input a specific pre-formatted value as part of the displayed text within a figure.
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6.12.1. Editing Text

The Text Editor Popover must be opened to edit the text content of a selected figure. Double click on a figure

to bring up the Text Editor.

Entered text will be reflected within the drawing view in real-time to provide instant feedback regarding how it

will appear, wrap, etc., within the figure.

Click in any location outside of the supplied popover to dismiss the editor.
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6.12.2. Font Family

A figure must be selected to alter the Font Family of entered text.

Use one of the following methods to change the font family for a selected figure(s):

Method 1

Step 1: Select the Text Tab located in the Info portion of the Sidebar and click on the Font Family drop-down

menu.

Step 2: Click on a family name in the provided list to make a selection, and the drop-down menu will close

automatically. The selection will appear in the Font Family section of the Text Tab, as shown below.
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In the above example, the Font Family was changed from Arial to Courier New.

Method 2

Step 1: Click on the Font option located in the Format Bar.

Step 2: Click on a family name in the provided list to make a selection, and click anywhere within the Drawing

Canvas to close the selection window.
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Note: The Search Field may also be used to quickly locate a specific font family. To use this feature, click on

the field and then type part or all of a font family name.

The selection will appear in the Font section of the Format Bar and will be applied to the selected figures as

well as new text additions.

In the above example, the Font Family was changed from Arial to Times New Roman.

Note: The currently applied Font Family will be highlighted in gray within the pop-over window.
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6.12.3. Font Size

A figure must be selected to alter the Font Size of entered text.

Use one of the following methods to change the font size for a selected figure(s):

Method 1

Step 1: Click on the Text Tab located in the Info portion of the Sidebar.

Step 2: Use the "up" or "down" selection buttons to alter the size or click on the actual field to make a
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keyboard entry.

Method 2

Click on the Font Size drop-down menu located in the Format Bar. Use the drop-down size menu button or

click on the actual field to make a keyboard entry.

Measurement Conversions

The Font Size attribute provides the ability to convert a different unit of measurement (Pixels, Millimeters,

Centimeters, Meters, Kilometers, Feet, etc.) into their equivalent measurement in points.

To use the conversion feature, simply type in the value for the unit of measurement and its abbreviation (px,

mm, cm, m, km, ft, etc.) and then press the Enter Key or click in another area of the application.

In the example below, the Font Size value has been entered as 2 centimeters (cm), which is equivalent to

56.693 points.
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If the Font Size is entered as 25 millimeters (25 mm), it is converted to 70.866 points.
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6.12.4. Font Styles

A figure must be selected to alter the Font Style of entered text.

Use one of the following methods to change the font style for a selected figure(s):

Method 1

Step 1: Select the Text Tab located in the Info portion of the Sidebar. Click on the Font Style selection

drop-down menu.
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Click on a style to make a selection, and the drop-down menu will close automatically. The selection will

appear in the Font Style section of the Text Tab. The Font Style was changed from Regular to Bold in the

example below.

Method 2

Click on the Font option located in the Format Bar.

Then click on the desired style on the right side of the popover window.
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The selection will appear in the Font section of the Format Bar and will be applied to the selected figures and

new text additions. In this example, the Font Style was changed from Regular to Bold.
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6.12.5. Font Color

The Font Color of a selected figure can be changed to meet a desired preference. It can be altered for a selected

 figure(s) or in instances where no figures have been selected. If a figure has not been selected, the color

change applies to any figure added after the change.

To alter the Font Color:

1. Click on the Text Color attribute in the Text Tab.

2. To select a pre-defined color in the Color Square, click on the desired color.
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3. You may also configure a color by choosing an option from the Color Selection Menu:Color Wheel,
RGB, HSV, Gray Scale, Named Colors, Favorite Colors, or Colors in Use. To do so, click on the menu
and select an option.

4. If using the Color Wheel, first click on the desired color range within the outside of the wheel view.
Then choose the desired lightness or darkness of the selected color in the center (saturation) square.
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5. Scroll through the Font Family and Font Style options by clicking and dragging in an upward or
downward direction on the wheel to make a selection or Click on additional options (opacity slider, fill
type, etc.) within the pop-over window to make further attribute changes.
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6. Click anywhere within the Drawing Canvas to close the window.Note: A color change will be seen
instantaneously when the text is selected. If text has not been selected, the color change will apply to all
subsequent text entries.
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6.12.6. Text Alignment

The Text Alignment option alters the vertical and horizontal positioning of text within its bounding box. A

figure must be selected to alter the alignment position of entered text.

Use one of the following methods to change the text alignment position within a selected figure(s):

Method 1

Step 1: Select the Text Tab located in the Info portion of the Sidebar.

Step 2: Click on a horizontal or vertical alignment button to make a selection.
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Method 2

The alignment of text can also be changed by using the Format Bar.

The currently selected horizontal and vertical alignment choices will appear blue, as shown below.

The following example shows the alteration of text within a figure from a left horizontal alignment to a right

horizontal alignment.
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6.12.7. Text Margin

A figure must be selected to alter the Text Margin of entered text.

Click on the Text Tab located in the Info portion of the Sidebar. Use the "up" or "down" selection buttons to

alter the margin value or click on the actual field to make a keyboard entry.

The Text Margin attribute provides the ability to convert alternative units of measurement (Pixels,

Millimeters, Centimeters, Meters, Kilometers, Feet, etc.) into their equivalent measurement in points.

To use the conversion feature, simply type in a number value and the abbreviation for the desired unit of

measurement (px, mm, cm, m, km, ft, etc.) and then press the Enter Key or click in another area of the

application.

In the example below, the Text Margin value has been entered as 1 centimeter (1 cm), which is equivalent to

28.346 points.
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In this example, the Text Margin is entered as 5 millimeters (5 mm) and is converted to 14.173 points.

If you enter 1 inch (1 in) as the Text Margin, then it will be converted to 72 points (1 inch = 72 points).
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6.12.8. Text Location

The Text Location slider and percentage field can be used to change the location of text that is attached to a

line or path.

Complete the following steps to change the location of text attached to a line or path:

Step 1: Create a line or path and add text to the figure. In this example, a Path figure has been created within

the drawing.

Step 2: Click on the Text Tab to access the Text Location option.
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Step 3: Click on the Attached option to enable it.

Step 4: Use the Slider or Up and Down buttons to change the text location.



Page 583

TouchDraw 2 for Windows

In the example below, the text location has been changed to 85%.
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6.12.9. Text Orientation

The Text Orientation Menu can be used to change the orientation of text that is attached to a line or path.

Text Orientation can be Absolute or Relative. Absolute is selected by default.

Note: Text Orientation can be changed for all lines and paths in a drawing or one or more selected lines and

paths.

How to Change the Text Orientation

Complete the following steps to change the orientation of text attached to a line or path:

Step 1: Select the Text Tab to access the Text Orientation option.
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Step 2: If not already enabled, click on the Attached option to enable it.

Step 3: Use the Text Orientation drop-down menu to select an option.



Page 586

TouchDraw 2 for Windows

Path Figure with Absolute Text Orientation

Path Figure with Relative Text Orientation
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6.12.10. Adding Variables to Text

A Variable can be added to text within a figure through the Text Editor Popup Window by hand keying the

desired variable as part of the text or completing an insertion with the Variable Popup Menu.

On a subsequent page, there is a list of available variables.

In the following example, the Area variable is included as part of the selected rectangle's text.

1. Double Click on a desired figure to open the Text Editor.

2. Begin entering text and then click on the Variable Popup Menu to select a currently supported variable
from the provided list.
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3. The variable will appear in the Text Editor Popup Window after it has been selected.

4. The selected variable shows as the actual value within the selected figure as it is entered.

5. The final text within the selected figure appears as shown below.
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6.12.10.1. Available Variables

TouchDraw 2 supports inserting Variables into a text area. Entered variables are replaced with the actual value

when the drawing is rendered. The table below provides a list of currently supported Text Variables:

Variable Name Variable Type Description

{MinX} Pre-formatted The minimum X-axis position of the figure bounds + the units

abbreviation.

{MaxX} Pre-formatted The maximum X-axis position of the figure bounds + the units

abbreviation.

{MinY} Pre-formatted The minimum Y-axis position of the figure bounds + the units

abbreviation.

{MaxY} Pre-formatted The maximum Y-axis position of the figure bounds + the units

abbreviation.

{Length} Pre-formatted The length of the line (if the text is added to a line or line

connection) + the units abbreviation.

{Width} Pre-formatted The width of the figure bounds + the units abbreviation.

{Height} Pre-formatted The height of the figure bounds + the units abbreviation.

{Area} Pre-formatted The area of the figure + the units abbreviation.

{Dxxxx} Decimal The decimal representation (to 4 decimal points) of one of the 7

variables above where xxxx is the name of the variable.  For

example, {DLength} would return the decimal value of a line

length.

{Fxxxx} Fractional The fractional representation of one of the 7 variables above

where xxxx is the name of the variable.  For example,

{FLength} would return the fractional value of a line length.

{DrawingName} Pre-formatted The name of the current drawing.

{Units} Pre-formatted The abbreviation of the unit of measure specified for the

drawing.
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Variable Name Variable Type Description

{UnitsName} Pre-formatted The full name of the unit of measure specified for the drawing.

{Layer} Pre-formatted The name of the layer that the figure is currently in.

{Date} Date The current date.
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6.12.10.2. Formatting Date Variables

By default, the {Date} variable will expand into a date formatted in the mm/dd/yyyy (or dd/mm/yyyy for

non-US locales) format as shown in the screenshot below:

TouchDraw 2 allows the exact formatting style to be specified in scenarios where the date must be formatted

differently than the default setting. Use one of the following {Date:format} options to insert a desired

format. Refer to the sample table below:

Variable Description Examples

{Date:d} Default - Short

Date Formatting

6/15/2009 (US)   15/06/2009 (France)   2009/06/15 (Japan)

{Date:D} Long Date

Formatting

Monday, June 15, 2009 (US)   15      2009  . (Russia)   Montag,

15. Juni 2009 (Germany)

{Date:f} Full Date/Time

(short time)

Formatting

Monday, June 15, 2009 1:45 PM (US)   den 15 juni 2009 13:45

(Sweden)          , 15         2009 1:45    (Greece)

{Date:F} Full Date/Time

(long time)

Formatting

Monday, June 15, 2009 1:45:30 PM (US)   den 15 juni 2009

13:45:30 (Sweden)          , 15         2009 1:45:30    (Greece)

{Date:g} General

Date/Time (short

time) Formatting

6/15/2009 1:45 PM (US)   15/06/2009 13:45 (Spain)

2009/6/15 13:45 (China)
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Variable Description Examples

{Date:G} General

Date/Time (long

time) Formatting

6/15/2009 1:45:30 PM (US)   15/06/2009 13:45:30 (Spain)

2009/6/15 13:45:30 (China)

{Date:m} General

Month/Day

Formatting

June 15 (US)   juni 15 (Denmark)   Juni 15 (Indonesia)

{Date:M} General

Month/Day

Formatting

June 15 (US)   juni 15 (Denmark)   Juni 15 (Indonesia)

{Date:o} Round-Trip

Date/Time

Formatting

06-15T13:45:30.0900000

{Date:O} Round-Trip

Date/Time

Formatting

06-15T13:45:30.0900000

{Date:r} RFC1123

Formatting

15 Jun 2009 20:45:30 GMT

{Date:R} RFC1123

Formatting

15 Jun 2009 20:45:30 GMT

{Date:s} Sortable

Date/Time

Formatting

2009-06-15T13:45:30

{Date:t} Short Time

Formatting

1:45 PM (US)   13:45 (Croatia - Hrvatska)   01:45 (Egypt)

{Date:T} Long Time

Formatting

01:45:30 PM (US)   13:45:30 (Croatia - Hrvatska)   01:45:30

(Egypt)

{Date:u} Universal Sortable

Date/Time

Formatting

2009-06-15 20:45:30Z

{Date:U} Universal Full Monday, June 15, 2009 8:45:30 PM (US)   den 15 juni 2009



Page 595

TouchDraw 2 for Windows

Variable Description Examples

Date/Time

Formatting

20:45:30 (Sweden)          , 15         2009 8:45:30    (Greece)

{Date:y} Year Month

Formatting

June, 2009 (US)   juni 2009 (Denmark)   Juni 2009 (Indonesia)

{Date:Y} Year Month

Formatting

June, 2009 (US)   juni 2009 (Denmark)   Juni 2009 (Indonesia)

In addition to the formatting variables above, you can also use the variable below to create your own custom

date formats. For example, we could do something like the following

{Date:MM/dd/yy H:mm:ss}

which would create something like:

06/10/12 15:24:16

Variable Description Examples

{Date:d} The day of the month, from

1 through 31.

6/1/2009 1:45:30 PM -> 1   6/15/2009 1:45:30 PM ->

15

{Date:dd} The day of the month, from

01 through 31.

6/1/2009 1:45:30 PM -> 01   6/15/2009 1:45:30 PM

-> 15

{Date:ddd} The abbreviated name of the

day of the week.

6/15/2009 1:45:30 PM -> Mon (US)   6/15/2009

1:45:30 PM ->    (Russia)   6/15/2009 1:45:30 PM ->

lun. (France)

{Date:dddd} The full name of the day of

the week.

6/15/2009 1:45:30 PM -> Monday (US)   6/15/2009

1:45:30 PM ->             (Russia)   6/15/2009 1:45:30

PM -> lundi (France)

{Date:f} The tenths of a second in a

date and time value.

6/15/2009 13:45:30.617 -> 6   6/15/2009

13:45:30.050 -> 0

{Date:ff} The hundredths of a second

in a date and time value.

6/15/2009 13:45:30.617 -> 61   6/15/2009

13:45:30.005 -> 00



Page 596

TouchDraw 2 for Windows

Variable Description Examples

{Date:fff} The milliseconds in a date

and time value.

6/15/2009 13:45:30.617 -> 617   6/15/2009

13:45:30.0005 -> 000

{Date:ffff} The ten thousandths of a

second in a date and time

value.

6/15/2009 13:45:30.6175 -> 6175   6/15/2009

13:45:30.00005 -> 0000

{Date:fffff} The hundred thousandths of

a second in a date and time

value.

6/15/2009 13:45:30.61754 -> 61754   6/15/2009

13:45:30.000005 -> 00000

{Date:ffffff} The millionths of a second

in a date and time value.

6/15/2009 13:45:30.617542 -> 617542   6/15/2009

13:45:30.0000005 -> 000000

{Date:fffffff} The ten millionths of a

second in a date and time

value.

6/15/2009 13:45:30.6175425 -> 6175425   6/15/2009

13:45:30.0001150 -> 0001150

{Date:F} If non-zero, the tenths of a

second in a date and time

value.

6/15/2009 13:45:30.617 -> 6   6/15/2009

13:45:30.050 -> (no output)

{Date:FF} If non-zero, the hundredths

of a second in a date and

time value.

6/15/2009 13:45:30.617 -> 61   6/15/2009

13:45:30.005 -> (no output)

{Date:FFF} If non-zero, the milliseconds

in a date and time value.

6/15/2009 13:45:30.617 -> 617   6/15/2009

13:45:30.0005 -> (no output)

{Date:FFFF} If non-zero, the ten

thousandths of a second in a

date and time value.

6/1/2009 13:45:30.5275 -> 5275   6/15/2009

13:45:30.00005 -> (no output)

{Date:FFFFF} If non-zero, the hundred

thousandths of a second in a

date and time value.

6/15/2009 13:45:30.61754 -> 61754   6/15/2009

13:45:30.000005 -> (no output)

{Date:FFFFFF} If non-zero, the millionths

of a second in a date and

6/15/2009 13:45:30.617542 -> 617542   6/15/2009

13:45:30.0000005 -> (no output)
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Variable Description Examples

time value.

{Date:FFFFFFF} If non-zero, the ten

millionths of a second in a

date and time value.

6/15/2009 13:45:30.6175425 -> 6175425   6/15/2009

13:45:30.0001150 -> 000115

{Date:g},

{Date:gg}

The period or era. 6/15/2009 1:45:30 PM -> A.D.

{Date:h} The hour, using a 12-hour

clock from 1 to 12.

6/15/2009 1:45:30 AM -> 1   6/15/2009 1:45:30 PM

-> 1

{Date:hh} The hour, using a 12-hour

clock from 01 to 12.

6/15/2009 1:45:30 AM -> 01   6/15/2009 1:45:30 PM

-> 01

{Date:H} The hour, using a 24-hour

clock from 0 to 23.

6/15/2009 1:45:30 AM -> 1   6/15/2009 1:45:30 PM

-> 13

{Date:HH} The hour, using a 24-hour

clock from 00 to 23.

6/15/2009 1:45:30 AM -> 01   6/15/2009 1:45:30 PM

-> 13

{Date:m} The minute, from 0 through

59.

6/15/2009 1:09:30 AM -> 9   6/15/2009 1:09:30 PM

-> 9

{Date:mm} The minute, from 00

through 59.

6/15/2009 1:09:30 AM -> 09   6/15/2009 1:09:30 PM

-> 09

{Date:M} The month, from 1 through

12.

6/15/2009 1:45:30 PM -> 6

{Date:MM} The month, from 01 through

12.

6/15/2009 1:45:30 PM -> 06

{Date:MMM} The abbreviated name of the

month.

6/15/2009 1:45:30 PM -> Jun (US)   6/15/2009

1:45:30 PM -> juin (France)   6/15/2009 1:45:30 PM

-> Jun (South Africa)

{Date:MMMM} The full name of the month. 6/15/2009 1:45:30 PM -> June (US)   6/15/2009

1:45:30 PM -> juni (Denmark)   6/15/2009 1:45:30

PM -> uJuni (South Africa)

{Date:s} The second, from 0 through 6/15/2009 1:45:09 PM -> 9
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Variable Description Examples

59.

{Date:ss} The second, from 00

through 59.

6/15/2009 1:45:09 PM -> 09

{Date:t} The first character of the

AM/PM designator.

6/15/2009 1:45:30 PM -> P (US)   6/15/2009 1:45:30

PM ->   (Japan)   6/15/2009 1:45:30 PM -> (France)

{Date:tt} The AM/PM designator. 6/15/2009 1:45:30 PM -> PM (US)   6/15/2009

1:45:30 PM ->    (Japan)   6/15/2009 1:45:30 PM ->

(France)

{Date:y} The year, from 0 to 99. 1/1/0001 12:00:00 AM -> 1   1/1/0900 12:00:00 AM

-> 0   1/1/1900 12:00:00 AM -> 0   6/15/2009 1:45:30

PM -> 9

{Date:yy} The year, from 00 to 99. 1/1/0001 12:00:00 AM -> 01   1/1/0900 12:00:00 AM

-> 00   1/1/1900 12:00:00 AM -> 00   6/15/2009

1:45:30 PM -> 09

{Date:yyy} The year, with a minimum

of three digits.

1/1/0001 12:00:00 AM -> 001   1/1/0900 12:00:00

AM -> 900   1/1/1900 12:00:00 AM -> 1900

6/15/2009 1:45:30 PM -> 2009

{Date:yyyy} The year as a four-digit

number.

1/1/0001 12:00:00 AM -> 0001   1/1/0900 12:00:00

AM -> 0900   1/1/1900 12:00:00 AM -> 1900

6/15/2009 1:45:30 PM -> 2009

{Date:yyyyy} The year as a five-digit

number.

1/1/0001 12:00:00 AM -> 00001   6/15/2009 1:45:30

PM -> 02009

{Date:z} >Hours offset from UTC,

with no leading zeros.

6/15/2009 1:45:30 PM -07:00 -> -7

{Date:zz} Hours offset from UTC,

with a leading zero for a

single-digit value.

6/15/2009 1:45:30 PM -07:00 -> -07

{Date:zzz} Hours and minutes offset

from UTC.

6/15/2009 1:45:30 PM -07:00 -> -07:00

{Date::} The time separator. 6/15/2009 1:45:30 PM -> : (US)   6/15/2009 1:45:30
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Variable Description Examples

PM -> . (Italy) 6/15/2009 1:45:30 PM -> : (Japan)

{Date:/} The date separator. 6/15/2009 1:45:30 PM -> / (US)   6/15/2009 1:45:30

PM -> - (Algeria)
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6.12.10.3. Formatting Decimal Variables

The Decimal Variable can be inserted as part of entered text to show the value of another variable in decimal

form within the text of a figure. Refer to the Text Variable Table for a list of all supported variables.

Any of the listed pre-formatted numerical variables can have a "D" placed in front of it (as long as they

correspond with the type of selected figure) to insert the value as a decimal. The following screenshot shows an

example of this:

By default, the decimal value will be presented with at most 4 digits after the decimal point. An alternative

formatting style can be specified by using the {Dxxxx:format} pattern. The table below outlines the

options for formatting the decimal value.

Format Specifier Name Description Examples

0 Zero Placeholder Replaces the zero with the corresponding

digiti if one is present, otherwise zero

appears in the result.

Width =

1234.5678

Variable =

{DWidth:00000}

   Result =

01234      Width =

0.45678   Variable

=

{DWidth:0.00}

   Result = 0.46
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Format Specifier Name Description Examples

# Digit Placeholder Replaces the pound sign with the

corresponding digit if one is present;

otherwise, no digit appears in the result

string.

Width =

1234.5678

Variable =

{DWidth:\#\#\#\#\#}

   Result = 1234

Width = 0.45678

Variable =

{DWidth:\#.\#\#}

   Result = .46

. Decimal Point Determines the location of the decimal

separator in the result string.

Width = 0.45678

Variable =

{DWidth:0.00}

   Result (US) =

0.46  Width =

0.45678   Variable

=

{DWidth:0.00}

   Result

(Germany) = 0,46

, Group Separator Inserts a group separator character

between each group.

2147483647 ("#

#,#") =

2,147,483,647

(US)  2147483647

("# #,#") =

2.147.483.647

(Estonia)

, Number Scaling Divides a number by 1000 for specified

commas.

2147483647

("#,#,,") = 2,147

(US)  2147483647

("#,#,,") =   2.147

(Estonia)

% Percent

Placeholder

Multiplies a number by 100 and inserts a

localized percentage symbol in the result

0.03697

("%,#0.00") =
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Format Specifier Name Description Examples

string. %36.97 (US)

0.03697

("%,#0.00") =

%36,97 (Greece)

0.03697 ("#

#.0%") = 37.0%

(US)  0.03697 ("#

#.0%") = 37,0%

(Greece)

‰ Per Mille

Placeholder

Multiplies a number by 1000 and inserts

a localized per mille symbol in the result

string.

0.03697 ("#

0.00‰") =

36.97‰ (US)

0.03697 ("#

0.00‰") =

36,97‰ (Russia)

EO, E+0, E-0, e0,

e+0, e-0

Exponential

Notation

Zero - Formats in exponential notation.

E/e - Indicates case of the exponent

symbol in the resulting string.  Plus Sign

- Indicates that the sign character

precedes the exponent.  Minus Sign -

Indicates that a sign character precedes

only negative exponents.  The number of

zeros following the E/e symbol

determines the minimum number of

digits in the exponent (Must have at least

one zero).

987654 ("#

0.0e0") = 98.8e4

1503.92311 ("0.0

# # e +00") =

1.504e+03

18901385E-16

("0.0e +00") =

1.9e-16

\ Escape Character Next character interpreted as a literal

rather than custom format specifier.

987654 ("\# # #

00\#") = #987654#

'string', "string" Literal String

Delimiter

Indicates that the enclosed characters

should be copied to the result string

without changes.

68 ("# ' degrees'")

= 68 degrees  68

("# ' degrees'") =

68 degrees
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Format Specifier Name Description Examples

; Section Separator Defines sections using separate format

strings for positive, negative, and zero

numbers.

12.345 ("# 0.0#;

(#0.0#); -\0-") =

12.35  0 ("# 0.0#;

(#0.0#); -\0-") =

-0-  -12.345 ("#

0.0#; (#0.0#);

-\0-") = (12.35)

12.345 ("# 0.0#;

(#0.0#)") = 12.35

0 ("# 0.0#;

(#0.0#)") = 0.0

-12.345 ("# 0.0#;

(#0.0#)") = (12.35)

Other All Other

Characters

The character is copied to the result

string unchanged.

68 (" # °") = 68 °
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6.12.10.4. Formatting Fractional Variables

The Fractional Variable can be inserted as part of entered text to show the value of another variable in

fractional form within the text of a figure. Refer to the Text Variable Table for a list of all supported variables.

Any of the listed pre-formatted numerical variables can have an "F" placed in front of it (as long as they

correspond with the type of selected figure) to insert the value as a fraction. The following screenshot shows an

example of this:

Additional format specifiers may be added at the end of the variable to alter the number of shown placeholders

of a fractional value or to round the supplied value. Rounding is accomplished by placing a semi-colon (:) after

the variable followed by either #.### or #.000. The screenshots below are two examples of ways to round a

fractional value in the Text Editor.
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Both the F and first letter of the entered variable must be capitalized for the value to appear in the selected

figure.

By default, the numerator and denominator making up the fractional value will be presented with at most three

digits. An alternative formatting style can be specified by using the {Fxxxx:format} pattern. The table

below outlines the options for formatting the fractional value.

Format Specifier Name Description Examples

0 Zero Placeholder Replaces the zero with the

corresponding digit if one

is present, otherwise zero

appears in the result.

Length = 4 148/249   Variable =

{FLength:00000}   Result =

5      Length = 4 148/249

Variable = {FLength:0.00}

Result = 4 63/100

# Digit Placeholder Replaces the pound sign

with the corresponding

digit if one is present;

otherwise, no digit

appears in the result string.

Length = 4 148/249   Variable =

{FLength:\#\#\#\#\#}

Result = 5      Length = 4

148/249   Variable =

{FLength:\#.\#\#}   Result

= 4 63/100

. Decimal Point Determines the location of

the fractional separator in

the result string.

Length = 4 148/249   Variable =

{FLength:0.00}   Result

(US) = 4 63/100

Other All Other

Characters

The character is copied to

the result string

68 (" # °") = 68 °
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Format Specifier Name Description Examples

unchanged.
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6.13. Handling Paths
TouchDraw 2 supplies multiple actions for altering handles or segments within a created path. A handle may be

inserted or deleted at any point within the path, and a figure can be split at a selected handle. Segments may be

removed from a figure or converted to a line, quadratic curve, or cubic curve segment by adding or deleting

corresponding control points. These additional actions are available for altering an existing figure:

• Opening a Path

• Closing a Path

• Joining Lines and Paths

• Trimming Lines and Paths

• Reversing Lines and Paths

• Splitting Segments

• Creating and Separating Compound Paths

• Conversion of Shape or Text Figure(s) to Paths

A control point is displayed in gray when it has not been used and is referred to as a "phantom" control point.

This characteristic provides a hint to the TouchDraw 2 application that it should function as a control point in

scenarios where the next drawn segment is a curve.

A few basic actions can be used to alter the "phantom" control point position as a path is edited. Refer to the

sections below to learn more about each available action.

Click/Drag

A Click/Drag combination on any position in the drawing canvas creates the end handle of a curve segment in

relevance to the current "phantom" control point position. The "phantom" control point is re-positioned in

accordance with the newly created end handle while this action occurs.
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Option/Click

An Option/Click combination allows the "phantom" control point position to be set to a desired location on the

drawing canvas after a curve segment has been created.
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Option/Click/Drag

An Option/Click/Drag combination allows the "phantom" control point to be dragged to any point on the

drawing canvas and changes a corner point back to a smooth curve after a curve segment has been created.

Text Location and Orientation

Text can be added and attached to a Path Figure. The location and orientation of attached text can be altered for

Path Figures within the Text Tab.
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6.13.1. Opening a Path

TouchDraw 2 supplies options for opening and closing an existing path. A path can be opened to make

individual alterations, such as segment additions. Follow the steps below to open a currently closed path:

1. Select the path to be opened.

2. Select the Modify Menu and choose Open Path.

3. The end/start handle of the closed path is separated into two individual handles. Once a path has been
opened, the connecting segments are treated as individual path segments. They can be moved or
expanded to any point on the drawing canvas, have handles added, be converted to a quadratic or curve
segment, and be combined with additional paths.



Page 612

TouchDraw 2 for Windows

6.13.2. Closing a Path

The Close Path option draws a straight line segment from the last segment end handle to the path start handle

to close an open path. Follow the steps below to close a currently open path:

1. Select the path to be closed.

2. Select the Modify Menu and choose Close Path.

3. A straight line segment will be drawn from the last segment end point to the start handle of the chosen
path.
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6.13.3. Joining Lines and Paths

The Join Lines/Paths option allows the intersecting end points of two or more selected lines or paths to be

joined to form a single path. A minimum of two intersecting lines or paths must be selected for a join to occur.

Follow the steps below to join two line end points:

1. Create two lines on the drawing canvas using the Line Tool and then select both line figures by holding
down the Shift Key while clicking.

2. Select the Modify Menu and choose Join Lines/Paths.



Page 614

TouchDraw 2 for Windows

3. The line end points are joined to create two path segments with corresponding end points (orange), a start
handle (orange circle with white center), and a rotation handle (red). To learn more about the types of
handles used within TouchDraw, refer to the handles reference table.

Two or more path end points may also be combined with the Join Lines/Paths menu option. Follow the steps

below to join two path end points:

1. Create two paths with at least one shared segment end point on the drawing canvas using the Path Tool
and then select both paths by holding down the Shift Key while clicking.



Page 615

TouchDraw 2 for Windows

2. Select the Modify Menu and choose Join Lines/Paths.
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3. As shown below, the intersecting end points are joined to form a single segment end point (orange) and a
new start point handle (orange with a white dot) is added to the beginning of the first selected path to
visually indicate the formation of a single path. To learn more about the types of handles used within
TouchDraw, refer to the handles reference table.
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6.13.4. Trimming Lines and Paths

The Trim Lines/Paths option trims a line or path when it intersects near its end with another shape or line.

TouchDraw 2 considers "near" to be when an intersection is within the first or last eighth (1/8th) of the line. If

the intersection is within the middle 6/8ths, then the line is not trimmed.

Follow the steps below to trim the ends of intersecting lines or paths:

1. Select the items to be trimmed.

2. Select the Modify Menu and choose Trim Lines/Paths.
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3. All lines or paths intersecting within the last 1/8th are trimmed. In this example, the additional portions
of the path extending past the straight line are trimmed.
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6.13.5. Reversing Lines and Paths

The Reverse Lines/Paths menu item flips or reverses the direction of the decorations (arrowhead, diamond,

square, etc.) within selected lines and/or paths.

Follow the steps below to reverse the ends of lines or paths:

Step 1:Select the lines or paths to be reversed.
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Step 2: Select the Modify Menu and choose Reverse Lines/Paths.

Step 3: All decorations for the selected lines or paths will be reversed.
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6.13.6. Splitting Segments

The segments of a path can be split into individual segments. Follow the steps below to Split All Segments

within a selected path(s):

1. Click on the path to be split.

2. Select the Modify Menu and choose Split All Segments.

3. As shown below, specific visual indicators are changed to show that all segments have been separated
within a path and are able to be moved or altered as individual objects. Segment end point handles
(orange) are changed to a bounds handle (blue) The start handle (orange with white center) remains at
one end of each split segment since they are still considered by the application to be a path and the
control points (green) are left untouched to allow for alterations to existing quadratic or cubic curve
segments. To learn more about handles, refer to the handles reference table.
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4. Click on a bounds handle (blue) to move or resize a segment. Attribute alterations are made just as with
any other created figure on the drawing canvas.
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6.13.7. Creating a Compound Path

The Make Compound Path option can be used to combine two or more paths into one figure (compound path)

that shares the same attributes and is treated as one object. At least two paths must be selected for this option to

be available. Follow the steps below to create a compound path:

1. Select the paths to be combined.

2. Select the Modify Menu and choose Make Compound Path.
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3. The two paths are combined to form a compound path with shared bounds handles (blue) and a shared
rotation handle (red). Attribute changes now affect both paths as if they were a single path. For example,
if the fill color is changed to red, all paths included in the compound path are altered to have this
attribute. Refer to the images below:
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4. If the top handle of the triangle is dragged into the other compound figure, the intersecting portion of
these two paths will appear in white.

5. An attribute change of stroke color to blue with a stroke size increase alters the attribute for every
segment in the compound path.
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6. The addition of a shadow with a rotation angle of twenty degrees would result in the image below.



Page 628

TouchDraw 2 for Windows

6.13.8. Separating a Compound Path

The Split Compound Path option separates a compound path into its individual paths. Follow the steps below

to separate a compound path:

1. Select the compound path.

2. Select the Modify Menu and choose Split Compound Path.

3. The previously combined paths are now two individual paths, which can be altered separately.
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4. Attribute changes will be applied to the selected path only rather than both paths. For example, if the fill
color of the bottom path is changed to black, the upper path remains red. Refer to the image below:
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6.13.9. Converting Shapes to Paths

The Convert Shape to Path option allows a selected shape(s) on the drawing canvas to be converted into a

path figure. Follow the steps below to convert a shape to a path:

1. Select the shape to be converted.

2. Select the Modify Menu and choose Convert Shape to Path.

3. Each individual segment used to create the shape will be converted into a path segment with
corresponding segment end point handles (orange). A start handle (orange with a white dot) shows the
initial starting point of the path.
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4. If the converted shape contained curved angles such as a Rounded Rectangle, then new bounds handles
(blue) are assigned in relation to the created path and control point handles (green) are added to each
curved segment.In the example below, a rounded rectangle with a corner radius of 1 inch has been
converted.

5. Any attribute changes available for a path can be performed on the converted object. For example, if you
perform a Click/Drag combination on one of the bounds handles (blue), the size of the path will be
altered.
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6. The upper right curve of the rounded rectangle can also be dragged to another location to alter its size or
shape. In the image below, one control point is moved upward and the other is moved to the right to alter
the path figure.
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7. Perform a Click/Drag combination on a segment end point handle (orange) to alter the size of individual
path segments. In the image below the circled segment end point handle is dragged to the left and
downward within the path object to create the shown change.
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6.13.10. Converting Text to a Path

The Convert Text to Path option converts a selected text figure(s) to a path. Size, color, rotation, scaling, and

moving alterations are performed as a path rather than by using the traditional text figure selection methods.

Follow the steps below to convert a text figure to a path:

1. Select the text figure to be converted.

2. Select the Modify Menu and choose Convert Text to Path.

3. The selected text figure is converted to a path figure.
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4. Perform a Click/Drag combination on a bounds handle (blue) to alter path size. In the images below, the
bottom bounds handle is dragged downward to increase the height of the path.

5. Attribute changes are performed in the same manner as figures created with the path tool. For example, a
fill color change to blue would result in the following image.
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6. The added rotation handle (red) can be dragged clockwise or counterclockwise with a Click/Drag
combination to change the angle of the newly created path.

7. A converted path can be moved to any location on the drawing canvas or scaled to a specific size.

8. Adjustment, Stroke, and Shadow attributes may also be altered to change the look of the path. In the
example below, the stroke cap, stroke location, and shadow characteristics have been altered.
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6.13.11. Delete Handle

TouchDraw 2 supports the insertion and deletion of handles or segments from an existing path. A different

behavior is received depending on the type of handle chosen for deletion:

• Cubic Curve Control Point Handle - Segment is converted to a quadratic curve segment upon deletion.

• Quadratic Curve Control Point Handle - Segment is converted to a line segment upon deletion.

• Segment End Point - The entire segment is removed, including the control points (cubic or quadratic
curves).

Follow the steps below to delete a Path Handle:

1. Click on the desired handle to select it, then Right Click (Control-Click) to open the contextual menu. In
this example, the Quadratic Curve Control Point Handle (indicated by the color green) is being
removed from the path.

2. Select the Paths Submenu and then choose Delete Handle.
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3. The selected Quadratic Curve Control Point Handle is removed and the segment is converted into a
Line Segment.

Follow the steps below to delete a Path Segment:

1. Right Click (Control-Click) on the desired Segment End Point to open the contextual menu. In this
example, the bottom left Segment End Point is chosen for deletion.
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2. Select the Path Submenu and then choose Delete Handle.

3. The selected handle and segment are removed, as shown below.
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6.13.12. Split Path at Handle

The Split Path at Handle action divides a path into two separate sections at the chosen handle and allows each

section to be altered as an individual figure. In the following example, the End Point Handle located at the

bottom right of the path is chosen.

1. Click on the desired End Point Handle to select it and then Right Click (Control-Click) to open the
contextual menu.

2. Select the Paths Submenu and then choose Split Path at Handle.

3. The path is now separated at the chosen End Point Handle, as shown below.
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6.13.13. Insert Handle

TouchDraw 2 supports the insertion and deletion of handles or segments from an existing path. A different

behavior is received depending on the type of segment chosen for handle insertion:

• Line Segment - The inserted handle splits the line segment into two connected lines.

• Quadratic Curve Segment - The inserted handle splits the quadratic curve into two quadratic curves, and
the shape of the original curve is maintained.

• Cubic Curve Segment - The inserted handle splits the cubic curve into two cubic curves, and the shape
of the original curve is maintained.

A new handle can be inserted into a segment or at the same location as an existing handle. In the provided

example, the bottom line segment is chosen for a handle addition. Follow the steps below to insert a handle or

segment into a path:

1. Click on the desired handle or segment to select it and then Right Click (Control-Click), where a new
handle will be inserted to bring up the contextual menu.
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2. Select the Paths Submenu and then choose Insert Handle.

3. A new Segment End Point Handle appears in the center of the selected line segment and can be used to
alter the path.
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6.13.14. Delete Segment

The Delete Segment action removes a selected segment from an existing path. A different behavior is received

depending on the type of segment chosen for handle insertion:

• Line Segment - The entire segment is removed.

• Quadratic Curve Segment - The entire segment and corresponding quadratic control point are removed.

• Cubic Curve Segment - The entire segment and all cubic curve control points are removed.

In the provided example, the bottom Line Segment of the figure is chosen. Follow the steps below to delete a

segment:

1. Click on the desired segment to select it and then Right Click (Control-Click) to open the contextual
menu.

2. Select the Paths Submenu and choose Delete Segment.
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3. The Line Segment and corresponding end point (orange) are removed. The remaining segment end
points are joined.

The following screenshots show the resulting control point and segment changes when a Cubic Curve

Segment is deleted from a figure. In this example, the top cubic curve is chosen for deletion. The selected

segment and both control points are removed.

Note: Refer to the Handles Reference section of this documentation to learn more about each handle.
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6.13.15. Segment to Line

The Segment To Line action will convert either a quadratic or a cubic curve segment into a straight line

segment. Essentially, it discards the control points of the curve.

In the provided example, a Quadratic Curve Segment is changed to a Line Segment. Follow the steps below:

Step 1:Click on the desired segment to select it and then Right Click (Control-Click) to open the contextual

menu.

Step 2: Select the Path Submenu and then choose Segment to Line.
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Step 3: The control point (green) of the Quadratic Curve Segment is removed and the segment is changed to

a Line Segment to create a rectangle, as shown below.
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The following screenshots show the resulting line when the Segment to Line action is performed on a Cubic

Curve Segment.

Note: Refer to the Handles Reference section of this documentation to learn more about each handle.
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6.13.16. Segment to Quad

The Segment to Quad action will convert either a line segment or cubic curve to a quadratic curve segment. A

different behavior is received when the handle is inserted depending on the chosen segment type:

• Line Segment - A curve control point will be inserted at the center point of the line and can be used to
create the exact desired quadratic.

• Cubic Curve Segment - The two control points of the cubic curve segment will be averaged to create a
new control point for the quadratic curve, which is replacing the cubic curve.

In the provided example, the Line Segment located on the right side of the figure is converted into a

Quadratic Curve Segment. Follow the steps below:

Step 1:Click on the desired segment to select it and then Right Click (Control-Click) to open the contextual

menu.

Step 2: Select the Path Submenu and then choose Segment to Quad.
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Step 3: A Quadratic Curve Control Point (green) is added to the center of the selected segment.

Step 4: Perform a Click/Drag combination on the Quadratic Curve Control Point to create the desired curve

segment. In this example, the control point is dragged in a downward direction.
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The following screenshots show the resulting control point and line changes when a Cubic Curve Segment is

converted to a Quadratic Curve Segment. In this example, the top cubic curve is chosen for conversion. The

two existing Cubic Curve Control Points (green) are averaged to generate a single Quadratic Curve Control

Point.
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The provided Quadratic Curve Control Point can be moved in any direction by performing a Click/Drag

combination. In this example, the new control point is dragged upward.

Note: Refer to the Handles Reference section of this documentation to learn more about each handle.
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6.13.17. Segment to Cubic

The Segment to Cubic action will convert either a line or quadratic curve into a cubic curve segment. A

different behavior is received depending on the type of segment chosen for handle insertion:

• Line Segment - Two curve control points will be inserted at the 40% and 60% locations along the line
and can be used to create the exact desired cubic curve.

• Quadratic Curve Segment - The shape of the quadratic curve will be approximated with a new cubic
curve segment.

In the provided example, the Line Segment located on the left side of the figure is converted into a Cubic

Curve Segment. Follow the steps below:

Step 1:Click on the desired segment to select it and then Right Click (Control-Click) to open the contextual

menu.

Step 2: Select the Path Submenu and then choose Segment to Quad.
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Step 3: Two Cubic Curve Control Points (green) are inserted at the 40% and 60% locations on the chosen

Line Segment.

Step 4: Perform a Click/Drag combination to move either Cubic Curve Control Point in any direction. In

this example, the left control point is dragged upward and the right control point is dragged downward. Refer to

the image below:
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The following screenshots show the resulting control point and line changes when a Quadratic Curve

Segment is converted to a Cubic Curve Segment. In this example, the top cubic curve is chosen for

conversion. The Quadratic Curve Control Point (green) is approximated to create two Cubic Curve Control

Points and the associated segment.

The provided Cubic Curve Control Points can be moved in any direction by performing a Click/Drag

combination. In this example, the left control point is dragged downward and to the right. The right control

point is dragged upward and to the left to create the desired Cubic Curve.
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Note: Refer to the Handles Reference section of this documentation to learn more about each handle.
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6.13.18. Grouping a Path

Once a complex path has been created and all control points are in their appropriate place, it is recommended to

group the path using the Group function available under the Arrange Menu.

This will allow the path or path figure to be stretched, resized, and moved without having to worry about

changing the points. The following screenshots show a before and after for the Fleur de Lis example drawing

included with TouchDraw 2.

The path figure is the only figure that is allowed to be grouped by itself. Normally, one or more figures must be

selected before a Group can be created.
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6.14. Handling Layers
Layers provide the capability to incorporate more than one level of objects into a drawing. Each added layer

builds on top of the previously created layer to create a multi-dimensional drawing.

They are managed and controlled through the Sidebar, as shown below.

Layers can be added, renamed, merged, duplicated, deleted, sorted, locked, and hidden within the TouchDraw

2 application.
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6.14.1. Adding a Layer

A Layer can be added in one of two ways:

1. Click on the Layers Tab and then Click on the Layers Settings Menu.

2. Click on the Add Button located at the top left of the Layers Sidebar section.
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6.14.2. Duplicating a Layer

A Layer can be duplicated to create another layer with the same objects and properties. Follow the steps below

to duplicate a selected layer:

1. Perform a Click action to select a layer within the Layers List.

2. Click on the Layers Settings Menu menu.

3. Then choose Duplicate Layer.
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4. The duplicated layer will appear above the original and can be renamed, re-ordered, merged, or deleted.
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6.14.3. Renaming a Layer

A Layer can be renamed by following the steps below:

Step 1: Perform a Click action to select a layer within the Layers List.

Step 2:Click on the Layers Settings Menu menu and choose Duplicate Layer.

Step 3: Enter a new name for the layer and click on Rename Layer to finish.
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The new name will appear in the Layers Sidebar as shown below:
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6.14.4. Deleting a Layer

A Layer can be deleted in two ways:

1. Perform a Click action to select the desired layer and then click on the Layers Settings Menu menu to
choose the Delete Layer option.

2. Perform a Click action to select the desired layer and then click on the Delete Button located at the top
left of the Layers Sidebar section.

3. The layer will no longer appear in the Sidebar, as shown below:
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6.14.5. Re-ordering Layers

Perform a Click action to select the desired layer and then Click on the Layers Settings Menu menu to choose

from available re-ordering functions. The Layers Settings menu will appear as shown below.

A Layer can be moved up or down in the Sidebar list, and this action will alter the layering positions in the

drawing canvas. Layers can be re-ordered by using a Click/Drag combination to another location or by using

one of the methods shown below.

Use the Move Layer Up menu option to move the selected layer up by one in the Layers List.
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Use the Move Layer Down option to move the selected layer down by one in the Layers List.
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Note: The Move Layer Up option will only be enabled when a layer resides above the selected one in the

Layers List. The Move Layer Down menu option will only be enabled when a layer resides below the selected

one in the Layers List.
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6.14.6. Merging Layers

Perform a Click action to select the desired layer and then Click on the Layers Settings Menu menu to choose

from available merging functions. The Layers Settings menu will appear as shown below.

A Layer can be merged up or down in the Sidebar list. This action will combine the Drawing Canvas contents

and properties of the selected layer with the one above or below it, depending on what layer has been selected.

An additional option is available for merging all layers in a drawing.

Use the Merge Layer Up menu option to merge the selected layer with the one residing above it in the Layers

List.
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Use the Merge Layer Down option to merge the selected layer with the one residing below it in the Layers

List.
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The Merge All Layers function combines every layer of a drawing within the Layers list.

Note: The Merge Layer Up and Merge Layer Down menu choices are only enabled when a layer resides

above or below the selected one. More than one layer must be present in the Layer list for the Merge All

Layers menu choice to be enabled.
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6.14.7. Layer Visibility

The Visibility option is an "On/Off" toggle button for setting the visibility of each created layer. It appears to

the right of each layer name in the list as an "eye" icon and indicates the visibility of the layer.

To hide (or show) a layer, Click on the eye icon of the layer to be toggled. An eye icon with a line through it

indicates that a particular layer is not visible, whereas an eye with no line indicates a layer is visible.

The Layers Settings Menu provides additional options for changing the visibility of all layers residing within a

drawing. To access these options, click on the Layers Settings Menu in the Sidebar and then choose Show All

Layers or Hide All Layers from the provided drop-down menu.
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All layers will be made visible or hidden within the currently open drawing depending on the chosen option.

The "eye" icon serves as a visual indicator and will appear differently after a selection has been made, as shown

in the screenshots below.
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6.14.8. Locking Layers

The Lock option is an "On/Off" toggle button for locking or unlocking a layer. It is located to the right of the

visibility icon and indicates whether or not a layer is locked.

To lock (or unlock) a layer, Click on the lock icon of the layer to be toggled. A closed lock icon indicates that

the layer is locked, and an open lock icon indicates a layer is unlocked.

The Layers Settings Menu provides additional options for locking or unlocking all layers residing within a

drawing. To access these options, click on the Layers Settings Menu in the Sidebar and then choose Lock All

Layers or Unlock All Layers from the provided drop-down menu.
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All layers will be locked or unlocked within the currently open drawing depending on the chosen option. The

"lock" icon serves as a visual indicator and will appear differently after a selection has been made, as shown in

the screenshots below.
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6.14.9. Sorting Layers

Layers within a drawing can be sorted in ascending or descending order alphabetically by name.

Sort Layers in Ascending Order Alphabetically by Name

Step 1: Click on the Layers Settings Menu.

Step 2: Click on the Sort Layers (Ascending) option within the menu.

The layers within the drawing are now sorted in ascending order alphabetically by name.
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Sort Layers in Descending Order Alphabetically by Name

Step 1: Click on the Layers Settings Menu.

Step 2: Click on the Sort Layers (Descending) option within the menu.
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The layers within the drawing are now sorted in descending order alphabetically by name.
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6.14.10. Moving Figures to Layers

TouchDraw 2 provides a simple method for moving a selected figure(s) from one layer to another. The Move

To Layer option in the Contextual Menu may be used to complete this action.

Follow the steps below to move a figure to a different layer within a drawing:

1. Select the figure(s) to be moved. In the shown example, both the circle and rounded rectangle are part of
the first layer (Layer 1). The circle is being moved to second layer (Layer 2).

2. Perform a right-click on the Drawing Canvas for ~1 second. Then click on the Move To Layer Submenu.

3. Click on the Layer where the selected figure(s) should be moved.
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4. The circle is now part of Layer 2.
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6.15. Handling Libraries
Libraries are used to add and manage Stencils stored within the application and for adding these objects to a

drawing. They are managed and controlled through the Stencils Tab.

The Stencils Tab can be accessed in the lower portion of the Sidebar, as shown below:

To learn more about how to work with Libraries and Stencils in TouchDraw 2, please see the following

documentation sections:

• Library Functions

• Stencil Functions
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6.15.1. Library Functions

The Library Functions can be accessed through the Libraries Settings Menu and provide the ability to:

• Add a Library

• Rename a Library

• Delete a Library

• Import a Library

• Export a Library
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6.15.1.1. Adding a Library

A Library is added by clicking on the Libraries Settings Menu.

Then choosing the New Library option.

The new library will appear in the Library Selection Menu with the name "Untitled Library."



Page 687

TouchDraw 2 for Windows

Note: An Untitled Library can be renamed with the 'Rename Library...' option.
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6.15.1.2. Renaming a Library

A Library is renamed by selecting a desired library and then choosing the Rename Library option in the

Libraries Settings Menu. Follow the steps below to rename a library:

Use the Library Selection Menu to select the library to be renamed.

Click on the Libraries Settings Menu and choose Rename Library.

Enter a new name in the Rename Library prompt and click on Rename.

The entered name will appear in the Library Selection Menu.
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6.15.1.3. Deleting a Library

A Library is deleted by selecting a desired library and then choosing the Delete Library option in the Libraries

Settings Menu. Follow the steps below to delete a library:

1. Use the Library Selection Menu to select the library to be deleted.

2. Click on the Libraries Settings Menu and choose Delete Library.
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3. The Confirm Deletion prompt will appear. Choose OK to delete the library or Cancel to back out of this
process.
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6.15.1.4. Importing a Library

A library can be imported into TouchDraw 2 for use during drawing creation and manipulation. Follow the

steps below to Import a Library:

1. Click on the Libraries Settings Menu and choose Import Library....

2. Browse to the appropriate file directory and click Open.
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3. A confirmation popup window will appear if the library is imported successfully. Click Okay to close
the confirmation window.

4. Use the Library Selection Menu to locate and view the imported library within TouchDraw 2:
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6.15.1.5. Exporting a Library

An existing library can be exported as a .tdlb file for use within another application or to be imported for a later

drawing. Follow the steps below to Export a Library:

1. Click on the Libraries Settings Menu and choose Export Library....

2. Enter a different name (i.e.name.tdlb) for the library if desired and choose a save directory. Then click on
Save to finish exporting the TouchDraw library to the chosen directory.
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6.15.2. Stencil Functions

The following links provide additional information for managing stencils in TouchDraw 2. Click on a link to

learn more:

• Adding a Stencil

• Renaming a Stencil

• Deleting a Stencil

Stencils may also be inserted into a drawing. To learn more, please see Inserting a Stencil into a Drawing.
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6.15.2.1. Adding a Stencil

A Stencil may be added by choosing the Add Selection To Library Individually or Add Selection to

Library as Group options in the Libraries Settings Menu.

Adding Stencils Individually

To add a new stencil individually to a library:

1. First, draw the figure(s) within the drawing editor. Then select the figure (or figures) being made into a
stencil.

2. Open the Library Selection Menu and navigate to the desired insertion library.
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3. Select the Libraries Settings Menu and choose the Add Selection To Library Individually option.

4. The stencil will appear in the selected library as shown below and can be renamed after the addition is
complete.
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Adding Stencils as a Group

To add a group of selected objects to a library as a stencil:

1. First, draw the figures within the drawing editor. Then select the figure (or figures) being made into a
stencil.

2. Open the Library Selection Menu and navigate to the desired insertion library.
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3. Select the Libraries Settings Menu and choose the Add Selection To Library as Group option.

4. The stencil will appear in the selected library as shown below and can be renamed after the addition is
complete.
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6.15.2.2. Renaming a Stencil

The selected stencil must be in "edit" mode to be renamed. Complete the following steps:

1. Select the desired stencil in the library and click on the Libraries Settings Menu.

2. Next, click on the Rename Stencil option within the Libraries Settings Menu.

3. Enter a name for the stencil and then click on Rename.
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4. The stencil selected in the Sidebar list will look as shown below after it has been renamed:
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6.15.2.3. Deleting a Stencil

A Stencil is deleted from a library by selecting the desired stencil and then choosing the Delete Stencil From

Library option in the Libraries Settings Menu. Follow the steps below to delete a stencil:

1. Use the Library Selection Menu to select the library where the stencil is saved.

2. Perform a Click on the stencil to be deleted and then click on the Libraries Settings Menu.
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3. Choose Delete Stencil.

4. In the confirmation message, click on Delete to finish removing the stencil or Cancel to exit without
removing it.

5. The stencil will automatically be removed from the library, as shown below:
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6.15.2.4. Inserting a Stencil into a Drawing

To insert a stencil into a drawing:

1. Select the appropriate library in the Library Selection Menu.

2. Perform a Click/Drag combination from a selected stencil to the Drawing Canvas.
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6.16. Calculations
TouchDraw 2 provides an easy method for calculating the area and dimensions of a selected figure(s) by

entering variables within the Text Editor Popup Window.

Note: Refer to the Available Variables table to find out more about what can be obtained as part of the text of a

figure.
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6.16.1. Calculating Area

TouchDraw 2 supplies the ability to enter variables into the text editor for a figure(s). The calculated area of a

figure can be obtained and included within the figure's text by:

1. Double Clicking on a figure to open the Text Editor Popup Window.

2. Entering {Area} as part of the text within the Text Editor Popup Window. The value will appear
within the selected figure in real-time.

3. The figure will appear as shown below:
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6.16.2. Dimensioning

TouchDraw 2 provides variables for determining the dimensions of a selected figure(s). The MinX, MaxX,

MinY, MaxY, Width, and Height can be entered as part of the displayed text within a figure. Refer to the

available variables table to learn more about what variables can be inserted. These values can be applied to

show the dimensions of a drawn object, as shown below:

Follow the steps below to create the images shown above:

1. Select the Rectangle Tool and draw a rectangle.

2. Select the Rectangle Tool again and draw a square on top of the right half of the rectangle. Use a
Shift/Click combination to select both figures.
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3. Select the Modify Menu and choose Add Shapes to combine the two shapes.

4. Select the Line Tool and create a line with two black arrow end points along the bottom of the rectangle.
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5. Double Click on the figure to open the Text Editor Popup Window.

6. Click on the Variable drop-down menu, choose Length, and then choose {Length}. The value will be
entered into the Text Editor Popup Window and be updated on the line in real-time.
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7. Follow steps 4 through 6 to create a dimension line for each side. The figure below shows the completed
dimensions for the drawn shape.
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7. Tips and Techniques
This section provides information on how to perform specific actions within TouchDraw 2 and can be used to

master the basic features of the application. Listed below are links to several quick tips designed to help you

become more familiar with TouchDraw 2.
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7.1. Resizing a Figure Proportionally
TouchDraw 2 provides several features for resizing shapes when working with figures in a drawing. If a

bounds handle is dragged to a location within the Drawing Canvas without using application features for

constraining proportions, the shape is resized to that specific location. The Shift Key on your keyboard may be

used to constrain proportions as you drag to ensure the original shape is maintained.

For example, a simple drag of the bounds handle without this feature enabled can result in a perfect square

becoming a rectangle or a circle becoming an oval, but by using this feature, the shape will remain as a square

or circle and only change in size, not proportions. The example below shows what the puzzle piece from the

Stencil Library would look like if the bottom right bounds handle is moved upward without using the Shift

Key.

This tutorial will show you how to use the Shift Key to alter the size of a figure while constraining its
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proportions to maintain the original shape. We will be using the Puzzle Piece  (as in the above example) from

the Stencil Library  to demonstrate how this feature can be used to easily constrain proportions when resizing

shapes in a drawing.

View the Libraries section of the Sidebar and then select the Shapes category in the library menu to locate this

stencil.

You will see the puzzle piece as an available selection. Click on the stencil and drag it into your drawing. The

stencil will appear as shown below once it has been inserted into a drawing.



Page 719

TouchDraw 2 for Windows

Proportions are not constrained for a resized shape when the Shift Key is not used. When the Shift Key is

pressed during figure drawing, TouchDraw 2 makes certain that the proportions are constrained during shape

resizing to maintain the original shape.

For example, the puzzle piece will remain as a puzzle piece as a bounds handle is dragged and only change in

size. This feature can be used for any of a shapes bounds handles.

Follow the steps below to learn how to use the Shift Key to constrain proportions while resizing a shape.

Step 1: Select the shape in your drawing by clicking on the figure. Bounds handles will appear around the

chosen figure once it has been selected.
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Step 2: Next, you will need to hold down the Shift Key on your keyboard to constrain proportions during

shape resizing. Click and Drag (without releasing the Shift Key) on a bounds handle to begin resizing the

shape. In this example, the bottom right bounds handle is selected and drug inward toward the shape.

Step 3: The puzzle piece becomes smaller in size but retains its shape as its proportions are constrained.
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Release the Shift Key  once resizing is completed.
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7.2. Creating Proportional Shapes
TouchDraw 2 offers a great amount of flexibility when creating shapes or figures in a drawing. A click and

drag action in combination with a selected drawing tool results in the addition of rectangles, squares, circles,

ovals, and additional shapes of any size and/or proportion to a drawing. The Shift Key can be used when

adding a shape such as a circle or square to your drawing to make certain it retains its proportions and only

changes in size. This prevents the shape from becoming a rectangle or oval.

For example, if you select the Rectangle Tool and insert the shape into your drawing, it can either be a square

or rectangle depending on where you click and drag on the Drawing Canvas. Dragging toward the bottom right

results in a rectangle with non-proportional Width and Height measurements, as shown below.
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By holding down the Shift Key as you click and drag, you can create a proportional shape. In the example

above, a perfect square would be created when this feature is enabled and the same click/drag action is

performed. As shown in the Info Sidebar, the Width and Height of the square are proportionally the same.
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7.3. Using the Selection Rectangle
The Selection Rectangle provides an easy method for selecting multiple figures within a drawing. Click and

drag from left to right or right to left on any point in the Drawing Canvas and then release the click action once

the Selection Rectangle resides over the desired area. Figure selection will vary depending on the direction the

mouse is dragged.

If you drag the Selection Rectangle from left to right, it will select all figures within its bounds as well as any

figures it intersects.

While this approach is a great choice for making a quick selection in a defined area, it does not offer the

amount of control that is sometimes needed during figure selection.
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You can drag the Selection Rectangle from right to left to select figures residing in its bounds without

selecting intersecting figures. This provides finer control for using the Selection Rectangle to select multiple

figures in a specified area of the Drawing Canvas.

For more information about selecting figures within a drawing, please refer to the Selecting a Figure page of

the documentation.
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7.4. How to Resize an Image to Scale
The linear, horizontal distance, and vertical distance dimension tools can be used to add a dimension line to a

floor plan or other image and scale that image based on an entered value. Once scaled, the opacity can be

changed to perform tracing on the floor plan image.

The step-by-step example is shown below:

Step 1: Insert the Floor Plan Image into the Drawing

To insert the floor plan image into your drawing, click on the File Menu. Then click on the Insert Image...

option.

The floor plan image has been inserted into the drawing and is shown below:
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Note: For step-by-step instructions, please see: Inserting Images into Drawings.

Step 2: Draw a Dimension Line

Next, draw a dimension line within the drawing. For this example, the Linear Dimension Tool will be used.

Click within the Drawing Toolbar to select the Linear Dimension Tool.
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Next, draw a dimension line below the floor plan image.
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Step 3: Disable the “Snap to Grid” Option

This option will need to be disabled so that the connection points for the dimension line can be dragged to a

desired location within the floor plan image.

To disable this option, click on the View Menu and then click on the Snapping Submenu.
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Next, click on Snap to Grid to disable the option. It will not have a checkmark when disabled.

Step 4: Drag the Connection Points to a Specific Location within the Floor Plan

After the Snap to Grid option has been disabled, you will be able to drag each connection point on the

dimension line to a desired location within the floor plan.

For the first connection point, use the Shift Key and a Click/Drag action to move it to the desired location on

the floor plan.
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For the second connection point, use the Shift Key and a Click/Drag action again to move it to the desired

location on the floor plan.
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Tip: You can zoom in on a specific location within the floor plan to be more precise when changing the

dimension line connection point locations.
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Step 5: Use the Scale Attached Option

The Scale Attached option can be used to scale the drawing based on an entered scale value (e.g., 10 ft).

Click on the Modify Menu and click on the Transform Submenu.
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Next, click on the Scale Attached… option.

Enter a new Length value. For this example, “16 ft” will be entered. The image will scale based on the entered

length value.

Step 6: Change the Dimension Line Font Size

Select the Dimension Line and then click and drag on the bounds handle to drag the handle downward.
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Increase the font size so that the dimension information is viewable for the location the dimension line

represents.

After the font size has been changed, the dimension information will be more visible, as shown below:
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Step 7: Change the Opacity for Tracing

Select the image and select the Shadow and Opacity Tab in the Sidebar.

Click and drag on the opacity slider or use the “up” and “down” buttons to change the opacity value.
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The image will appear as shown below:

Completed Example

The floor plan can optionally be lined up to specific points on the gridline, as shown in the image below:
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Once finished, zoom out to see the entire floor plan and perform any needed tracing activities.



Page 741

TouchDraw 2 for Windows



Page 742

TouchDraw 2 for Windows

8. Miscellaneous
TouchDraw 2 supports specific file formats for importing or exporting and provides options for setting

application preferences. The following documentation sections supply information regarding:
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8.1. File Format Support
Images or drawings from external applications can be imported for editing within TouchDraw 2. A created

drawing in TouchDraw 2 can also be exported into an alternative file format.

See the Importers and Exporters tables for additional information about supported file formats. Known issues

during exporting or importing of specific formats are noted in the following documentation pages.
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8.1.1. Importers

Importer Type Supported Import Methods

Image Importer TouchDraw 2 supports inserting or pasting bitmap images into a drawing.

SVG (Scalable Vector

Graphics)

TouchDraw 2 supports converting SVG files into a drawing.

VSD, VSDX, VDX (Visio

Drawings)

TouchDraw 2 supports converting Visio files into a drawing.

EMF (Enhanced Metafile) TouchDraw 2 supports converting EMF files into a drawing.

WMF (Windows Metafile) TouchDraw 2 supports converting WMF files into a drawing.

iDraw (Graphic Drawings) TouchDraw 2 supports converting iDraw files into a drawing.
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8.1.1.1. Image Importer Notes

TouchDraw 2 for iPad supports importing the following bitmap image formats.

• PNG

• JPEG

• GIF

• BMP

• TIFF

• HEIF

Limitations

• None Known

Known Issues

• None Known
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8.1.1.2. SVG Importer Notes

TouchDraw 2 supports importing Scalable Vector Graphics (SVG) files. This page documents the known

issues and limitations of the importer.

Limitations

Not every SVG feature is supported by the importer. When an SVG feature has no equal within TouchDraw 2,

the original SVG command is ignored. As SVG is large and complex specification, the following is a

non-exhaustive list of limitations we are aware of:

• Elliptical gradients cannot be imported.

• Clipping regions are not imported.

Known Issues

• None Known
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8.1.1.3. VDX Importer Notes

TouchDraw 2 supports converting Microsoft Visio in the VSD, VSDX, and VDX formats. This page

documents the known issues and limitations of the importer. Limitations 

Not every Visio feature is supported by the importer as TouchDraw 2 does not have every feature that Visio

does, nor does Visio have every feature TouchDraw 2 does. When a feature has no equal within TouchDraw 2,

the original command and/or data is ignored. As the Visio file format is very extensive, the following is a

non-exhaustive list of limitations we are aware of: 

• Only visual information (the look/layout of the drawing) is imported. Any semantic information
(associated metadata) stored in the Visio file will be lost.

Known Issues 

• None Known
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8.1.1.4. EMF Importer Notes

TouchDraw 2 supports converting Enhanced Metafile (EMF) files mainly for the purpose of importing

embedded stencil file in Visio documents. This page documents the known issues and limitations of the

importer. 

Limitations 

• None known 

Known Issues 

• None Known
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8.1.1.5. WMF Importer Notes

TouchDraw 2 supports importing Windows Metafile (WMF) files mainly for the purpose of importing

embedded stencil file in Visio documents. This page documents the known issues and limitations of the

importer. 

Limitations 

• None known

Known Issues 

• None Known
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8.1.1.6. iDraw Importer Notes

TouchDraw 2 supports converting drawings created with Graphic (iDraw) files. 

Limitations  

• None known 

Known Issues 

• None Known



Page 751

TouchDraw 2 for Windows

8.1.2. Exporters

File Formats Options

Image Exporter TouchDraw 2 supports the exporting of a drawing in the form of a bitmap image

(PNG/JPEG). Refer to the Image Exporter Notes section of the documentation to learn

more about this exporting option.

Scalable Vector

Graphics (SVG)

TouchDraw 2 supports the exporting of a drawing as a Scalable Vector Graphics

(SVG). No additional options are associated with this choice. Refer to the SVG

Exporter Notes section of the documentation to learn more about this exporting option.

Portable

Document Format

(PDF)

TouchDraw 2 supports the exporting of a drawing as a Portable Document Format

(PDF). Refer to the PDF Exporter Notes section of the documentation to learn more

about this exporting option.

Microsoft Visio

(VSDX, VDX)

TouchDraw 2 supports exporting a drawing as a Microsoft Visio (VSDX, VDX) file.

No additional options are associated with this choice. Refer to the Visio Exporter

Notes section of the documentation to learn more about this exporting option.

Note Refer to the Exporting a Drawing section of the documentation to learn more about exporting a drawing

from TouchDraw 2.
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8.1.2.1. Image Exporter Notes

TouchDraw 2 supports exporting drawings in the following bitmap image formats: 

• PNG

• JPEG

• GIF

• BMP

• TIFF

Limitations 

• None Known

Known Issues 

• None Known
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8.1.2.2. SVG Exporter Notes

TouchDraw 2 supports exporting drawing files to the Scalable Vector Graphics (SVG) file format. The

following page outlines the known issues and limitations of the exporter. 

Limitations 

• Only the visual information will be exported as SVG does not support some TouchDraw 2 features such
as connections.

Known Issues 

• None known

Notes 

• Many SVG viewers and/or editors do not support all of the features of SVG that TouchDraw 2 may
possibly use to export your drawing. Specifically, many SVG views do not correctly render shadows. The
Elevenworks team recommends using the Google Chrome web browser to view and validate that your
drawing was exported as expected. In our testing, Chrome has been found to have the most full feature
(freely available) SVG rendering support.
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8.1.2.3. PDF Exporter Notes

TouchDraw 2 supports exporting drawing files to the Portable Document Format (PDF) file format. The

following page outlines the known issues and limitations of the exporter. 

Limitations 

• None known

Known Issues 

• None known
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8.1.2.4. VDX Exporter Notes

TouchDraw 2 supports exporting drawing files to Microsoft Visio VSDX and VDX file formats. The following

page outlines the known issues and limitations of the exporter. 

Limitations 

• Font, font color and font size are the only font (text) attributes currently exported.

• Exporting of the drawing background color is not supported.

Known Issues 

• None
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8.2. Keyboard Shortcuts
The Keyboard Shortcuts within TouchDraw 2 provide fast access to application, file, editing, etc. functions.

Refer to the table below to learn more about each available shortcut:

Keyboard Shortcut Option Name Description

Control-Comma Preferences The Preferences... shortcut can be used to change general,

handle, and performance options for the application.

Alt-F4 Exit TouchDraw 2 The Exit TouchDraw 2 shortcut closes the application.

Control-N New The New shortcut can be used to create a new drawing.

Control-O Open The Open shortcut can be used to open an existing TouchDraw

2 document, or it can be used to import a drawing or image in

one of the 3rd party file formats that TouchDraw 2 supports.

Control-W Close The Close shortcut closes the current drawing.

Control-S Save The Save shortcut saves the current drawing.

Control-Shift-S Save As... The Save As shortcut saves the current drawing under a

different name.

Control-I Insert Image... The Insert Image shortcut can be used to import a bitmap

image stored on the local file system into the current drawing.

Control-E Export The Export shortcut can be used to export the currently active

drawing.

Control-P Print The Print shortcut can be used to print single or multiple pages

of a drawing.

Control-Z Undo The Undo shortcut removes drawing changes in the order they

were applied starting with the most recent.

Control-Shift-Z Redo The Redo shortcut reapplies drawing changes in the order they

were removed starting with the most recent.

Control-X Cut The Cut shortcut removes the currently selected item from the

active drawing and places it in the clipboard.
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Keyboard Shortcut Option Name Description

Control-C Copy The Copy shortcut places a copy of the currently selected item

into the clipboard.

Control-V Paste The Paste shortcut adds the most current item residing in the

clipboard to the active drawing.

Control-Shift-V Paste in Place... The Paste in Place shortcut copies the current clipboard item

into the exact location of the original.

Control-Alt-V Paste Multiple The Paste Multiple... shortcut can be used to paste multiple

copies of a clipboard item at specific offsets.

Control-Alt-Shift-V Paste Style The Paste Style shortcut applies the formatting properties of

one object to the currently selected object.

Backspace Delete The Delete shortcut permanently removes a selected item from

the active drawing.

Control-D Duplicate The Duplicate shortcut creates a copy of a selected item in the

active drawing.

Control-Shift-D Duplicate in Place The Duplicate in Place shortcut creates a copy of a selected

item and places it in the same location as the original.

Control-A Select All The Select All shortcut selects all items residing in the

currently active drawing.

Control-Shift-A Deselect All The Deselect All shortcut deselects all items residing in the

currently active drawing.

Control-Alt-A Invert Selection The Invert Selection shortcut inverts (reverses) the currently

selected figures within the Drawing Canvas.

Control-G Group The Group shortcut combines selected shapes residing on the

drawing canvas into a group to manipulate and treat them as a

single figure. It is enabled when two or more groupable figures

are selected in the Drawing Canvas.

Control-Shift-G Ungroup The Ungroup shortcut removes the grouping characteristic for

individual shape manipulations. It is enabled when one or more

grouped figures are selected in the Drawing Canvas.
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Keyboard Shortcut Option Name Description

Control-L Lock The Lock shortcut prevents a selected figure(s) from being

moved or resized until it has been unlocked. Attributes such as

stroke, fill, shadow, etc. can still be manipulated on a locked

figure. It is enabled when one or more unlocked (and lockable)

figures are selected in the Drawing Canvas.

Control-Shift-L Unlock The UnLock shortcut removes a previously set lock on a

selected figure(s) or group of figures to allow for moving and

resizing. It is enabled when one or more locked figures are

selected in the drawing canvas.

Control-Shift-Closing

Bracket

Bring to Front The Bring to Front shortcut moves a currently selected

figure(s) to the front of all figures residing in the same layer. It

is enabled when one or more figures are selected in the

Drawing Canvas.

Control-Closing

Bracket

Bring Forward The Bring Forward shortcut moves a currently selected

figure(s) one step closer to the top of the stack within the layer

they reside in. It is enabled when one ore more figures are

selected in the Drawing Canvas.

Control-Opening

Bracket

Send Backward The Send Backward shortcut moves a currently selected

figure(s) one step closer to the bottom of a stack within their

residing layer. It is enabled when one or more figures are

selected in the Drawing Canvas.

Control-Shift-Opening

Bracket

Send to Back The Send to Back shortcut moves a currently selected figure(s)

behind all other figures residing within the same layer. It is

enabled when one or more figures are selected in the Drawing

Canvas.

Control-Right

Facing Arrow

Rotate 90° Right The Rotate 90° Right shortcut rotates the selected figures to

the right by 90°.

Control-Left

Facing Arrow

Rotate 90° Left The Rotate 90° Left shortcut rotates the selected figures to the

left by 90°.

Control-Shift-Right

Facing Arrow

Rotate 180° The Rotate 180° shortcut rotates the selected figures by 180º in

a counter-clockwise direction.
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Keyboard Shortcut Option Name Description

Control-Plus

Symbol

Zoom In The Zoom In shortcut increases the magnification level of the

drawing canvas to allow for working on the drawing in more

detail.

Control-Minus

Symbol

Zoom Out The Zoom Out shortcut decreases the magnification level of

the drawing canvas make a larger portion of the drawing

viewable in the window at once.

Control-1 Zoom to Fit

Contents

The Zoom To Fit Contents shortcut can be used to zoom in

and fit the drawing figures so that they are shown within the

window.

Control-2 Zoom to Fit Page The Zoom To Fit Page shortcut can be used to fit the entire

page within the window.

Control-3 Zoom to Fit

Selection

The Zoom to Fit Selection shortcut can be used to zoom in on

the drawing so that the selected figures are shown within the

window.

Control-4 Zoom to Fit

Actual Size

The Zoom to Fit Actual Size shortcut can be used to 100%

drawing size based on the page size (8 1/2 by 11, etc.)

Control-5 Zoom to Origin The Zoom to Origin shortcut returns a drawing back to its

normal magnification level (100%) and resets the visible

portion of the drawing canvas so that the coordinates 0,0 are in

the upper left hand corner.

Control-R Show Rulers The Show Rulers shortcut can be used to remove the left and

top rulers from the main application window. Select this menu

option again for the rulers to reappear.

Control-Apostrophe Show Grid The Show Grid shortcut toggles the visibility of the grid within

the drawing canvas.

Control-Shift-R Show Regions The Show Regions shortcut toggles the visibility of regions

within the drawing canvas.

Control-Shift-ApostropheSnap to Grid The Snap to Grid shortcut toggles whether or not figures are

aligned to the grid for more precise drawing.

Control-F Easy Drag Mode The Easy Drag Mode shortcut enables/disable easy drag mode
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Keyboard Shortcut Option Name Description

within the drawing canvas. Easy drag mode makes it simpler to

move and select figures without having to worry about touching

one of the handles (which could lead to an unwanted resize).

Control-Shift-R Show Format Bar The Show Format Bar shortcut removes the formatting bar

from the TouchDraw 2 application window. Select this menu

option again for the formatting bar to reappear.

Control-Alt-R Show Side Bar The Show Side Bar shortcut removes the side bar from the

TouchDraw 2 application window. Select the menu option

again for the side bar to reappear.

Control-Shift-T Show Toolbar The Show Toolbar shortcut removes the main toolbar from the

TouchDraw 2 application window. Select the menu option

again for the Toolbar to reappear.

Left Arrow Key Nudge Figure to

Left

The Left Arrow Key nudges a selected figure to the left on the

drawing canvas.

Right Arrow Key Nudge Figure to

Right

The Right Arrow Key nudges a selected figure to the right on

the drawing canvas.

Up Arrow Key Nudge Figure

Upward

The Up Arrow Key nudges a selected figure upward on the

drawing canvas.

Down Arrow Key Nudge Figure

Downward

The Down Arrow Key nudges a selected figure downward on

the drawing canvas.

S Selection Tool The S key activates the selection tool for selecting objects

within the drawing canvas.

M Move and Zoom

Tool

The M key activates the Move and Zoom Tool for panning or

zooming within the drawing canvas.

F Freehand Tool The F key activates the Freehand Tool (Pen Tool) for drawing

freehand objects within a drawing.

L Line Tool The L key activates the Line Tool for creating line objects

within a drawing.

1 Line Connection

Tool

The 1 key activates the Line Connection Tool for creating

connection objects within a drawing.



Page 761

TouchDraw 2 for Windows

Keyboard Shortcut Option Name Description

2 East/West

Connection Tool

The 2 key activates the East/West Connection Tool to draw

connection lines that originate from the side (either west/left or

east/right) of the source figure and connect to the side (either

west/left or east/right) of the target figure.

3 North/South

Connection Tool

The 3 key activates the North/South Connection Tool to draw

connection lines that originate from the side (either north/top or

south/bottom) of the source figure and connect to the side

(either north/top or south/bottom) of the target figure.

4 Horizontal/Vertical

Connection Tool

The 4 key activates the Horizontal/Vertical Connection Tool to

draw connection lines that originate horizontally from the right

or left side of the source figure and connect vertically to the

side (top) of the target figure.

5 Vertical/Horizontal

Connection Tool

The 5 key activates the Vertical/Horizontal Connection Tool to

draw connection lines that originate vertically from the side

(either top or bottom) of the source figure and connect to the

side (either left or right) of the target figure.

6 Path Connection

Tool

The 6 key activates the Path Connection Tool for creating a

path connection that connects two shapes.

7 Hub Connection

Tool

The 7 key activates the Hub Connection Tool to create

connection lines that are able to receive connections. The

connection line can originate from any side of the source figure

and connects to any side of the target figure or to another hub

connection line.

O Oval Tool The O key activates the Oval Tool for creating ovals or circles

within a drawing.

C Circle Tool The C key activates the Circle Tool for creating perfect circles

where the radius increases in increments as the size of the shape

increases.

R Rectangle Tool The R key activates the Rectangle Tool for creating rectangles

or squares within a drawing.
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RR Rounded

Rectangle Tool

An RR key combination activates the Rounded Rectangle Tool

for creating rounded rectangles or rounded squares within a

drawing.

H Polygon Tool The H key activates the Polygon Tool for creating regular

polygons within a drawing.

P Path Tool The P key activates the Path Tool for creating complex curves

and shapes with detailed control on every aspect of the shapes

appearance.

T Text Tool The T key activates the Text Tool for creating text areas within

a drawing.

+ Zoom In The + key can be used to zoom in on the drawing canvas.

- Zoom Out The - key can be used to zoom out on the drawing canvas.
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8.3. Handles Reference
TouchDraw 2 uses color and decoration attributes to differentiate the varying functions of handles to allow for

quick identification regarding what a handle does. The following table lists the different handles and their

individual function:

Image Handle Name Handle Description

Bounds Handle The Bounds Handle is used to change the width and height of

a shape.

Group Bounds

Handle

The Group Bounds Handle is used to change the width and

height of a group. The white center dot is provided to show that

a group of figures has been selected, as opposed to a single

figure.

Path Start Handle The Path Start Handle indicates which point or a path is the

starting point.

Path End Point

Handle

The Path End Point Handle indicates which point is an end

(or start) point of a line or curve segment within a path.

Path Control Point

Handle

The Path Control Point Handle indicates which points of a

path are control points. Control points are used to alter the

shape of a Quadratic or Cubic curve segment to be altered.

Phantom Path

Control Handle

The Phantom Path Control Handle is a control handle

displayed in gray to indicate that it has not been used. This

characteristic provides a hint to the TouchDraw 2 application

that the handle should function as a control handle in scenarios

where the next drawn segment is a curve.

Rotation Handle The Rotation Handle is displayed on shapes (or groups) that

can be rotated around their center point. This handle can be

rotated in increments of 15° when the Shift Key is held in

conjunction with the Click/Drag action.

Center of Rotation

Handle

The Center of Rotation Handleindicates where the current

center of rotation point lies in a selected shape(s) or group of
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Image Handle Name Handle Description

shapes. The Center of Rotation option must be selected in the

Handle Settings popup menu for this handle to be visible.

Lock Handle The Lock Handle indicates that the selected figure (or group)

is currently locked, which means it cannot be resized or moved.

The white center dot is provided to show that the figure (or

group) cannot be altered.

Connection Handle The Connection Handle indicates that the selected line can be

used to connect to figures.

Gradient Location

Handle

The Gradient Location Handle indicates the current center

location of a gradient fill within a figure(s) or group of figures.

The Gradient Location option must be selected in the Handle

Settings popup menu for this handle to be visible.
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8.4. Application Preferences
TouchDraw 2 provides a preferences popup window for setting general, defaults, and license preferences

within the application.

Use one of the following methods to open Application Preferences:

Method 1: Click on the Application Menuand choose Preferences.

Method 2: Use the Control-Commakeyboard shortcut.
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8.4.1. General Options

General Preferences can be used to set general settings within the application. They are located in the General

 section of the Application Preferences popup window, as shown below.

Enabled preferences have a check mark in their associated box.

General Preferences

Preference Name Description

Default Template The Default Template preference can be used to configure the default template that

will be used for new drawings.

Curve Smoothing The Curve Smoothing preference, when enabled, smooths curves drawn with the

freehand curve tool.

Smart Fill The Smart Fill preference allows shapes created by touching lines/paths to be filled.
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8.4.2. Defaults

The Defaults Preferences are used for setting the default configuration for showing the grid, snapping objects

to the grid, lines or points, showing page bounds, and the selection mode within new drawings.

Enabled Defaults preferences have a check mark in their associated box.

Defaults Preferences

Preference Name Description

Full Bleed The Full Blead preference can be enabled to create drawings with no margins. It is

disabled by default.

Show Grid The Show Grid preference toggles the visibility of the grid. The grid visibility is an

application level preference. It will remember what you have selected through the

application restart and will apply to all drawings that you edit/view.

Snap to Grid The Snap to Grid preference aligns objects to the grid for more precise drawing

modifications.

Snap to Lines The Snap to Lines preference aligns objects with the nearest lines.

Snap to Points The Snap to Points preference aligns objects to whole pixel numbers or points for

simplified object modification and increased accuracy.



Page 768

TouchDraw 2 for Windows

Preference Name Description

Snap to Shapes The Snap to Shapes preference snaps a figure to a selected shape vertex or center

point. It is disabled by default as an application preference.

Show Page Bounds The Show Page Bounds preference toggles the visibility of bounds of a page within

the drawing canvas. Any figure surpassing this line will appear on another page when

printing.

Selection Mode The Selection Mode preference can be used to set the default selection mode for

shapes and figures within the Drawing Canvas. The default selection is Group.
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8.4.3. License

The License Preferences are used to view your TouchDraw 2 license information include who the application

has been licensed to, the license type, and the valid until date. These preferences can also be used to update

your TouchDraw 2 License.

Licensing information is located in the License section of the Application Preferences popup window, as

shown below.
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